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R ER TS M8 30 EMRAIERIERAE, HEoms A A SRR
HIERAFECRE, Y om X SEAR A B 2R e T B RGE VR R 1 A st 5
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IME— : UG NX N FEEM

UG NX iR

UG ¥ /24 CAD/CAE/CAM — R =4S Bt itt, ek R iR T B
AT I R MNIRZEFE SIS 2, SR T CAD/CAM/CAE HR M HIIAWIAN . B2
LA AR T E R B R T RIS E, TR N TR SR, R
LGN @ERAVUA B AU . R PECNIRN 9 UGS AR KA UG BAF—
—UG V17, Rt — M IhRe e & fiE A H 5

1.1 UG NX 145 5

Unigraphics = S Solutions A F] (&R UGS) s&4xEk
SSEH MCAD BERIR, FEOMRZESASHE. AR, B HRS. @EHNU L &L BT
b 2 AT B T LR U T R (VPD) I B & SR 2 A . SRR . Al i 3 S A 7=
i 55 IR 45 TE N 1R 52 B2 1) MCAD fifR J7 %

AFIH 1962 FAINELIK, —EHEFEEER PSR EE, K(E B S T3t
ZHIHCFACIR, AU AL B AR BT 4B B3 R ) Unigraphics 4
fF. 2T Windows V& RiG S &5 B~ i Solid Edge £ H% i EHR EH R4
IMAN. SEER S TG 3 R ProductVision LA Rz Ml 532 48 FH A ek 188 3201 7 3 7 1) Si
HAAZC Parasolid 7E N 4 2R /. IR, AFIEATRIEREAN IR EOAFR TR, #=214
ARG K RAER RS IR L 5 SRS

25t 20 ZHEMKRE, UG AL CECN H A — I SE LU CAD/CAM/CAE KA,
NS SRS R4 B, BRI B AREN. 2 HRAEL A
F R UG 1E A BN BT HE RN s . WsEE@EARE AR B
B RHLAF. JURBEANLAF. TEEFHA R EERBHLA 7SR L, UG 1E k™=
i RS . UG AR E 1990 Fif AT ETTIA LK, DAHGHE fEiREat . 55
KT . EENReM LI AR RS WS 7 K+ E cap/cam H . H
Al UG B4 FR E FH ' 1500 258, %K1 8000 £ 6 %&, M. 54 MAMEKHH
AN AR T2, BONFR E SRS CAD/CAM/AE RS 3= b

Unigraphics CAD/CAM/CAE R&GiHeflt 7 — AN R BBt m s, /- frr K
ML BN TR IESEI T 50 o ae e, M iiAl 7k = ikt S5lid . uG
)i FE IX B R A A R FL™ b T R I SCEERR, FETH Mk AR IK S E R A s b, P
(1) 4 38 7= it DA BORE  F B A ZRY B A 75 7= T R A I R I S AN IR R FRAE O, A
SO EL T AT TRE

A A R SEAGE R . s A R AR E A AR TR ST T RE
i H, R R T AT B IR IC T LB N 3 )12 B f G AR, 32
T SRR RIS, AR ST = AR B AR AR, TR AR L,
HJG A FERR P X FF 2 MR ABUENUR . AN E TR AR X IF K 1E S UG/OPen GRIP,
UG/open API & .5 %%, SCELDIREZ, T H /K& H CAD R4, Bk, Z#4t
A PUTERE AT

l. BHG—0BIEE, HIFSEHL 7 CAD/CAE/CAM 25 &R 2 1] i e <2 e i E
HHYI#, AT ST TR

2. RHAEEEMEEAR, SR, mhimaEi, LEEE. Bon)lakss
A LR — 1k

3. HETHHE Cogl. e BUiS. M. RIS BRI T I AE NSk
ERELA, HREM, BT RIS INE, e SRS,
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4. B BETHRAAESSIA B B AEAESERY, TR 2RO A R 2 T, R
WA TREINEEIT IREEHUH it S8 e dh g 2 .

5. HEThaEETR, 10T N S 4E SR B A 4k TR . Bt 1SO Fr
HERE FRARIE RS TR A ZRIPCF S o JF e BB X ST FE 5] . B s ) Ak
2O RS AL, 3850 1 Zeibi] T2 B R s

6. LL Parasolid ASZARGEB IR 0y, SEARGE I RE AL TR0 A . H A& %2
CAD/CAE/CAM A 351 LA G A Ay sk i TR it

7. AT HH B IFA R IT & T E GRIP (GRAPHICAL INTERACTIVE PROGRAMING )
A UFUNC (USER FUNCTION) , JffReilidmauBs# 10, f# uc MRt S mdit s
Tt E IR R L Gk .

8. BHARIMHINE, £ UG REH, AR HIhaeasnlimid FbrsLHl; 37
X REBAER, BAHSHEEDIGE; FE, ERMNMEELSRA, A MHENIRRE R,
15 F F P 450 IE A e %

1.2 UG IRefE )2

DIRESR K I UG B2 RS I DR AT A B . 72 UG VA7 hiiAH, 845 60 2
AN THREAEL, X —2H 1) UG ThREALHBE T — N i B4

1.2.1 UG/AA (UG/Gateway)

ZIBGE R T UG BRI "o SCRF— SR ORRAT,  WIFTIFAAAER UG i
PSR BB ARSI il TREEI DA S A a5 P A RS S St A
iz AR AR H] . EE X FRRAi R /I R BIThEe. 7
bb, FEZREGR, WTRAHEAT AT, S, SRR R A S T AL R

1.2.2 CAD &3t

1. UG/SfR#EME (UG/Solid Modeling)

IABRORE B 2 R AR 20 LT i e A I A ke ok, 343 1 oAy
T CEEEE” TR, R AT e s MRS SR, . SHEER . i
R, WIS TR = HELRHERLAY . N e Sk DA R HEAT A AR I8 B e 2 A
o JiHh, ZMHGATR A T PO S BT BRI TR — Ll R R L ZwAE T
H

>~No

2. UG/HFIEEAE (UG/Features Modeling)

AR TRERF AL E CBEHE R, FF5RE 7 2P brHE R Bt Re L, gl #l. &Y
s e AR SRR HERL BRORL EIEAR. IR MAAVR E A A, R sk
SLEEECE . B BOHRHMIE T LS B E X, HRS RN BT Dt . - B
FESURFIERAFREAE RILASN, ATRAS N B g B AR . S Rp Al ml AR
AL S E AT, AT 51 SRS AH A AR

3. UG/H HI T 24 (UG/Freeform Modeling)
AR TS B TR, wdLE . IFRIEA e Tk SR E BT
TR SEAR AN i T @R B R A 9, A NIRRT R AR T . AR R
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CUFEUT 2T 4,  FIARVEE M 4o 57 O A, I BEAE A BB 2 Ak ] P M B
(7 RS GHE fEER h T . EE AT DL R TRERI S, I il 2/ s ks € SCHf T
B SR G . S35h, e BUBE S E X Z . SRS HEN
Ko r R Gt 4 CALE 1Y b T B S AR AR

4. UG/H ' H e XHE (UG/User-Defined Features)

AR B 5 SCRHIEI T S SL AT, 5T T A, gRett 17—
S TR, e RAFEAE I S B SEAR R S RHIE S HC TR R & 58 SURHIE RS
B WEAGE, DURHE R RE PR e S TR 7 e SR
SEVUJR, BAEIAE AN E R, mIER U T B e SCRFIEOINA 2 A
J&, TR R RAE S BT VE A Y (K S RO AT G AR 18 2

5. UG/ LFEHIE (U/Drafting & ['dra:ftin] 3 ['dreeftin] )

FAEHE BT N ] DU E B3R 5 = 4E SR 52 A M O 4k TR, JF IR
E T BE SRR %, [F2E O TRRE R RS R ARG, s> TR =
ALY PR B g A TRE BT R (ORI S AT R D e T PR A R 4L,
FEIEZ BB AL SRR S E AN ORI S . RN E RS T
— BT TREESRNNE TR, AR, oLl AR AL
2, KK THRERE . UG/Drafting SCHF Tk A (1) = b El brite,  4n
ANSI/ASME. 1SO. DIN. JSIS A% [ 1] GB AnHE .

6. UG/HERRZAE (UG/Assembly Modeling)

ZABRIRAE TIMT I B L RS R RO R . R AR, W]
PAREAT Z 80 it A g, AR m] RS s AUE AL, R ORIFHOCHR . Sl
11 2 A A T AR IR B30 2 T PRI E X O R o X A R 65 ) oV s S 5 P K )
PR EE A, FFES B RREAT AR, ™ RO A AR R e 8 T AT A

7. UG/EZ T (UG/Advanced Assemblies)

UG i Z R FU BRI At 7 Bt R Bz I Thae,  SCVRF P X R Be 454 v (1 B A k47 i
e, ATLVE R, ILEAIPPE B AR, DU AR 2 R I e R e
FEo BRI SR TH A A g $RE T R G EE AT IAT R A A AR R
Bl FEREAT BRI L AR T, HAS ISR AT R4 o AERG BT, 2 EGL AT
XTI BEATAE I E Lo 4 S — AR AU  h (BR  E5A BEATAE LT, DRI v A
S XML, DT PR E

8. UG/MEMIISE (UG/Reality) 1 UG/iEJiF (UG/Fly-Through)

XPABEERIR A T AT T H L FHAT AL TR AR A dh A TR o XA
BRA FH vt 2 B O R i s AR R MIREAT NS T8I & . UG/Reality £EXT 7 i Dy BE 5 T i3k
AT SEIASDL RS (RN o)Xt 7 i BEAT S, REARIE AR RIE 3l 2T (20 BROME B P 10
gL A H . UG/Reality fFOVFEILEANRE] TR ERALIIE BB sh i, T
HIBE), W REEAT N AIREBCINF i H . UG/Fly-Through HR AT #EAT #1872
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RZNE R, 22N P AT DAR IS IS e 400 i, FFRe S e — Ry ot o &
9. UG/LVi&AI¥it (UG/Studio for DeSign)

R T R I RE T T St . HEm A EJE T A Studio Visualize,
TR ESENR. IR M TREMEESE, o DHENE RN mEE, N
MinsE 7 CAD BRI A R . FoH HIRRTIRE (Studio Freeform) , mIXT i il 24T
BT, fF IR A AL . HEhAVE DRE (Studio
Analyze) , WX H B LATEARIEAT 73 RO VPA

10. UG/WAVE

UG/WAVE &t 7 — M ZHA = dT T 6, e Bte st 5 g tt 51 5 B84
PR BT R . WAVE SRR v AT 5E . 1B HIAITEAY, 8t SO LT
HESRMSCHE e T A B, RIA S S i, B SHUL gz HI 250, (AR
BT R ARG I 0 AN VEAil o SR SE R R ocs S LT Y, gk seds Dl B2 id
PR BT dh AR R . IR, AR SR AT R AR, fevF R S s AL
T = BT U AR ISR

FrUA b CAD #H2 4t, UG IHFRHELFE RSt (UG/FAST) FIJLIIAZE
(UG/Geometric Tolerancing) & it

1.2.3 CAM &R

1. UG/CAM FAl (UG/CAM Base)

PO IERE UG P i TR LAt . P AT MZE R 7 A s g2 ) Rig
2, FHERARGETTRKE s, KA iEf. gEAEs0] RPULEgmE 6.
BEXTRGAL. BURSOUMBALAE, et TR TR . ARt Tt — bR
AR, e e P @SN L BRI LA T TRRER TR o

2. UG/ EAbH (UG/Postprocessing)

REFZAEEL, AT EE R K 2 B MR R B O e BB Y. HR A BT
REAL S T BEHIIN T ZEE N TANZ D) BN T4 SEBRA AR 30 A2 o

3. UG/ZEHIINT. (UG/Lathe)

RBGEOE T MR TN L R 2 M i Ihae. FOFH LT T RS 58
MR, TR RERE ) LR SR T B B . s T 2U0ETIRE S
TV FAREONT LSS TR . ot B0 AL IR i) AT IR AL B, 7 AEALR
AR SO P I Rk L B AIE TR S, A, XS
Kokt PR R AT BUE . IEPTE R BB T) R, DO X B R e g AT R, Al
SR E RN LR, I a] SO T A S TR S X T AL, A
JUAT DAAE R IHBR B EESRAZ BUX B S

4. UG/ALEAIAY k] (UG/Core & Cavity Milling)
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PO AN 2 dh AT L P ORI TR A . B SR AU D) A e A Y
JEE . WAERETRY) 2 KEBR A BRI T AUEH 25 ThEE . &% K DhRE 2 Al %)
TEARIARH B AR 7= 42 T R 3, #ie £ 7). 24 UG/Core & Cavity Milling
P 2 57 R R P T I, e EGRAB G  BGRAE T E [ 28 22 B 0 I A

5. UG/[H sEHhBER] (UG/Fixed-Axis Milling)

R T4 3 Bhis s T R AR . SRR b, B RENN A An] i AR AR SRS
M, SRt T 2 IRE I EAE )T A, WL AR R LU L T
[FI3RB . AL AREN Tk, AT BB R AR R S 2 Rl T105 . Bhah, ek
A DA SSRGS I H], LR IR e 2kt 1% . RN, eI REIRII TS Ly R g
DIER 8 DCIRANBEUS X, AT Pk — 2 B L 77 o A ERas v] AT T B A%,
PR IR

6. UG/IEMYIHI (UG/Flow Cut)

UG/Flow Cut FHE TS24 25 Il T80k in LA AbHER (8] . 1X — At 5 UG/Fixed Axis
Milling B &5 A, DN TS EOp3EAE, v DL 2400 L (RS B Ak st
), KATE XA %A . PR CUEEE J1E, IS S AR 5 XCERBh LT,
I EBNTEIR L X 35 P FH — 8 T B2 UGE TI R 1 R VBRI L. 24 T8 i BES
AR, PO NS I LR AR R TR, DSRS0 LR &

7. UG/mZAZEh%EH] (UG/Variable-Axis Milling)

AR 1 ] 4N 22 Bt n AR R i A hRg, AP R] AR R 2 B ok
P ) B iz shna

8. UG/INF#iHI (UG/Sequential Milling)

SR T AEDIHE R 200 T B — P AR AR s E AT I & . ES L
R S oG, MR E TN, W ULEB L) Higte, (HALHEE RIS — DA
TR DRI A AT RE fe v P il e R BRI B A g, A ih T B AT
ZUGETIINL, AR &8 BN TR o

IEAk, UG 1) CAM 3407 il i SR B R 4 (UG/Genius) « VIHIT &
(VERICUT) . ZV)#E (UG/Wire EDM) . K JI#14w%E%s (UG/Graphical Tool Path
Editor) . HUAMTE (UG/Unisim) . NURBS (B FE4%) i ERi#% (NURBS (B-Spline)
PathGenerator) 25N TAER,

1.2.4 CAE 183t

1. UG/HIRJC/#HT (UG/Scenario for Structure)

AR — MR CAE T, "EReHs J U R AL O IRoT o i A, tREEh
X UG FIZEAFAERCHEATHT . Ja BALHE . B 5RMEAS UG/FEA FER, W DLEATENER /)
. DA, AIRITTAIE N B R — MRS, H PR %
PP J5 5o H AT aE R T LA i st 3R i R 4k i BT A T
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RS A IR TT TR AEE: UG/FEA, BIEME 1T 2 BRI, QIR LR /).
PRAEREAS . Re S HARBMZNE JE AR AT, RN SCRPR R AR, 4 1A B T 7
B, R0 RS M AN R AT . UG/FEA SRR & ) 5] 14 125 1] ek PR R AL 2

E_l{O
2. UG/HL¥I2% (UG/Scenario for Motion)

AL BERHT A — e B = N AT B R RS 2= b 3128 e A
B, ATLASERCKEMEEE AT TAE, wi/NEE . PSR ENrassE, HAZH
g v P RIS 5 NMEahE], oA RAER 77, R BIER R S
Rk HPEE. MEERIMERR. FE, RAEM 0 RA e frisideb . 28
PoC R B U shE B e, i N A 152 Mechanical Dynamics A5 (MDD )
KA ADAMS/Kinematics. [FIf, YT HE AR MR, EHEA MDI (4R Eh A K g s
ADAMS/Solver #3745 N SCHF

3. UG/IE¥EHELHr (UG/MF Part Adviser)

A —MRIRAE UG FHIEES M R4, B AT, WEAE LA
IR TAESOR MG S B RO PE o 70 B4 RO sh S SR i Bl R iR 3
SR JRLALE . A HFERI AT EERE . VR MR R . A AT
DA BB BB N R I O HR B A B, A B LR S AR 2 S
R R IFE TABIE, WAL M v o7 Ry 28 A

1.2.5 $R&#EHR (Sheet Metal)

1. UG/Hi& 1t (UG/Sheet Metal Design)

AR FE — H R B RE, T RS- MR BRI X SRR e fd
Berh N A RE e CLAER 178 T Bk e ORI L L .

2. UG/Hi&HiE (UG/Sheet Metal Fabrication)

Xt UG/Modeling B BT &, LB R4t 7 WIS 2 AL & 20

DIFIRIZhRE . P mDng s B SLAE R FURF AR B AR A b IS 34T B B A, RIS
RN e s A AT A2 L AU R

3. UG/Hi&-HERE (UG/Sheet Metal Nesting)

AR ] — BB IRORE LA T b R B Z A E AT 2 RO . P A R SO
TAFHIRSE . AR ECE DL SR RS, RGBT AT “ B3l JF
AR H S AT EREAT RS . S POE Rt IR TR, Wb T R e, fdi
TR FE f b Pk ] AR A B 5 20 B AEAR A _ B EATHERE o

4. UG/EZi& 1t (UG/Advanced Sheet Metal Design)

ARG B AR BT HRFAE AN T A) T R A e i B AR AR pl R 254
fFo BERFEAEITAE S WA WURMGH P dh P WaI, Wnih 2675 thid . 7
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b, ZBBGEIRAL T AT e F A LA

5. UG/Hi& i T2 (UG/Sheet Metal Die Engineering)

DRy BT P S T S BRI Wk AEFR TR, R
AR, XA TEX TR AT IR AR AR R A R
1.2.6 EiES5HE&ER

1. EZRREER

M2 T UG/Routing. UG/Tubing. UG/Piping. UG/Conduit A1 UG/Steelwork
HURe. PTLATERRETE. B, . S RSVEIE. KIE I BRI I

o

.
2. UG/HLS A%k (UG/Harness)

AU R R R (P 2RI N B B 5 B SRR TE . T REAE SR AL H A R A 1 i R
KER, BRI H =4 SEKE., (AHEESMENERER, HRHAERMNEHRA 4%
N, CLATIRIBR 0. RIS IE BE ks = 4 L S AT ZR
1.2.7 UG Hfthi&k

B T LA B YA, UG & HAh —se Dyt g, gk A - o i S B )
UG/Open Menu Script #5e; ftF P RiE UG KU 6HEHE 6 A 7 F T Btk (UG/Open
UlStyler); At/ #-47 — X IF A, 1 UG/Open GRIP. UG/Open API Al UG/Open-++41 5 [
UG JF RS (UG/Open); LA REHEAS S He . PR e BT HOR A 56 A4S0 FH 3 ) T 7%
SH ) T B TR B AR RS

1.3 UG [fjZ3k

HHFAFE T4, UG 222806 A A E R E AR . UG 84 TAE, iRk
WU P Ff, 43 3lizAT7E UNIX A1 Windows 2000/Windows NT #:-/E R4 T .

1.3.1 RE UG REHNER
N PAHLCRN B, UL 223 UG R G I B AR 1 SR

1. REfRER

CPU: Pentium 11266 DL I,
PWA7: 64MB LL I,

isk: 4GB DL L.

WNR: 3CFF Open_GL [1) 3D EIJEIN# =, 800X600 LA B #i, HEMA,
8MB UL E IR GAT

PR S HE 800X 600 UL _F R4,
HeIK: 4 L RGIK.
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PR BURMA MR AT BAH %I 1.3.3 A4 7 0k % 3 UG R0
How: MRYE T Z0E B i
2. BAFESR

¥E A %: Windows NT 4.0 LA Workstation B¢ Server i35 m], Jf42%% SP3
(Windows NT #h ) DL E, 5 & Windows 2000 #:/E R4t .

R 2 SR NTFS #43K
RIZE B 222 TCP/IP Bl
BR-RIKENFRT: BB P40 800X 600 LA EMFF .
1.3.2 UG REHR%E
ML UG V17 £ Windows 2000 T )22 Aeid REu, i B BAR 22D IR

1. ARG H A MG 05k Windows 2000 R4t. ik LR E T
“ugv170.dat” TIPS DUBIRERIE H T (XHEy 6 #MRHZ) , IFRmEm “ Hi”
AR

2. 1817 UG 234 UG V170 H 3% R Setup F2/% .
3. BEES UK 1.1 Fros @35k DUEHE, EF PUANED,

Configure: RECE UG RGNV A, A %ede UG I R5.
Custom: HJE X ZHEH I,

License Server: {WAE NVFAT RS 2% .

Typical: St7YZz4%, W2 BARERE B (IDES I DXF SRR 22 AT %4%)

Installation Options il

Select the bype of installation you prefer, then click Mest.
Pregz F1 for Help or F3 to Exit.

Configure
Custom
License Server
:Tupical

— D escrphion

Thiz will install Unigraphics and all related products an paur
zyztem. Recommended for mogt users,

< Back I Meut » I Cancel |

B 1.1 2R TN G HE

IR ELBGAGE UG RGN A M EE A B OV FRFIREOR, W] AL #%
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“Custom” 2245 )7 AKRIAT 2205 . XIS “Next” %4, SHBUE 1.2 Fros il
HE, TEIXHH PRI LLE R E B E L2 UG RG M LA, N3 1iIEF:
“Typical” %4577 SRBAT UG 1) 22 25 84

Unigraphics ¥17.0 - Custom Installation il

In the Components list, zelect the products pou want to install
Setup will install praducts in the destination folder shown below,

Components

|Jnigraphics FLEXIm Licenzing 354K ﬂ
Unigraphics [CAD-Cak-CAE] 194223 K

| Administration Tools 0Ok

Cast Uszer Interface 15185 K

Mative Language kenu 23k

GRIF International Library 100k j

— Destination Folder

UGS 70
Space Required: 246616 K S
Space Available: 1414132 K &I

< Back | Mest > | Cancel |

K 1.2 7 B E SCRERRTHRE

4. R “Typical” 2# A FF i “Next” %45, SHIMWE 1.3 Fisll
License KA EXFUEHE, HAG W FUUAEDT, 7EIX BIRATER “Both” 1IN,

Server: 4HiHLES R HAMEVF O] I UE IR S48, AIB1T UG RSt
Client: METHLARHPATIZ B PIVF O] SCAFIGUE, ARHIAS 222877 7] S0
Both: 4RETHLASREAE NVF ] SCAFIRIE R 48, N EIEIT UG RS,
Bypass: %3& UG, BV nl SCAFI L & .

License Options x|

Select the type af UG licensing aptions vau wizh bo be configured
for thiz computer. Prezs F1 for Help or F3 to exit setup.

£ Server Configuraton Only

" Client Configuration Only

%" Server/Client Confiquration

™ Bypass Licensing Configuration

< Back I Meut » I Cancel |

1.3 License ZRHY % & X 1EHE

5. Hii “Next” #%4l)5, HIIE 1.4 FiosIXEHE, 1EH P48 5E License I
PN E . XA RENDIE 1 F ugvl70.dat SCHFTEHIRH 3%, AP
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“g:\ugvl70.dat” .

ient Configuration x|

Thiz computer is to serve az a Server and a Client.

Enter both server(z] and full path ta the Unigraphics license
data file.

Data File:  |grugy170.dal

Server(z): IETDDD@zhk

¢ Back I Mest » I Cancel
1.4 % & License M1 H 4%

6. i “Next” #Z4lJ5, JHiH UG RGN LA, wHEMIG, RIEFREF R
5L

7. TR, BIUURE UG %% H 3% UGS170 1 UGFLEXLM H 3% T i ugv170.dat
R ENZ NIRE SR ENZ (B 1.5 Fiw, B SCHSE—417F 1 “hostname” BN
HETHINLER S -

& ugv170 - iTBE _ o] x|
FHHE REE 0 #BIH)

SERVER [QUEAdFETTR] ANY 27608 -
DAEHON uglmd x:\UGS178\UGFLEXLH\uglmd.exe

FEATURE server_id uglmd 17.8 1-jan-8 188 BCEG29ACE12988981CEC Y
UEHDOR_STRING="1852464 - TITAH, IHC." ISSUER="Unigraphics %
Solutions, Inc." ck=1%

FEATURE gfem uglmd 17.8 1-jan-@ 188 EC76C?9C3CDAYP96PCE?3 ck=118

FEATURE mechanisms uglmd 17.8 1-jan-8 188 DC9659FC9B186B54C2D4 ck=68

FEATURE cam_base uglmd 17.8 1-jan-8 188 AC26F?6C21CEPE23CE7 A ck=88

FEATURE gateway uglmd 17.8 1-jan-8 188 1C36E9BC71F57BAIB7 BB ck=73

FEATURE lathe uglmd 17.8 1-jan-@ 100 CCBG619FCO74779608BBY ck=23

FEATURE grip_execute uglmd 17.@ 1-jan-8 188 1C2659ECEBEFM1SCFFSDC Y

ck=29

FEATURE mechanisms_batch uglmd 17.8 1-jan-0 100 CCF699BCO62ANEB7AEES \
ck=104

FEATURE planar_milling uglnd 17.0 1-jan-0 100 DCO629DCEA4SLOTCSDBE \
ck=104

FEATURE wire_edm_machining uglmd 17.8 1-jan-8 188 \
ACBG29BC2AYB2BIAPEBD ck=25

FEATURE drive_curue_lathe uglmd 17.8 1-jan-8 188 7CBGGIACE1BS81221ACS
ck=1@

FEATURE sequential milling uglmd 17.8 1-jan-8 180 \
BCAG69FCABEB7F5ACACE ck=113

FEATURE flat_patterns uglmd 17.8 1-jan-0 100 6C46091C18ASD592148B
ck=8

1.5 1B ugv170.dat 14

8. SEM I A LHWE S, MAiatr ue viz B 7.
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1.3.3 TMFEZRESR

WRARINLES EA PR, URAT LR o MR85, BTN PRede UG
V17 &4t
1. MS loopback HZ UL = ) 22 2%

BIRA AN E AR, (HLAULEE MS loopback . BEAIZHTHINRK, fE30
“CONIN/MBRRELE” BIbR, $EIR SRR, BEANWE 1.6 Fros f R 2238 ) S 0 1 AR,
FE “HIIER” FIRHIERE “Microsoft” , FEMAIL “W-R” FIFEHESE “Microsoft
Loopback Adapter” , #E % [H] TR TERAT “MS loopback MK 7 )22,

2. EFPABIHN. FEHZIEATT N e R %3 UG R 4.

EFEMRE o
IEREA- P

| ig?ﬁ#ﬁﬁ%ﬂf SRBE “HE" . IDRETE-THGRZERE ,

MR
ST M) I (a):
Madze d Microsoeft Loopback Adapter
Microdyne

Microgate
Microsense

_I—I_IJ

MEEREE ).

<t—s@[Fsw>] @mE |
Kl 1.6 MR Z2HXTEHE

1.4 UG A b ik &

fE UG B b 22 5e iia, R AT LT B O R 2 e TAEREDSR, Xf UG is17#
BiAT UG M sk HAT WA, AT AL H I ESR.

1.4.1 88 UG IEBEE

7E Windows 2000 1, #fF RAH TAEREAR AR H RGEM R FNIA AL TR E .
UG %3 PUG, S HINEN M RGAEA &, U0 UGFLEXLM_DIR. UGII_BASE_DIR.
UGIL_TMP_DIR F UGII_LICENSE_FILE %%, WIS P Eys nFrisAs &, af LT FF4ab i
R, Wik RS, ERGEEFIER “my” &R, B “AELRE” &, S
HanE 1.7 Fros SR R EHE, 7R R T S R B W E .

FAh, UG ARG WA MR AR E % B S “ugii_env.dat” , iZ UL T UG LR
H3H UGH THR T, EHRKEEIZIT UG MH<SH, e U TAESEH., E X
SCAFREE AR Pattem U H % HUREUE STHFAZ R 12 . B RS EOR B U UG i
AR RS . BB R HICHEARITIH “ugii_env.dat” , FREFTEBLS AL
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B, BATIELANET.

21x]
2] x|
TR B |
I I |
- FHER (3)
T8 | & |a]
3II_EASE_DIR i 45170
UGII_IICEHSE. .. Z2T000@zhl
1ITI_FLOT_DIR 1M ES1TOVPLOT _|
UGII_FLOTQ_DIE DI \WINHT'\System3Z'spooliugplot
UGII_FLOTH_S. .. 2365 -
e, | B0 | #Ro |
wmE | W |

K 1.7 AR RE

BIINERE UG B B2 E0K B XN “ug_metric.def” , NITE “ugii_env.dat” 3
FI| UGII_DEFAULTS_FILE I &, FH4% DL U -

UGII_DEFAULTS_FILE = ${UGII_BASE_DIR}ugii\ug_metric.def

WIS AT Drafting B “Insert” IS s R K TR E 32 a4 “Surface
Finish Symbol” , RifE “ugii_env.dat” SCfFHFKE] UGII_SURFACE_FINISH, FH & &
N:

UGII_SURFACE_FINISH = ON

1.4.2 &8 UG E5eH

£ UG i, UG HIHR(ES 8 — AR v LU T2 0. R 2 BHRAESHn R 1)
1 REFHIASETT RS FARIR/AN X RIBEGE SR A HUE . TS50 E SAEER IR
TEERSHRSHRE Y, UG Bait, 2 AMNEAERSERE P RE S
o (BAEREERES D, IR 248 BB 2 AR U8 35 B bR AN ST e 1, ek [ A A
Kevt, fEARRAT ., Ui E S 157 Wi & E A s S 80 E U & S H A
B, mrEEREETSE.

CAM BRI 8 S E A S S50k B “ug_cam.def” e X, HEBIHA
S HUEH “ug_English.def” B¢ “ug_metric.def” AT L. UG i AT ME S-S H I E
A, MR EEE O C(ugii.env.dat) "1 UGIH_DEFAULTS_FILE A8 B 454 .

IR UG MR TR E I SRS BT R SO “ug_metric.def” , T E{EXL
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NHEVERSEER, ATHSCRg A GEEEA) $TJF “ug_metric.def” SCfF GZICHFAL
T UG ZR L HRI UGH THxRTD) , HRIEBUSHNAE, REHTEL.

B, R B T SRS B R AT ERAE, MO S
Assemblies_AllowInterPart )2l 1% & /-

Assemblies_AllowlInterPart : yes

W EAE T A= A LT BE 0 R, B2 2L Assembiles_AllowPromotions 124
HEEN:

Assembiles_AllowPromotions : yes

1.4.3 UG ThEem e

1E UG ARG ds g, HAREA &Rk = N F #5258 & UG/MOLD
WINZARD. UG CAST Fll CAST SAMPLE AR D) RE, 1% 46 T e AR b 7 i sk . st 1) 22
TR Rt AT 223

AN, UG REEEEIE, 41 ROUTING 25, ZedBm ik b it O 4 25 4
T RAE 2 EIREEH O F LR — SRV A T MERH, BR s ik i
Application»Routing»Piping #7488 Tubing fir &2 SE TR, 2> L H A SHEHE .
P Piping fr & hfl, miesHIluiE 1.8 Frs iR s EAHEHE,

° Error Loading Application View:
Check to see if the part library has been uncompressed/un—zipped by your System Administratoer.
M=o look at the syslog file for details on the failure.

i \UGS1T0Nugpipingiugpiping. apv

1.8 HED TEAE

AL E SRR —F, RXEFNIXEYREIAET— UG HP#aHElE, A
L UG RGN 71T, X &4 R Djae TS+ Hs “.\inch” M
“ \metric” EAEENA “tar” SO, XL UG 2ERARIR, RERCTFIRIES,
UG A v UAEHEAT, XA AR .

LA Piping fir 2, REFE UG %23 Bt “UGS170\UGPIPING” H T RILM A&
a3 AF “ugpiping inch.tar” 1 “ugpiping metric.tar” SC, R R B X AN SR TR
FIHH SN, 240 “UGS170\UGPIPING\inch” I “UGS170\UGPIPING\metric” 7
M HZF. BEH ST UG 24 2.1 Application»Routing» Piping iy &), A S HBH R
SE T, MK B PIPING 1 PIPING TOOLS PN T H 4, JH & 3 5T Iy 1] 5 th w] LA P [+
1977 AT AL

1.5 UG /= itk
FH P E AT 2 S, % TR R B A RS S ST, IR A R A Y
I 1] Ph SR 5 FR 2 b B B T . R UG B AT 7 i it A ep, P i e 7
R B R . R R — e R UG HEAT P2 B I 256

1. UG = Fh it i) — o 72
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® iR TAE
1) RS RV IWRASCRS, TR H AR IR T R

2) RG] Ll A A R v i

3) EXKHESHMEH T,

4) TR B A R RE o

5) BT A

6) LA HR, WiEJZIREH .

7) RAHSS BT EEE A BB, A AR AT H H

® UG Wit
1) FESF P RS .

UG B LI NSt Uik, AL A A WA S ORI e v R A
FT, AT DU P 45 K 2 4 2K LN 7= Rl oo LAl — 2 hR R A, T RAFE T
B BUR I SIERAC o UK X R F A 5 B LM SE R A REENL, B E
AP

2) FERRBCITHAYTIUZ E SO dh st (0 32 ZE I S HOM 2B iR (anss
B SRR o XSRS R e R ARSI, DA AR B
o [RIN I SE 4 F T 5 2577 i (Rl Az 2

3) KIXEESHN AR E s, AR SCHE DU RSN BN R Z AR 1 1%
(ISR

4) GRAFEEAT BTSRRI A AR B AT S B BT R 23

G

5) HIPORAS R 5 B A A AT Al 1Y it

6) TR RATIERES, DOZBE BT RACE Bl A, Wi, EEA
PSS

BeAh, AT BAE s IR, ARG TUR B 80— S AR S SRR FRR L
[LREIE S  H CR S Ca A A

2. =YEEMRH PR

o it
AN VRIVANS (R Jib At NS i aa AR e A R e R

o ikt
SIS P P AR AR (R DG BR Ay ,  dn S B R AT OB 5 L FLAS A M . SRR S R Y
B ER TR s RS RE i 2O A
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TR S, B RS R Ok . IR AN A RE B = 4Ry
EIERRTE R, HI /5 EAR BNZ A A R BRI . SRS IR e B
75, A TS R A AR E SIS .

UG SaVFHI I E — DSkt B 2RI, X8, WEAT DA i S 2 A 2 45
1, SRR BT RIS AT S SOE A il . X T RENS R E I BT, i
Jeig T, AR AN B RE B BETHES o NOZ I G B R I AT SE A

FEREAT EARGERIE RS, F P BRI R RO E . BT B TR g vt
IR, GRS B R feiE R R, IR BB . %, KEnid
RYTERE (T 00 A1 SR HE R BETH AR o

o B{HIKKI
UG F0VF PR (R AR T 5E 2 I, TR SE T 2 I B HO6 R o (6T B4 7
SEAE T ok BB A S

X LA 2 (IS RURFAIE, NS ATRE SN CASEDL . AR Be s T WL — teig
RURFAE T RE 2 SEBLAN 1, R AT RERF FLTBE RTIRAN AR D o XA, 7T DUR R A L]
A, T RENTT R

® ARG
A RIS T — OB GE T 0 5 IR B, — AN ARG B S Bk AT X Le 4 9
Beit, XA KN s Y

3. WIS

o FRAAMZE Cayer) MZHBERAI P AIBLHEHE
HE AT BE T DA SR RURIHEATH ZY, 0 m] DL i B i v A SR 24

® A UG BEEIERBARIR MBI,

XF YRR B, AEF P ARERE LR, BN BT S HA R, TR
il FH i 2R SRR o AR BETHIN T U R AR A R D RER e AL A o 3 mT LA
FEERRI S, DASR iR R ) BB AR

® EAFBLHIIE, R AT AL .
® N TRILEHN, ERMM trim (BB BRI AR BT AR Py AL i .
® SE{EIHRFIERY simplify (fRIA6) RAERIE R A I BEHHRCR

NG

UG B CURCH 4T CAD/CAM/CAE & A 323w, Frh i) CAD ZhResedl 1 H i
HEAT I AR U TR . Wt B Ihae B3 . As K& EAHET UG AR
RIS DIRERERPE R, I T Wil 2e3% UG 3k L UG MEREAR & DL JH
U563 UG MRS E .

TN UG FATRAF AT — LE R A S AN — SE AR B AR T P T
UG SRFHIMHIMES, ARG T b 2 NG A Pk e 2 ThgE, % uGe TH
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BIRREE SR T VS, SRR VRGN T UG ThEERIE NN Bh (6

1.6 SEF 4B

ARFTKAHE UG B G S KA I E B IhRE. UG A AR L g @, H R
BT RS A E SH&, BT bAassris H A I MR RTheE, 48 Crl LR k7 E .
UG M EF WA 1.9 frx.

B REE
EEunigraphics ¥17.0.1 - Modeling - [Displayed Part: 7.prt \ ] 4
0 Fle Edit View Insert Format Tools  Assemblies WCS  Information  fnalvsis  Preferences

Application  Window  Help = J

DeEeEdESo X || RQAEONE | @w @@ | @00

Refresh F5

Fit Chrl+F
L0 Fa
Zoom InfOut

Rotate F7
Pan

Update Display
Restare

Display Mode
Hidden Edges

Replace Yiew

%ﬁﬁ@ E"I&E E Crient View

TOP WORK |

= Undo
Work Layer |—

Mo object selected

K 1.9 UG i3 Al
UG M FEF P FEAFELLUR LR B TEX . &R SEREE, 3R,
RERE, TRERRFE. PSR YafEZE R E XM TS, N2, H— e
) EE D fe.

1.6.1 &

SCEAALE T UG AT A DhRe 2, W& 1.10 fias. UG RGUK T I fir & B
BIRIT UK, i EAEAN R RIS ST, DT R 2 S A8

U:Eile Edit Yiew TInsert Format Tools Assemblies WC5 Information Analysis Preferences Application Window Help

T om M OWE o I #H I 5 7 2 W w7 #
# &5 B A £ B # F g r i A O B
oy w
Fr "

K 1.10 UG HISEEFE
SEHRAESH File (OO0, Edit (%), View (MLED. Insert (4fiA). Format ($%
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)+ Tools ( T.H ). Assemblies (ZHff). WCS ( TYEA ¥R ). Information ({5 &)+
Analysis (43#7). Preference (Z#{% & ). Application (). Window (% ) Al Help
(FED . A P R — R BRIR T, RS REIT— D WE 111 P M e
B, BRI 51T R E R A AL .

File Edit Wew Ingert Formak Tools Assemblies WCS  Information

TEw, . Chrl+M

Qpen. . Chrl+0 Ba Al
Selected Parts. ..
All Parts

Save Chrl+3

Save As,.. Chrl+Shift+a Save and Close

Save All Save As and Close. ..

Options , Save All and Close

= Save All and Exit

IEr:J;E:: : Reopen Selected Parts. .,

= Reopen All Modified Parts

Interoperate, .,

Print. ..

Elat. .. Chrl+P

Save Bookmark. ..

Ukilities

Execute UG/Open

Properties

Recently Opened Parts

Exit

B 111 THCEs
1.6.2 TEEHFE

UG 3855 A5 ] e 3 At A R B R A, e iz A R Sh g 70 i T2, |
2.4 Frs il A2 fi A AL B R A

view x|
RAECE @ w|

kGGG 00 B a0 o

K 112 AR
P a] DR T A DO E T 7 B Py bR A, RGO 113 s TR
BER. SH T UEIRE O TR PR R E, REEWSE THAER T RoR, L7
o WER, NTZEAEAN RN T AR Efdr, AR P — ey, 2
HRE, AMEEREATEMBE A B, A S Rzl ul, 24 i i 0 x # AT
e
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v Standard

W iew

v CUrve
Edit Curve

v Work Laver
YWisualization
Studio Analyze
Studio Visualize
Farm Feature
Feature Operation
Edit Feature
Free Farm Feature
Edit Free Form Feature
Die Engineering
Sheet Metal Feature

Cusktamize. ..

K113 THEHAEE SRR
1.6.3 tRIESEH
TS RS AT REORCIRES . P B TAE R X rh s Rbs A A RE S T, JFH
TEARAAE F D REERAE RS Y AT AT e . AEREESE L rh &0 & AL H| S m 2,
W TAERR] TR KRBIH B, B 1.14 Fros st 2 8 b i s 5,

Apphy
Back
Zance]

Refresh F5

Fit Chrl+F
Zoam Fi
Zoom InfOut

Rotate F7
Pan

Update Display
Restare

Wireframe
Shaded

Partially Shaded
Face Analysis
Crient Yiew Skudio

Replace ‘iew

Expand

Undo

B 1.14 PeiEsE s
1.6.4 LB TEX

mE 115 Prosi B TEX R UG B EZETAEXE, v U T Easg: HilHi s 118 .
I A SRR H S . RN EIRGUG, S BITAEX Nt Ron SRR 25 T HA,
FISRZE W] HI AR AE LA AR R AL E
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=101

EUnigraphics ¥17.0.1 - Modeling - [Displayed Part: 7.,
10 File Edit Yiew Insert Format Tools Assemblies WCS  InFormation  Analysis  Preferences

Application  'Wwindow Help =121l
DEEE | X T RABOKE | @9 HHH B oD

TR

HEEERER

Xe | 225 Yo [ 4eer 20| oooo o2 | oom A oo T [ tooo | Worklaver [

Indicate skart of line or seleck object Screen position

1.15 £ TEX

1.6.5 RREFIREE

PRORAE B E RS R N7, B ORIRE P I EEAE . PUTEA G A S IR,
ARG AR BRI P S AHAT IS E, SR N — sk, e,
RUFREBS S T MR ME B, BRSNS H0iE, XA DUl e R AEVE 24 1R . IRE
BEAESERAE R TT s B R BN RGBS R ARG

BN ERAT 2 M B MR, SHBWE 116 FiniifE R, $TREe Hilen
B2, AR H B S B E IR A Hir. mRPREENEEER, BT %
P N T S fa P

Indicate start of line or select object |Screen position

B ESEANELZE B F®_LHIA
Bl 116 $Ron i SR

1.6.6 T{E%#R

UG BTG 1 TAEARR RGN WCS, RBE TAEARR RS . RASTELE TIEXH
IR, TR P BT AR R G, Wil 1.17 For.

B 1.17 TAEAKE &
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1.6.7 HEEBEEX

2GR T R B OE ST TAEER, Wl 118 Fron. 7 W R EEPEH N AT
KENEHSBE, HEMAEHESAPE Format (B30 S RETURIHAT B E

|'-.-'-.-'n:nrk Layer |1_ ‘

K118 TR E X

1.7 W H T RFEFE N

AT HEATEL R RRAA T UG FHlih TRESRER DhEE, X —/Nd, o
— LB I TR AR S AR DO RE 55 3, 138 R I 48 TR AR A — A ELBVE AR 1Y
T, AR T AR EPRDIRERIE M Tk, A Ja &5 1 YR h = BhSER 4H 2).

1.7.1 R T E#
RETEAEAE AT AR, Wk 1.19 Fizs, B4 File S8 13 2oy 240 5 B .

x|
DEEE v« X |6 RS
ERERRE

E?Ti%?ir’gﬂﬂ*]%%‘i;
FIIIERERL
SO O & &
4 w #

1.19 R T HAF
1.7.2 T RE

Mk TEEASHA TREERRE: M4 (Curve) T HEMYiE ML (Edit Curve) T
A, K 1.20 f11.21 o, ‘B4 Edit»Curve. Insert»Curve 1 Insert»Curve Operation
R L S B iy A RE R R

B E i = 1
B & i B % oW 2o
BeE & SE D WY @& bk oey
TS S8 a2k B EE &8 2
BN .
Be [+ % NOQ|@E (s | gx
BEDRE| 2L IEMNOE| D0
| EEEEEEEEE
RoTH E S ExgRite BEEFE
BEdE AL BEE £ 0 @
Bhophgh B & 1 phopg iR R

%%%%%% 1 B

N
(5]
~
)
"y
-y



B 1.20 miZk T HAZ

Edit Curve ﬂ
BE 4 LD
NEEEEE
WO E o RO
i By Ey = =
SamnmE DS
ﬁéﬁﬁiﬁﬁéﬁﬁ:
&

B 1.21 YmtE Rk T HA2
1.7.3 BRI RE
M2k T RS — AT EERE, B 1.22 B, B5 View S B 1 586 6y 41 X6 R o

=] il =R OR B

i B £ 2o g
MEET i EE S
K AER £ aaifF
EEEEEEEEN
?@MEIEI?@H? g s |
@@@@|@@maaamm
EXE R FEHRITSRME
T B & B o oA WA m oA A m
F2 P2 P2 F2 AW AN B B W B B W
BT E EHE B B
S

1.7.4 SR RE

Mk TEMAE =ATHERE: SSRRE (Form Feature) T EHAFL. RRIE#EAE

(Feature Operation) L EAFIFHIESwE (Edit Feature) T EHA%, W 1.23. K 1.24 f11.25

Fi7r, ‘B5 Edit>»Feature. Insert»Form Feature fll Insert» Feature Operation H [ 26552 Py
AN o
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FE O ez g — X

R —
S —

i —
R ] —

—
= —

=0 @ | o) & & & =]

&

]

@ 003 4 4

R =

— Br#E
— HE
— &
— & E
—— MHE
— W AE-IE
A0 o it
— RlEEE
— HEEE

T eH=EEE

A

B 1.23 2645 4E (Form Feature) T.JEA

=
=
aht
o
™
(1]
a
(=]
u
-
3
whd
-]
1]
Ll

o
ﬁ
e
o
.
2]
&

=

0| |

0558 4 55 s

I NEEE
—

— &

¥R 4o

— R
— iR,
—— LRl
— E R
— = = E
—— IR
—RriRE
— HEHRo

A

K 1.24 FFE#E(E (Feature Operation) T E.F
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R

e g "

ERE M@ 3

i 4 3 Be o#) e %

= E T g 5280

1T TER
[ | |

Ciereatwre

G| % g S

-

R

BH R E B

£ % 8| & i

£ 3 A F

o F Rir

= 2

E =

B 1.25 HHiEgniE T A
1.7.5 giE T B4+

H28 T HEA S A T EEPRE:: MH4RFE (Free Formt Feature) 1. E A F145 45 il
[H454E (Edit Free Formt Feature) T.EA%, W 1.26 il 1.27 fi7s, '©5 Edit»Free
Formt Feature A Insert» Free Formt Feature H i) 3 b 52 B 4 A AH X5 B .

I 2
T oEl s MF R
F o B M @R
Wi 49 eh b Hh
= @ @@ m
R

& |
DeBEUR | < mA G
R
I BF 2L R 4% 5 @ HE R %
TR - S - 1 =
Hf e EhER ® g @ @
m ®EG & @ &

Kl 1.26 HTHIBRRAE T HA
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Edit Free Form Featureg ﬂ

PR N S Al v
BB osoE R
B B wn TR
EE %m i Al E
| 1
4 S i)
55
]

1.27 Sk MRS AE TR A

1.76 LETEE

Mgk TEE & =T B B L EbsiE (Drafting Annotation) T HA%. 22 &R
J& (Drawing Layout) T HAF“FIZ:EZ%( (Drafting Preferences) T.HA%, 1l 1.28.
Kl 1.29 #1 1.30 fran, &5 THEED R T, S5 Drawing. Edit 1 Insert H 3

L= N ER P
Drafting Annotation ﬂ
“EHB%OF 7| @Y @
BEREEE
FEEZ =@ 8 B/ 38 W &% %5
TEEHE AN A wd #5308 88
T® ERB AR LH3 LA
i3 S SFETH BE%AOm
G o iR R
7 Fam T8
=

K 1.28 2P THEA
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AN

v HkRE E

I T T I #

= EEE M

HEHBEH H

[

Drawing Layoukt ﬂ
DEnE| E|
EEu@ bR axs| |y
e
FTREBYTITBSRE R %5 &
R fwa o
AEENARA BAX T
BEAMEEEE @8 B R
EH#l i 8 W =

E " m

K 1.29 WA R T A

Drafting PR
B B &
BN
8 & 7 Bl
= FE GT mm
M= F
B &
e #r
#r

K 1.30 ZEZSH T A
1.7.7 TEEMEE

B EEN UG IBETh BRI, O 1A BRI BOR IR B AR X, A8 s
N UG A& SR — 285 MR D RAE Sz DR B % H D RAS, AN By i LA
PR T HA ) AR B b 2] X A AR B QR TR ZOREH UG RETH) T A
£

2 PR FE R HISE R View» Toolbars» Customize, BRIEHF i3 H
Tools»Customize, BY7E T € A7 I T HEAZ DX I8 oy SRObR A B8, MB LR PR PR S B b e
P& Customize K HLi1 4, RSB UIA 1.31 Frocl LA EXUEHE. FIH1ZX5E
HE T DA 7~ BRBRERE 6 TH A B T B A AR i S e bR, 38 mT DACSCAE b | R ST
g, WaTLF AR E K TR,
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Customize

Toolbars |Cu:ummanu:|s I Cptions I ser Tools

Load

| »

Reset all |

[~ Global Seleckion

[~ Curve

[ Edit Curve

[+ ‘work Layer

[~ visualization L
I~ Uity

[ &nalyze Shape

[~ Visualize Shape -

Close |

K131 TR BEXHHE
THEREXNEHER LA 4 NINREIETIR: Toolbars ( T.EA) . Commands
(EFrT%4HL) « Options (BEEIET) A1 User Tools (FIF LEAFL) o JEBEAHN LT
Ja, IR E AR LR T, T LT A TR WE 1. NHE— T ]

FIHIX 4 A DhRedk -~k TR TRE .

1. Toolbars (T EAFS) &I

F P % Toolbars i& T f5, XFUEHEN BBt anPd 1.31 fion. ZEDiR AT E En
B RREE S T AR, A DL E SN TR E O, 8% T A 2 O )
HE SUOREE T HFL,

® N BB LA
fE Toolbars LA HEAT, 28 T A A FRAT IR LLHE,  JUARR (9 T RAR Eon e
LS by WRBGE T TR AR RAEHE,  E S b ARG FEOEAR N T EA

® AT HEME S
FEE 1.31 JronBIREHE,  Hidi Load #4023 S N T HAE SOCAFXTEHE,
R AT BB RS TRASE OCF (*tbr) o

o HETAM
1EE 1.31 FosFIRHEHES, Hiidi Reset All 4%4H, W RGuox4% TEFE U 1
AE SCREFBE TR, fRRE A i ER A,

2. Commands (EbrFED) ETR

LT T B BB TR I e btz . R FZIET R R, WIEHEN 2
Ik 1.32 e i REE 7R B REECR: T RAE AR S e - R4, RSB M Toolbars 311
M, PR AT A R T EAS, BT T HA A5 i 4 A0 AR A1 44 IR s 7
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Commands H&HEH . 7 7E Commands 2H-& HE A% H el BT Lo bR 2 2 AR R 2
JEAE, BPAT A i B bR 4 e 70 AH B B A R R 7 B RE R

Customize

Toolbars  Commands |Optiu:un5 I User Tools I

Toolbars: Commands:
Standard | | Layer Settings =
View A
Glabal Seleckion [~ Layer Yisible in Yiew
Curye [+ Layer Category
Edit Curve
Wark Layer [~ Move to Laver
YWisualizakion [~ Copy to Laver

¥ Separator
Visualize Shape | [ WS Origin

Knowledge Fusion

Drafting .ﬁ.nnntaf;j [v WS Drynarmics
»

Firawinm | Awon ik

p [~ Rotate WS

[+ Crient 'WCS -

Information | Reset |

lose |

K 1.32 Commands &I~
FAb, WRIEBUZAHEREF F Information JET, M RSB NEEE D, IHE
Horb B P TR E SO WA IEHL Reset #6100, W R G0Hs Fridt T B4 bR
TR EERECR SR S 2 AR

3. Options (BEIETD EIIF

TR T B T EA BRI A R RIS T RAS RO 30 3 5 i
PRGSO E . EFZEIR S, MIEHER N A WA 1.33 P, NEY
T Hr B

® Icon Size (EFrR~F)
T T TR R R R S), i iR B R G AR A0 R R~ FRLsk T
KL . KRG TN 4 P EIBR LR ST A

1) Small (16X16) : /MF (16X 16 %)
2) Large (24X24) : KRS (24X24 1835 &
3) Double Small (32X32) : /MRS 2 £ (32X32 %K)
4) Double Large (48X48) : KR~FI)2 5 (48X48 5%

® Coloricon CEtBEHR)
EBGZEED, W LB R B izl o AR e r 7 203 T B, B0 H R

o
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Customize

Tl:u:ull:uarsl Commands  Options |I_Iser Tools

Icon Size

{ Large (24x24)
" Double Small (32x32)
" Double Large (48:x48)

v Color Icon

Cuefstakus Position Cocking Priority
= Top f+ Horizantal
+ Bottom i Yertical

Close |

&l 1.33 Options i%IH&
® Cue/Status Position (FE/RFZFLIRASFALED

ZIETUH TBE U6 A M h s ARSI Bon i B Kb A& i FpAs ik

1) Top (THER) : EHOZHED, IR RENREE K PR ES B T/EX K EJT.

2) Bottom (EHE) : IEHGZHIEI, WIFRAEARERE BoREL B TAEX K T 7,

® Docking Priority ( T.EA&27750

ZIE U T3 B TR RAKFERBOE R T E R KPS R oA Sk,

1) Horizontal K~ « EHGZHEDT, W T EAZKFEIL.

2) Vertical (HEE) : BEHUZHIEI, W) THAHEEIRK.

4. UserTools (FHF THA) Eui&

ZIEWR TSR @ O TR (Futd) FFCE TR BREEH F e SH
THEF . EFEIE, MHEHER AN A WA 1.34 fi7x. User Tools HAHEFFIH T E %
ANBIH A€ T HRA=, 2 AR § ) 2R AR R ik i B A P TR R BoRit 2
Fajml. UISIERE Load JELT, WIoxsfith S A SCHREHE, F P AliksE e M T REFA
fF, WMRGZHHIFAN.

M PAEER T TRAEKRER, TrEMBSa 23288, A, Options 1%
+ H ] Cue/Status Position FI1 Docking Priority iX PN ETIESH TR B 5, AUE )5 5) UG
A A EIN TR
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Customize

Toolbars I Commands I Dptions  User Tools |

IUser Tools:

I LGiMoldiizard: Load |

Close |

1.34 User Tools &3

1.8 UG T Re B 133 N FN3E B

TEE—FHIRAINH T UG RE IRV 2 BT DhRe i, X ELBRTE UG  Ftif
TR Ee R RAE A B FER N B, W Modeling (SEARIERL) | Drafting
(TFEED . Manufacturing (JN1L) F1 Motion GEZN5E) ZEINREMEL, S ATH#E A+
7E UG T3 HAf] Application ST .

MJEBh UG, #BEAN UG EALHN, R7EH Gatewny N M A TAER) . I UG F
A MR RS 2 K2 EON K BRI, F P 75 B R S At SO BT AR )
A AR A REH AT J5 21 T AE

F P AT LS 2 — N A SO BT I — MR B S, AR Rk MR
Application, LB R HHEWIE 1.35 Fial FHSEHE . % FRSCHEAIH T &8
P24 /R, P AR 75 20T A B & TR ORI R B AR TT 46 TAE . Bl an 2k 47
SARIE BRI, THT BT SO JE RLIE B Modeling LA 4
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&pplication  ‘Window  Help

TSRS ——  Modeling... Chrl+M
TilERhw#Esth ——  Shape Studio...
THEE#EHR ——  Drafting...
NI ——  Mapufacturing. .. Chrl+alk+r
EEEJ‘E%*EE& ——  Skruckures,..
AR R ——  Moldflow Part: Adviser..,
E@]{Hgﬁﬂ% ——  Mation,,.
BB ——  cheet Metal 3
EHETEE — Mod Design 3
%ﬁﬁﬂ ——  Raouking 3
Eﬁ.ﬁ?ﬁﬁiﬁﬂ —  Wire Harness...
SRR Ascemblies Chrl-H A+
A —— Gateway... Chrl+
HFRm=iHES: ——  User Inkerface Styler...

&l 1.35 Application F#i3Ee

AN UG M EERG T & b, KA T HTML GBESCA) ML, X
MEFE B HER B RS, (EARRARE T, @k e A P ] eE RS 5 B .

W EE CRINLES 223 T uG vi7.0 IS RS, W] LLds LA Rk s
UG MBI RS, BalEr#EEiE D& 1.36 Frx.

1. fE UG ARG, I FEAM Help NHgHar4, P AT LURTSAH R (1) 45 B
fFE. HAa DIEM I se@E BI5E M, PEHPERE F1, RESHZAE UG
R T, I e A A 2 T Dy Re A8 A 1 B4

2. WA BL Windows 2000 f#] 7145 » #2£/7 » Unigraphics V17.0» UG Online HTML Help
AR E 3N UG I P T, ARAE AR & R N 25 P AL A DR SR AT AH R 35 B

E? ¥17.0 Unigraphics Help - Ellﬂ
8 & = = g El B
PSR FEfL FIE At En $TED BETM (@) UG Solutions UG Answer

BRO | #3lw | #Re]r 5 = 7

®

e oumenl (W J/0r3p0CS Sololions

@ CAM

=@ CAE . .

= @ Sheet Meta V17.0 Unigraphics Help

- Routing

- UG/Open

=@ Interfaces UGlOpen

- Translators

- System/File Managemer « UG/Open API Reference Guide

=@ Custamizing/Using UG

- Other
g NOTE: In order to activate the TG/Open APT Search, you tmust
open the documentation for this application directly. Checl with your
Systems Adrmmistrator as to where the documentation files have been
mstalled, then go to UGDOCHTML_FILESwgopen_doc'main.html.

+« UG/Open C++ Programmer’s Guide
1 B— al | _'|_I

1.36 UG H - Fiit
INgE s AR EFECLEITALIE T AN2E T UG 1 AR i S &4 i D se,
BIEE T UG MABEAN T FIMEFEEENHA T UG s A TR E R E
TR & ORIl 3 5 UG M T A, DL UG DhReREH it N0 e {3 FH 7226 75 B o
S F WIS AT ], BB EE UG MERIDIRERIE I RS E ik,
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—\ HEE:

I AREE T HMEE,

2. AGHEIBHEEPPIHIRE . LBMEZUTELH], Fith. LRGSR
E

3. RN IR R R T e
Z. BEFER

1. FEFERE . 2SRRI L0

2. B RFAE S 4
=\ BERER

1. FEEI LT 293

2. BEIRHIE g e

M. =5k (BB) AREEXR

1. F7 B R0 1) e P R T 22 1) > 15

2. B LIRAG®H, MBI IFas, Fe2 LME, 7A7 e, e
25T 215
Fi. BEFE:

i AN VNN /]
VAR 0F

12 271}
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EE s

L (Sketch) & 5SCAAMRUARIRA) —4EEIE . 12T RE AT LAFE 7 B AR —>1- [ P 2 AL 5
Bp, BEMAE S Tl 5B S Curve ThRET Fr il B S KIS F R BB g n 1
“EURT IR, B LR BT LSRR A R . MR TR, AT BT
(R 2R 55, ARSI A H0E SR, T U BERA BT R o S 5 e T s i Y
TRBEATHIAR . Bee A, RS R SCHR SC AR . B I, SRERASEA Rt 2 B
NS, AR BN GESI R AREE . g B B TR

2.1 BT HXEHE
EI%%%L&%mwv%amiiﬁﬁﬁlﬁﬁﬁﬁﬁﬁ@ﬁ,M%ﬁﬂﬁ@%%,ﬁﬁé
5 EE U] 2.1 P BRI A AE o N2 A 2R T AE P ) B RS AR T AT 57 200K GdE AT B

S UHE By R B i 2R Qe AL, e PRt U AR . S R IR A MR RESR
2k B th 2 A g 4 it 28 55 8 RO A B AR SR i 2. 23t N R ERIRECI . RGTRENS LU
IHRERBLE AL P QU I 2, A EA T4 T 24 A i 5 B i b

R L0 A P e P Th e IO PR M P B =T . TR I R T
B G e E T E DDA . FE R E R T2 F 00 6 1) B B R AT — S8 Y B D R AR A
AR, ARG T 7 MR EERAER DT BRI ER A E TR E SR A RO R E)
T G S 2S5 RIX 4 DI

B AE N AR A LB R R TR A T, T R os R R SRR A
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Sketch Tools

Curyve Consktroction
Z A H L mamy
=Y
Sketch Options
A 24 — ERTREER

5B o 8 05 el sme

'O Yy B D] - R

Eﬁﬁm@?‘irﬁl —H'_ Zhange Yiew Orientation

Laver | Skekch Mame

-—— EETIFE
BT E —Wctive Sketch
[SKETCH_000
Bk —W=  Acfivate Deactivate ‘-'I__ L Runy o
{262 B <t 5 57— Retain Dimension Display
BEHE R —— - Update Model |
)4 Back | Cancel |

K 2.1 FEDRENTEHE
2.2 HEThREE I

L DIRER I B 7R R s SN EE R R AR, A R B bR 2 AR
FEThRE, AL R AT R IR
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2.2.1 EERRE

FTOT R EDSTEHERS, an R BT AF P A AE R, IR B 2.1 WP IEHE ) 5 B B ZRAR Ao 7 A A
FE AR, BTSRRI, IR RS T, s T S R AT A ORI FE R
R P IR BA AT R, B BRI SRR . RS i e T i B R,
JS2 5 8 4R A ST R B T R o Ja S R PR A 0, 47 S R T A S R e P b o B o e P L AT
%o

1. TR TR 1

P AR T A 2 ) B P B . AR E R B AT R LR 5 (i ZRE D AR
FEAE L B AT A B AR AT DU ARFRT . By . SRR B AR

%Ez&ﬁﬁﬁ*%ﬁb IR, 2 P 2.2 R BIEE B BRI AE . A% RE
FEARARRRT T T I S AR i B Py AR i sl o7 B P AT i

Create Sketch

Selection Steps

S

Filker all L iR

Sketch Plane IFau:e,l'F'Iane ,-I

C5YS Methad -— HAT R HIERE

Sketch Mame -— EEER

-H— EESIR

SEETCH 001

A H ] Reference Direction
¥ Horizontal Wertical

Fap ——#= Reverse Direction I

[VE: | fpply | Cancal |

K 2.2 B B ST HE

O TEHE L 8 % B JEIBR A 1 T AN € 5 2257 A BV E D BRIE b, Pl A S0 1 i
WML ARG T, h 2 B B AL AR AN I T S 3 B I AR i, SN N AR, kg
B EIPAETE, e TiRE FEE S5 AR SE R B AR I L A N IE 4 N
B LT BAR
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Attachment Face/Plane (Jf{% & 1H/ 1)
TS B B E R ARPRF I  ZEEP . SERR Iy R, Rk, deRE i B b & s,

HFTEATE R AR SR AR B ET, 2 R B 2.2 SRR R B AR I Bk . BEE
FAAESEAR S RN TR AN [, T AN [R] (AR A T — s )3 5 B i AR 00

1) AFFLESEAR. PR Bl 1 i i ade 5 P B 1

WG RTERAE R AR SR . AR EEHEF T, WIZEST IR 2.2 XHERERT, H 5 Sketch Plane
A1 Sketch Name X 2 MMETHBE . &Y HJRﬁEIﬁhIf’EJJT? (10 A o~ T A R L PR A
[, M Sketch Plane BIJZRAHEHAL3E T XC-YC. XC-ZC F YC-ZC iX 3 NI, 7 ik $— A drnF
TR S 5 ] D B o T

) ERAE AR AEAESEAR L P AR B HE T I 2 A R B i

WK A AR AR SR R BRI HE T, UAEST T B 2.2 SRR, 55 1 P = 1 P A e Bk
o DU REATIERBEAR PRI AT DL RS HE T I SRR T B R SR I R R B A . RS
Sketch Plane Z1ZRHEP R T ELAE AT A 3 LI, IEE N T —> Face/Plane £

G AR BRI . SEARER T B R SR 1 b S R ] AR, N Sketch Plane TR BN
Face/Plane, FMREERFEAINT R, TEiLIESS Filter H I B IREEXT G2, AR ERIZL K TIEX ik
PRI SRR B T R I . P Baiinse, FFRaRHEg&Irm, B zc #ym. xf
TIEBMMEE P, WERH BIRIEL T AR E R A, 1li%E$F Reverse Direction T AL /7
7] o

o @ Reference Direction (Z%J7[])

W R AE AR T BB AR, WA BIRE BRI ZHET N, R4t H 30 ARPRE ) 77 F
ﬁ%@ﬂﬁﬁ%ﬁﬁ WS RAETEAETH  SCARR T E AR T F s R TR, WE RS
PR, BN EEEZE T,

Bl 2.2 XHENEFR 2507 W R, T ARE TAEFEE K FSE TS EESE . &
ZRbR G, RGRRERSE TN, SerEidiEs Filter A BRSNS R KR, HELKTIEXH
RBAENZHETT IR R WIESE T B 2.2 SPUEHEH K22 77 [7] Horizontal BT, WU Frife X 52
PR RN TAEFIRIE XC 5 dnSiES: 7 E S )5 W Vertical 00, T B x) GO N T
YEFIRIE) YC il &S E TG, B 2.2 XIEHEH Reverse Directinn iEIUA HB0E, a0 R 2R
RETJTIM (XCELYC HD , AERGZIED, DUP=A4H 7 M 22 T7 R &

® Filter (ILJEZH)
IEa%k T F 15 B O G BRI S5 e 2 BR e S AE R 1 B T T BERR RS, Filter B1)3RAE
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RAEA Al (T + Face (M) A Datum Plane (GEAEFIR) 3 Nk M5 EHS% 7 W K
i, Filter ZIRMEFAEH Al () + Face (F[f) . Datum Plane (FE#EFIH) . Edge (i) Al
Datum Axis (FEVERE) 5 ANED.

® Sketch Plane ([ F1f)

IR T R EP I @A E . H A 45 Face/Plane. XC-YC. YZ-ZC J% ZC-XC V[ % 4
ANET, 4N FIEFE Face/Plane JETI, W] {E CATAE 2R [l S HE T A0 B 1. Wik Y Xy ~F
[l YZ ~FIEG ZX -~ PI7E TAEARER (WCS) b S BT

® Sketch Name (EE4FR)

W SCAKE I SR N @ B R 43T T 2.2 SHEHERS, Sketch Name SCAHE 0¥ BoR R4
BRI EEI A FR, U1 SKETCH-000. SKETCH-001. SKETCH-002---+++%%. FH /v A 76 SCACHE rh 48 52 H e
R, BN, RGERHBRATRIENER AR —BORE, A RFEE O SE, AR
BIE TR AR 8 LEE AR, B NFERuags s, mMEAERARZKEIE
NG, RGHEHMARZIRSCARE .

® Reference Direction (Z%Jj[H])

IR T T B R S T7 ) E CRA, Hrh a7 (Horizontal) 7K~FZ7% 77 ] 5L Vertical
FEEHSE T, WRED Horizontal FLEHZE], T Fridk BRI 225 J7 [/ 2 1 1) XC Ao an ik
W Vertical FLETEAH, g B 2% 77 ) R S THI ) YC Bl

® Recerse Direction (Jx#Z% JA])
I ] i R e R S 771 .

FERA TR AR, BHFEENE TN E RS E TR, ARG EIERNRTN EZiEE
Z2J7 A R AR IR, (RN SR 2.1 B R AE o SR PR o 1 2 e P AR b1
W24 2.3 PS5 B IARic . &R AR IC 2 — S TR AR SR R R s . S
AR XC-YC I, NIRRT, PIARZE MRS 70 504 XC 3hAN YC 4, FHF SRR R . £ELR
RIS, I BB, AT IEEE Edit> Blank S 4 H R

Kl 2.3 ®EFH
41/ 454



Un SR RIS AR PR T SeAR B AR SR I, WS TR EE, TR R
BIpmikm oA E B, AAZER 2.3 Fos 5 BRI IC .

BALEETAEPIE, 2 NMEAEEENENER, RGAIER—NEERE. o
it SE A4 Information>Feature, 7] LAE BZEEIFFER — 25 B BT B A2 DURHIE B 77 A7
16, Bk, WREXTEEEAE, oS SEA AR VR, R AT B SR E L
P B R .

2. BIEEEXTSR

B GO AR R P AN e LR AR i, A AT b S R B
SN RN EA 2R, B RT DU B BRI il 2 el e, thon] DU B 2.0 XA
I — LS ThREFRAE, WIne: B AR XAFAE i 2R sl m 2R o, 38 m] AMSIEAAR B0R 44 L4 OGS 5 381
Kb RIS — N B P ER e S B I A s, R HA R DI RE, JAT= )R
T (R T P R B2 A 9 2

B 2.1 GHEHE F A S B U 28 BT bR, AT E B 1 B i A R s R it 2. X el
FrflE Basic Curves (FEAHIZE) . Point (&) . Rectangle (JETE) . Fillet (BRI ) AR
(Ellipse)  FEZ5HIZE (Spline) . General Conic C[AIHERZE) FlgmiE izt (Edit Curve) o W iXst
Elbr, nTLAERLE g T AR T LRI 5, BRI AR 20046, He BT, 55NE
MR ThRe R A A, XA LN H T .

FERE S FE R MR, ARERE RS B e, A I th &g BRRImT . KDy, fEJR sy
DL HRAEN T, ATt DRI e LA T RT AR UL RONE R, 52 F 7 Al DU
BRI EATR RS ARAGL B AR S B AR R o, IR LT Rk &R, A& AE
JUATHS 5 B B BB IR J U AR (k. SEEAAYD .

2.2.2 EEMEAL

HAE 2.1 W IEHE P B @ |l’§lﬁﬁﬂ‘, SN 2.4 o rE ALy A IEHE . A DI fE
e R S5kl S5, BRSNS R MR EKR.
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# + 4 +

LT A
+ + —

AN S

Reyverse [ormal |

1]:4 Baclk | Cancel

K 2.4 sERLTT XSIEHE

ZXTTEHEH L5 Horizontal (JKFENL) « Vertical (FEELENL) « Parallel CPATEND
Perpendicular (IEAZEfL) . Parallel at a Distance CCFATEERENL) « Angular (FAEELNL) « Point
onto Point (W mE A ENL) « Pointonto Line (fiFIZ FEfi) H Line onto Line (MZE G ENL)
JuMpEN T XA TS 3.6 /N AR AT AR, HATH 774X AN E S
I

SENLFEINS, MRYE S R ALK, (R 2.4 WIRHE P e S G R 77 20, AR TP AR s
POREFE AN R MO, ARSI TARX i $Ese kil . SEmE-V i AN el A4 Dy e L K 2 25 3
#E, HEERNR HA RAR R T BT E R EF AR SR, R TR
B, IXIN AT AR B PR B SN E B RE AL R . B R A LRI XU AE, AR B
R, AESCAHEFFNGE SR BV e OB e . PR RFED 7%, e S R e e R, =
R EWER, WARGSEFEEEZMAREM RS EAEREN R b HEERIETEEE
R, 22 1) 29 R Bl BOG S ) 8 B AN B kAT B e A 4 A

2.2.3 EEMNERNME

kN S S G N i e = TN (< st b T e VAL R S 2 221 7 e N N R A
SEUET T S SEARFRTH T AR T L.

] 2.0 % HE Ao S T 25 P ﬁ I, o 2.5 (138 P E R,
AR PR B R A T I 20 TR AE AR AR T TR R L B AT SRE S
7 T R EE I P B P R A IR IR . R AE T BT S R AR DGR I, N
Pl 2.5 XPEHERT, AT R BTAE P 22505 TAE LR S s e o . ST B B I
FAR P I AR AR R R B, SRR e 3 NP R T .

s
. jﬁiﬁ%*% (He s HFRINETD bR
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EFZIETR, Al Filter BT E A ST AIEPCERA, SR A E2 B AR X $3 A7 AL R 2
HET I SEARSRII B RR AR Dy H AR . il Pl & DA L oR, JRAE Tk b IBos R GTE B
K122 J5 R &

Reattach

EiF R Selection Steps
‘ @ %@ @ w
T IESE —Whilker IDatum Plane ‘I

—Direction Reference -} HeEE
% Horizontal " Wertical

Reverse Direckion 'I-I—— 7]
Reverse Side '-'I—— RmE
Specify Crigin '-'I—— e ERE=S
Delete Pasitioning Dimension “'I‘_ RiblRF: 3 for =T

1] 4 Bacl | Ca.m:ell

2.5 HHTHEE R EHE

2. iﬁ%@ (ZHiD Ebs

SERMERRER G, HATEESH 7 M ERIED IR, X B 1] LLESE Direction Reference (7%
J7 ) ") Horizontal METEY, Vertical LT, i iE I RRAE K FZE T M CPATTHE TR
P XC HD I8 RAEAEEZET N CHT TREE TR v D o i, SR TEX PR
INSEITAIRE, MR HAEER, WiEF Reverse Direction UE S5 )7 AR & 7 17

vy
3. iﬁ?%& (EWrE LR ERME) Ebr

W F RS LG, AT DAEDEH R e R T X s R T e . iz lbsE, Raitn
FH P e S EOR S SCHIRT o AR 2 PR AR DX Bl 5 (6 RS SRR SR AME ik 5 JEOR I B RSE - P
WEA RS 2 st iR . FHE HARMEE T LB AN 8, VR E G RT3k iE, SRR R R
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Fi 2%, HARE R RMERE R AT, IR S B 0T A T ERSIRE AL W SR AR ]
BATEAL, R e SR BT B EME 1 BIboR A eSS -« FUH e O A BRI, 5 ARG IIR

INAREIEE IR EABSUE AL RS, Eiﬁ%%ﬁiﬁ%ﬁ&ﬁ%i&l@ﬁ@éi%ﬁﬁé\
Edit»Feature» Positioning.

FIHAH— T 2.5 SHEAE A AR T

1. Filter GIyEED

I I T B Ik B T B2 T [ s R, A A T AR R 2 P 7 R R
2. EAL RS RMBIRAE

ZBRHES T BT A A (0 A RO 2808, B P 7 o7 5 £ 2 FRT BN o 9 5 6 RS 1 36

3. Direction Reference (Z%7J7[H])

ZIETH T WE R R EREESE T RN, Kb 7 2 Mk,

® Horizontal KFJ51M) « EFEZIET, WPkl K-FZ%T71, 1R TR XC
° iﬂi;tical (EETTF) « EFZIED, Wikl B 2% 5, EAREE AR YC #il.
4. Reverse Direction (X#5Z% 77 [H])

ST THE RGE GRS T 8 AN 2 2RI, RS RENTT .

5. Reverse Side (FEVEZETT IR

20 ARV IO, R4 Hes, E ) O AR GRS ik 7

6. Specify origin (f8 € Ji &)
ZIETAH T8 R R A B, R R R e P e .
7. Delete Positioning Dimension (HHIF& & 437 )R <))
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QU AL AR R AR W2 TR X & Bon k&7 Tk, JFH B ITHE, s B &)
BAEAE BRI TS 1), 3 FF Yes W S IRAE AL BT[], 14638 No 532 BRIy 1] 355 L3 AT K
FBRAEUGAE f e £ — M A R BRVE R R AT S i B A 1A - 18 3.31 oms (it i ph oy s 1

NO: BEEEAM YES: FREEEAM

B
[3%;)
Height
Back | Cancel

Kl 3.31 Height, Arc /7=

3.3.3 H#ix

Elﬁlglﬁﬁtlﬂﬁﬁiéjﬁiﬁﬁﬁ 7% Insert»Form Feature»Cones, ZRGr<=5f a1l 3.32 fir
TNV HEAR RS TG HE

Ciameters, Height

Diameters, Half Angle

Taop Diameter, Height, Half Anale

|
|
Base Diameter, Height, Half Angle |
|
|

Twio Coaxial Arcs

0K Baclk | Ca.m:ell
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K 3.32 HEARXTIEAE

FERS LA A 5 —Fh R A T 30, 23 A N B AE S B . A S HU5, B AT a1 R
HEo TR AN TR R PR [ AR R S

1. Diameter, Height

I TGS € IR T ELAR S T ELAR A & B R A s R (K 7 SR [ . PRz il SR
ERPEEHE, M TR E BHER T M. WIS R, S EH A 3.33 s i HES Hou i
HE

Top Diarmeker
Height |3|

(1] Bacl | Ca.m:ell

Base Diarneker |3
I 1

& 3.33 Diameter, Height ST i5HE

1E Base Diameter. Top Diameter Fl Height SCASHE A 43 75l i NI THT BELAR T T A3 R s B )L
PR R B 1 HE TR i [ 0 [ Py O B, A s FE 5 HH AT ZR BRSO T HE e 38— Bl AT /R 4384
J7i%, BRI SE Rl B g (R R 35 E . 1] 3.34 P st X Ao = )

Tnd iz

]
Ealk=lR

El+E

3.34 Diameter, Height /73{

2. Diameters, Half Angle
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ZIRIZAR E MR B T EAR M AR AERTT R A BB . Pz, <
KEBIEREHE, FFFa5E RHE AT 17 . MIERATT 1A )E, =3 518 3.33 MR 2 Hont
TEHE, HJEEJE— AN SUAMEH Height 25 Half Angle. 7EH R SCAKE R NIRRT
H, FAKIEARS SRR 5 80 (K 3.35 Pros ot 2 B A ERD .« EAH#H
H RS TEAE i R 5 SR ) RO B R R A KSR T PR I A R 3R T
%, BT s el B HERRAE . B 3.36 P Mt X Al 20 B

K 3.35 [RIHE A R

RE [EHEREE R

BEiFRE

10°

3.36 Diameters, Half Angle J77'{
3. Base Diameters, Height, Half Angle
ZIEWHZARE R EAT . = A A AT 7 SNAE R HE . R BaZak i, 2l R ER]
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FEXSTEME, FFHa e RHERI 2T 17 o M STy 1), 5t WP 3.37 Bl i) [ 46 2 HOR R A

Base Diameter IE

Height I 1
Half Angle Iél 3]
0K Bacl | Cancel |

4 3.37 Base Diameters, Height, Half Angle [E%EZ #0515 HE

1f Base Diameters. Height Il Half Angle SCAHEH 73 Bl AR mEEAEAME, FARER IE
Al R R R SO BN TR AE TR € HEAR IR [ RO A B, S AR B AT R AR ok
— AR ERAE DT, BIRT 58 B 5 e () 31

4. Top Diameters, Height, Half Angle

ZIE DR E T EAS P P AT M BT N a R R . Bz, 25 H R Ea
SENTEAE, TR E R R TT . MG R 2T IR e, i S K 3.37 AR [ HES EO TR AE,
HEH—ACAHE HH Base Diameters 2% Top Diameters. £EAH N R SCAHE i AT = LA
f, CEAMERTIER . BRI A 0 S B TENESR e MR B 1 O B, B S RS A
IRERAE XS U HE IR B — P A R ERAE ik, RIRT 58 RO 3 e 1) 31

5. Two Coaxial Arcs

R IE R E PRI B B 9N SRR B A . B2k T, 29 X SRR FERRAE, 1L ES:
B LA X A R I, U208 I A2 A0 mR o s 0 AR D [ PR JER [ S AR A e o SRR PR 5 —
I, AZ I IR ARAN L 5 73 55 A D B B HE A TOUR AR A Rt . SERRIRI e £ Je IR HER
ot 2 RS AE R B [ IR PO b, AR A R AN R A, AR G2 DASSCRE IR 5 20 oo (5] I3 21
HE I Lo 55 AR 3 AT R BRAE X TEME s £ — Rl AT R BRAE Uik, BV AT 58 BB St T PO R A
P 3.38 B s A& X A7 20 B
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BAIEE
HIEa,

—

B
N
ra
k\f
X

& 3.38 Two Coaxial Arcs 5z

3.3.4 Tkix

Elﬁglﬁﬁqjﬁﬁiﬁiﬁﬁiiﬁﬁé\ Insert»Form Feature»Spheres, ZRZGi<x3 i 41K 3.39
Frm B ERAR RIS HE -

Diameter, Cenker |

Select Arc |

(1]:4 Bacl | Ca.m:ell

K 3.39 ER{ANTIEHE

FEERONT AR F e — FPERI A O 20, 3 BB I ERAR S HOEHE, £ o ABRIA 2
B, RIATEIEEEK. T/ — TG b MR AR A BT A i,

1. Diameter, Center

IR IUZAR € BAR A O AL BT BV ER . Iz T, S A 3.40 PR B ABREL
FERAEHE . AESCARKE BRIV EAR S, AR5 A G TR HE R E BRI L R L . R A5
H RO AT ZR B A XA PP e — P ZR3R AR U5, W SE B BR (K41

Diameter I 1
0K Baclk | Cancel |
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& 3.40 Diameter T iGHE
2. Select Arc

TR € U7 SEERR, FEE MBI EFZIEI, 2 GO FERHE
HE, AEF L B AR X Rk — 9, MBI AR AT O 5 20 A 9 G BRAR ) AR AN ER
s o FEAEAE S IOAT ZR SR AT U AR P a3 — PP R 3R A U505, RIATSE B BRI ERAE . &1 3.41 i
71 BRI A 7 3R B

FiTiZ& A .

K
%‘r
K
K 3.41 Select Arc /7=

3.3.5 Bk

Elﬁlglﬁﬁqjﬁﬁi@ﬁiﬁ%%iﬁﬁé\ Insert>»Form Feature»Tube, ZR&Gi<5Hiw& 3.42 flr
TN AR ST EHE

Ciuter Diameter |1
Inner Diameter IEI

—Output Type
{* Multiple Segment

" Single Segment

0K Bacle Cancel |

K 3.42 EARNTIEHE

ZATAHE T E T RS, AN K SCARE PR NG RS EOF R EAMOGERTUR . AR)5 # ik
G IR GREHE, LR X B B Ja £ 5 R AT R SR T A e 5 — AT R A s
%, HIRSE BB E AR RIERIE . T — T E A T HE T & T AT -
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1. Out Diameter (4M%)

WOCAREH T B EIRSME, HAELAURT 0,

2. Inner Diameter (N1%)

IR T W EE RN, HELBURT ST 0, H. Inner Diameter #2451/ T Out Diameter.
3. Output Type CFEMHFIZRAL)

ZIE U TR B BRI AR AL, e MR RRE g P B . B Single Segment 5
Multiple Segment P54 E 15

® Single Segment (FATED)
IR T W B E AR A — B BR T, BN B-FE2&HI T . 4 Inner Diameter 55
T o A —BEEH.

® Multiple Segment (Z7EX)
ZIE DU TR EEERRNAZ BN E S,

FERBIERNSEUE, 25130 GUEBHEE, 5150 %A T € LEERTIR 5K,
RG] TR, BEn RS B TARX A ERGEFIOR G NG SR, Bl Jeft 5] Xt GO HE
FRE S X RMRA, BAEL K TAEXPEFZEMPN R WRRHRE R, HigHs SRy
fH, ARk RBHE IR, TN RE, WA RS T 5] S SR A Rk
J7A BT o R — 5 5150 GO T AE R BRI Rk I

1. Solid Face (SZAAFERMH)

3 uU YA El apvivt £ 2 S 1T v T s 0 T s B a2 P T AV g v & S T T M e
B2

2. Solid Edges (SEAid)

ST TR FE AL N5 S

3. Curve (HhZR)

TR T30k R AR i e B — ST R B P i 2 5] 2

4. Chain Curves CHEREMIZR)

ZIETUH TR PRI 2 E N 51 2L, DA DR & I8 B0 Rk B ML RN 2N 5] S 2t
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3.3.6 7l

7F T B B prpAs b B FESEBLAT 2 Insert»Form Feature»Hole, R & 3.43 A
TN AL 1 X A AE

{~ Counterbore
" Countersink

[~ Thru Hale

0K Bacl | Ca.m:ell

K 3.43 FLRALE BT EHE

UG RGP LRI EALFE Simple (fA#fL) . Counterbore (JT3kfL) #1 Countersink (HEFEUT
O, [FN &SRR FLA AT % BN Thru Hole CGEFL) o 7ESEAR ERIEFLIN—BOP B N: HeEfL
XPIENE R 2 FLAUSR AL, SR e STk i sl S e P 1 A N FL E -~ i AE fLF i, R E LR
ZH, ETESAESE B E . FUBCE R IR LG s @ LT A R LA 2 b i
B RIEFLEBIGHEFIE SR T Thru Hole IEIUAH 8. I HIVELIN 20— T A & PR B FL I A8
o

1. Simple (fEjH.fL)

FEFLERRINSIERE L FF Simple S8R5, 2R I SR T 1 (o IS IEHE . ] /5 2k
PSRRI BV TR VBB T, P SEAE O TR AHE G PECE T RS, F AR E R
KRB G ] HRAE B TR X R F AP R o X GUE PR A5 IR 2 AR
i

® Solid Face (SZRZERH)
EPEZIET, T EFESR . BRI E N FLRCE 1, R S s LI A BT m) &
PZ SRS TH Y2 I B L S ), i )i SRR R P 6

® Datum Plane (& F-[H)

EEZIRTL, Tk NP IR LB P, 2 B AR X A i R sk
ik, RRRGBHFHILAESTTIR, [FRSEH0E 3.44 s FERFLAROT RS HE . 1E4F
Accept Default Side 117 EE Flip Default Side X617, o2 u i R4t A B FLA T 1) .
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Flip Defaulk Side

0K | Baclk | Ca.m:ell

K 3.44 JEFEFLAE BT )R AE

AAEALRA L FEXTAHEFFTIT T Thru Hole $ 150,  JUAELE £ f] PR FLIRCE Pl e, I8 205 e %
I SLP T R RO IEHE, AR e —ANESLP . SR, QU S AL o E i AL T T A 2
1o F34h, Sk EAET IRy FLARECE T 1 BOE FLT T, U DR AL AL AR BT T B A FLRE S
RES AR FE A o

WEIFH RN E PG, 2 3.45 B Bl SEOMEHE. HP 75 7 Diameter
(Hf) . Depth (GAEE) 5 Tip Angle (Tiiff) SHUUAKNE, TEXK CAMEFMANMNSE )G, &9
HOEAL T XEHE (E2E 3.6 /N1 o SIS Tk, Fk$E B Ao e Bt m, SR e
H A HE A AL B RS BE LIRSS, RGUEAT LAFE LAk EOIE TR & S 8 i 5 fL .

Simple Hole
Diameter I 1
Depth |2
Tip Angle IEI|
0K Baclk | Cancel |

3.45 AL E T IHHE

TEHINZ ), Tip Angle FHE LUK T2 0 H/NT 180, HEFLRALEFEIIGHEF, EHFT
Thru Hole J& 5, U & PR L EOFIEHE Pt 2% Depth 5 Tip Angle iET. P 3.46 Frs il 21X F
77 A E

|

BRETT:

|
|
|
—
P

]
MER — b e

[
|
I
—_—1

¥
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2. Counterbore (J(kFL)

& 3.46 Simple /73

TEFLR BT TEHE L £ Counter bore 2R 5, it K IR BEDTL AL E FIRIHEHE, 1B ik
PR R B I E A CE P . G SRAE LR ALEFEXEHEH, 1E#E T Thru Hole 1T, ik
SEOR A P ERESLP I EHE (RREER B RIL) o R E TG, S E 3.47 Bism)
VELILSEOFIEHE, Hd 15 T C-Bore Diameter (JT=kfLE /) . C-Bore Depth (i =kFLFLIF
F£) . Hole Diameter (fLE4%) . Hole Depth (FLIREE) Fl Tip Angle (T0if1) SHCCARKNE, E& X
AHEFEANMN S SR H e 7 ASEE R B LA E S, Bin sk s e B S

HadiioL.

Counterbore Hole

Z-Bore Diameker W
_-Bore Depth IF
Hole Diameter IF

Hole Depth I 1
Tip Angle IEI
0K Bacl | Cancel |

3.47 PULILSEEHE

e NS4, C-Bore Diameter 44l KT Hole Diameter, C-Bore Depth 4 4i/N T Hole Depth,
Tip Angle 41K T45F 0 /T 180. i H, HIEFLRBERXTENEF, EFE T Thru Hole ETT, NIC
SLILBBOFIENEF, £7%7 Hole Depth 5 Tip Angle 1T, & 3.48 AT/~ st 2 X R 7 2 B 1

kLR

| 1 [-msdee
—

l

T T
N ~ | 1

1|__

I[N

LB —

] 3.48 Counterbore J7 =
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3. Countersink (HEFEZUTFL)

TEFLRBIXTTEHE I FE Countersink ZRAY 5, 3 HY IR BRHE T DUALIBCE P T X A, 1k P ik
FE SRR [ B AE T AR A Pl . i SRAE SR AR BT UHE S, &4 T Thru Hole &I, ik
SEORA P ERE LIS HE (RAREER AR » EBWEFHGE, St 3.49 Fisi
HETEITFL S EOMHERE, HrP A4 7 C-Sink Diameter (HEJEFLE4E) . C-Sink Depth (HETEFLFLIA
F£) . Hole Diameter (fLE.f2) . Hole Depth (FLVA/E) H1 Tip Angle (Tiiffi) SHCCAKNE, 1E% L
AHEFAANZE . fJE P HEA T O E R B LA B G, BT E SRR e BN 2
o AL

Countersink Hole

Z-5ink Diameter W
Z-5ink Angle IEE—
Hole Diameter IF

Hole Depth I 1
Tip Angle IEI
0K Back | Cancel |

K 3.49 HETLUTALSHOEHE

NS HU, C-Sink Diameter H{E 441K T Hole Diameter, C-Sink Angle 25 kT 0 /N
180, Tip Angle 2K T45F 0 /T 180, A 7EFLRALIE B X TEHEFIESE T Thru Hole JET, NIT7EZ
HEFEUTFL S BOHERE S, V&7 Hole Depth 5 Tip Angle i3, &l 3.50 flf 7 it A& X A7 2 1 B 1]

#IT.
Ry [ A ER
l \'.‘_ 4 X'«_ o
URE T
L e e a
T
B —

3.50 Countersink 77z,
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3.3.6 EEOE
7E T2 Ebsts g LR A4 Insert>Form Feature»Boss, # 4t 25 H X Gk BN

TEAE, 1EFH IR & W CE P . 325 600 A7 S F LI 2 16 0 B ~F 1 AR (R 48, e sk sk

T B IV~ TR N R ™ & R CE P . SRR G E A, i 3.51 Fsffha S5

XA HE o

Diameker I 1|
Height I 1
Taper angle IEI

Baclk | Ca.ncell

0K

3.51 MESHGTEHE

ZATEHER A5 T Diameter (HA4%2) . Height (7 3) Hl Taper Angle GGREEAI ) SHOCA
MEo TES CAMEFFINFANSEL, HHAH e 7 AXEE, el e B2E, RSk
RN B MAS B REREIE NG . K 3.52 Bt ix fhor 6 B .

BR . .
|

aE
_1'
z
" TiEfEsm
A
X
Tk

Ehs

3.52 BIEEIREE N &
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3.3.7 BpE

7F T B B prpAs b IR PR B4 Insert»Form Feature»Pocket, Z <> H & 3.53
FIT 7 B 20 s R 3 36 0 ATE

Rectangular |

General |

(1] | Bacl | Ca.m:ell

] 3.53 HY R B BE N EAE

e 2R R4S Cylindrical (BEFEZRLED . Rectangular CEIEHLE) Al General (—AE) =
FKo EHFTARMMBERMR ST ARMNSEORE, FHFEANH— X =R,

1. Cylindrical (AR

TE R s RA XS UEAE FH L FE Cylindrical 28, &5 X GOEBUSUEAE, 1EF Pk B8 s il B 1~

T o 4225 G 222 T B L AN R 6 TS T RO R 450, 3 SRR T w3 4~ 1 e P2 2R s ) T LY
. EPHCE PG, P 3.54 FrRnkt e AL 2 5O HE.

Cylindrical Pockek

Packet Diameter I 1

Depth 0. 5|
Flaor Radius IEI
Taper Angle IEI

0K Baclk | Cancel |

K 3.54 FETE R iE S HO0HEHE
XTTEHER AL T 4 MR ERSE, EfIRHEWT.
1. Pocket Diameter (HYfEE %)

ZOCAHE ] T i BAL R R 1 EAR
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2. Depth (VR

ZOCAHER TR BT A IR L o &2 A~ T VAT T 2 s A e 7 e AT D& )
3. Floor Radius C(JECTH F5I42)

ZOCANE ] T B A R R I A B4R . B UK T-48°T 0, H/h T Depth fH.
4. Taper Angle CIRAEA D)

ZOCAHER TR BT A R . B AR T45T 0,

FE& SCANEF AN NS ER, IR E AT AHEHE, e HE R R AL E . R GEr] (L SEk
FIREMERMAS OB . R S HOHEES 2 B W A 3.55 Fos.

e OCO (:)

EERE
g
A N e E

3.55 FEFEAY

FEAE AT IR, G R P e S v~ T AR A A T A P, D SR P T 0 U 2 S
AL

2. Rectangular (FEERYE)

FE R SERURF AR AE 7 1 % Rectangular JEAYJ5, 2058 H X GURIOREHE, 1k P e Rl ) Tl L
SPTT o A% -5 G e fa] SR FLIN B O T T RO [R5, 0B 39 S A3 i i - T R D RE TR s T
V. ERTREM G, XS SRR BOSTEHE, LA PIEBKFSER R, X AT SR
A T B RSER RANTEALE FK 225 T 1. fRE S5 7 A, #RH W 3.56 B e
T s Z RO AE
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Rectangular Pocket

» Length |1|—
¥ Length Il—
Z Length Il—
Cotner Radius IEI—
Floor Radius IEI—
Taper Angle IEI—
)4 Bacl | Cancel |

K 3.56 FH IR S HO TEHE
ZAERET RS T 6 MBS, ENMAZEDT.
1. XLlength (X [ )
SCARE T 1 B AT R 1K
2. Ylength (Y KD
ZOCAMER T BT A s 1 6 S
3. Zlength (Z &)
ZOCAHER TR BT A R .
4. Comer Radius (#3ff12F:1%)
P SCAKE -1 B AR R VR P 7 1) B AL i85 f A%, HHE AT T4 T 0.
5. Floor Radius CJiCTHI B 5I-42)

OCARHE ] T B R A s ST A A [ AR, HE WK T5%T 0, H/NT-5T Corner
Radius {H -

6. Taper Angle (FRAEAFE)
ZOCAHE T B B B R A B, HAE DL AUR T-45T 0,

FEA AN AN S EYG, FIREN T SHEE, e RN E . MRSk L
BEN B AS BT ZAE A . R ESAGHEES S BB A 3.57 s,
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K 3.57 F A

3. General (—f&AYfE)

TR P R XSUEHE £ FF General 2878, &9 tHU&] 3.58 Fros A — M B s X UEHE o 12560 1%
ME LEBIED, H Tt — A g Rob g, HENnT R E/RIX, H T8 SAHR D IR
H7 R NECONASGETIX, HFRECIE - BIHEENSE. FHEN A N5 s HE %k
I
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General Pocket

—Selection Steps

G
iy il
& <

Filker IFaces = I

Zutline Alignment Method

I.ﬁ.lign Ends j
Placement Radius IT
Floor Radius IT
Corner Radius IT

[v &ttach Pockek

[~ Confirrn Upan Apply

QK Apply | Cancel

3.58 — Bl Xt AE

® Selection Steps CGIEFEL )
K] 3.58 XTI HE LA FOD BRET, AT lg — A s — b iR, Hp I 10 PR
B, e A& KRR, R R LR i R el e I A 30

FERIERA BRI — R, FR A BRI AR, KBGO, HEM B
MEbR. RIS, XEEEFRIFA—E EHZ AT 2S5 RIF e, WS BiksE. THhdE— T &K
U PEERF S
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1) ¥ Placement Face (HUETH)

2B b Tk P R T L T o RO T W] L T SR AR T — AR, PE CRRCE I &
AT TR o PR TSCE T 58— MR D BR, P DASE SOBCEL I I A 25075 8 3 At 20 B i
AL Pt i 3 TR T B e A AR TR EL T b, BT AR IR RSB N, 2255 18 1T T e B0 2k
IR T Al SEFEIZEIbR G, I Filter SR, WIefe— e NRIE . —DEAET i 80P 1y
— R TR T

FEBRAERS, AN FE—ANIEE R . 22 mEUE N, &A1 R e SR s &
R, MHALAREL . ATRE HARSCARRT, 8B T P 35— R A R i R R S, RE AR
SE TR — RS I S AR B A, HAR e e AT MR e AR et R e B RO P A — A ik
PR 9 [ 8 S HEP TN, 253 E € H AR SR
—

2) @ Placement Outline (¥ & [H#CE1%)

b T SORCE HFEFRER, B0 P ORAIA — AR A s A UL T L T e JER 2 (1 h 2k 5. mT LA
MR o 56 i 2 B2 R S SRR T JE 2 s 13 P Y 2 88 Je i 2 J6 2 1) 7 3 ST BB T 2 JER 2

FdrizEbs, WK 3.58 A yan &l 3.59 PR ik it. Hh &I FEw N .

Fram Floor Sutline

Taper Angle IIE. 1]
ICDnstant VI

IFau:e Mormals j

Relative bo:

] 3.59 Placement Outline X i HEi% 17
(1) Taper Angle (3RFRFAFED

12 SCASHE VR B PRORR RS THI 50 3R 2R 45 21 i B 1H %0 BR 2R B R 3RO A 5 . Taper Angle {H LK T-25T
0° , H/MNFET 90° , FOAUUHLR A LAFRAR . 1ZSCAKE AR P 08 R AEF, ik
Constant % T 7 30

(2) PAsifzii] Iy 3k
Taper Angle SCASHE T [ 4 51| 2 HE Y 42 ] S0 25 v e 0 2 AN JE T 4 R e o i ) 3 ey
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7 Constant (%% . Law Controlled CHLNI$EH) F1 By Outline (3Z%CBEZE) 3 kT,

<> Constant
VI WA ] 5 A P B AT IRSE, R4 —[A] e A LR I AR BR 2645 2 E e R 2k . bRy,
AJ7E Taper Angle SCACHE HR iy N AR A 1) # B o

<> Law Controlled

AT AR 8 ISR TR 46 R A4S BB R0 AL . B FZIE TN, #5356 A E X Law
Controlled, JUSHIU1E] 3.60 Fros 78 SO R Z X TEAE . AR ZEORGEFEH P Rk T, 78 X Eidm i
i S AR R AT MR OR AT DA o A P Rt 1 5 Rk 07 X (ATRAZIE 4.3.3 /)
D, RS ANE T

Law Controlled

Conskank

Walues Along Spine-Linear

Yalues Along Spine-Cubic

Bw Equation

By Law Curve

(1]4 Baclk | Ca.ncell

K 3.60 & SCHUEE Bl 28 6 TE HE
a) Constant (/%0

LT T8 R A SR . R FZIETUE, K2 anlE 3.61 ProsfxiliE, mrfext
TEHE A 1] Law Value SCAHE i N HUELE SRS

Law Controlled
Laws Walue |1|

0K Baclk | Ca.m:ell

3.61 Constant %I %} iHHE
b) Values Along Spine-Linear (WA 4L)

PRI T8 SO B R AR L . Bzt UG, B el Ehkil—2% 02, JEH
ERL BT RIERAE, RREFE K, RGO 3.61 Proriximie, 1A~ f AHEL
16, DA A R AR R A L
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¢) Values Along Spine-Cubic (¥ &2k =1x281k)

ZIRTUH T8 SO E R =AM R B . eIk TR, B e 2ki— 2602k, JFH
FERL LA LA E, fRERFE—K, REHIIE 3.61 Fros O imiE, ik A
B, VIPPAIRE L = ORI B A

d) By Equation (J7FEF%Hl)

T T LA R ROk e R A . AR BRI TUAT, A BRI H SRS a4
Tools»Expression, 1 & Fik 3\ AL & S AR 2 AR A0 I 428 1) A AL BR B S BT R Bk ik 20, X A mT LA
A5 P Z 35 Tk 7= A2 B SR OB A B

e) By Law Curve CEITHINIHHZE)
A TR AR F it 26 K 5 SCIRABE AR B, 3 I A% A7 B o e BRI ) o 2 B s SR 2077 A

76 3.59 XFURHEH % $E Law Controlled B, 1R F 0 4 & UL, Rt aH i
3.62 FIToa 1) g B KA X TR ATE o

Law Controlled

Change Law Type i

Change Law Parameter |

Change Tolerance |

[IE: Bacl | Ca.m:ell

3.62 YN IEHE

AT TEAE R PR T =R 2w 7 20:  Change Law Type (HUZBRAEZEAY) | Change Law
Parameter (Z{ZFHNHZ%0) 1 Change Tolerance (B AZE) . WRIET EEFIL A AIET, TR
ER S EHEI T,

<> By Outline

T T JEC TR #8 R A BEAT R, BV 8 SRS T #0584 Hh A 2 il 4R O PR R R A 2118 B T
B2k, 1 H e R AERIRRELE G, AmiEANR IR, BFEZEmE, 2k 3.63 s
7E G R AR AR X TR AE

127 /454



Law Controlled

Conskank

Limear

Cubic

YWalues Along Spine-Linear

Yalues Along Spine-Cubic

B Equation

By Law Curve

(1] Bacle Cancel

3.63 JE AL R A A A T AR

S TEHE 5 [&] 4.96 P HEAR ), W] DAS [ G el KLU0 i 28 180 2 75 3R A P L v 0 25 ik

(3) Relative to (FRAEJ7H))

AR T T 2 R 7 e . LS T 7 NI Face Normals (THIVETR]) . Specified Vector
(JERERE) - Specify New Vector (FREBIRE) « +XCAxis (IE X HH77 M) « +YCAxis (IE Y fi75
1)) . +ZC Axis (1IE Z #i7\]) F Selected Datum Axis (FTikFEvER) .

<> Face Normals

23 TP 15 LU T A B0 2 T 10K [ 3T T o

< Specified Vector

2T TAE U Specify New Vector #3545 € HIHRAR 5 1], F-4i 7€ o3 — R &7 1A/ E NIRRTy
). WEFEZIEI, - g, WIHAHN KR ETT R 1A R TEM Specify New
Vector #J, $i5 €1 — 5 A E IR T )5, AIE T4 I

<> Specify New Vector. .
ZIE U T48 € — 8 5 A E MRS T . BT, 2 R EAIEEHE, 1w L —
[V E R TT I7)

<> +XC Axis
VZIE T T8 € +XC il 5 A E N 7 ]

<> +YC Axis
2L T8 €+ YC il 5 A E N 7 ]
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<> +ZC Axis
ZIE T 48 2+ ZC B 5 R R T 1)

<> Selected Datum Axis
ZIE T T8 A AE AR AP T A IEBZIETN, AR AR EAERVE AP T 1A, R,
1E Filter I H 3R H DA 2% HY Datum Axis % All JET

TR EEERET, 47 EARYE Relative to IETUEFNT RIS, B LMEH Filter iR 13 B X
BRI, 47E Relative to FASZFEE Selected Datum Axis iE TR, WRAELE TI/EX FkiE T H—
JEHERN, T Relative to #ETIUEF H 274 N Selected Datum Axis.

(4) REERLLi=

AU Filter 3ET0, AMERT LA R it B R CE A BELIUSRA, I8 W] LI B Relative to &I H
RS SR . FE R R BV B IR B . — LGB — 4% M AR B A D i B T e
2k, MZIZR DI, JFfe SRR R i =, R R SRR ET Sk, BRI FF T . [
I, R RETT A EE 2 E BB . TH., B 3.59 2NN 3.64 KITES, XML
SRIEAT R A Rk (1724

IThenreticaI - I
Reverse |

Kl 3.64 TR T8 R 242 1l 8

HAp N R8I R P A& PN E T Tangent (FHYI)) A Theoretical (FIS) , - T-HHI W SCE H
e ER A el iE B s T 5e BR 2 1) J77< . Tangent J7 20 148 & & 10 5 18 /A 1Y) 26 4 T [ 56 B8
25 Theoretical J5 =X T4 e JCE 50 T I ERAS S A T AC BR 4K . 177 Reverse $2%H FH T 4% i
B ER LR H X 55 7 s

TEEAET, THE MRS aE M, 1 HE R, RISEER 253552 J7 n #5245 € 1T
i, 2, AREERC. TR ENFCEIZL )5, Placement Outline Projection Vector FFr4: H 2
o

=0
3) Floor Face (JEHI)

bR e - BRI . Bz By, TP 3.58 R ERAS NI 3.65 Fs ik sl, Jf
FEL B TARIX R SRk ko A8 AR 5 SR, U7 Sk 27 MIUE T i 2 B0 #4521 T 14
BRITIE) ;s RISk s A\ L R T i £ B A5 1) S s JER T FR) 48 SR T
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Floor Face

IOFFseI: vI
From Placement |1. 1]
of Selected|Floor IEI. 1]

3.65 Floor Face X 15 HE LT

SE RN, BER] R FRRE, B nl w2 sl s B IS 2R E, 38 nT DU B Lk
A3 EISEPRE M . ERERERIAT, Il — s MR, — MR i — . N4
— R U AR T

(1) Floor Face (JEIHE X 770

ZIETH X BRI E X T B8 Offset (fff%) 5 Translation (F4) 2 ik, W
XATET: Offset [J7 Ml 2 RS A7 A, T Translation )75 [ A] LLEE B E 3.

<~ Offset
1208 TE T R R T B O i T A B SE PR T . IR PEIZ LTS, From Placement BY, Of
Selected Floor 114> H B -

<> Translation
12368 TR o A ot 3 T B L S THI 7S B SE B T » R PR 1ZIE TS, Floor Face Translation Vector
KbRKs B 3hiad, v L B e SR T 1) .

(2) From Placement (M JIUE )

LT T B E R R RAS AR, P e T8O T A% 5 T R P 45 i B B A5 2R T - %3 T A A
E B LRSI THI N 0

(3) Of Selected Floor (M ik )i TH)

IR T L BT A WAL AR o S P Ok JER TR S D2 7 T i R 41 5 B R 45 B SE BRI T o 3B T
A7 IR PRI A A B -

FERRAE AR, USRI T 2 A ORI, 24 R e A SEAR BT AR, 1 HA A AR AR -

4) @Floor Outline (R EIZR)
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bR T S BRI IR IR BR A, AT AN AR rp s 5 it 2 sl e ST SE Bk, thn] il
AR E IR B2 AT E o iz bR, A AT E LRI ERL, A 3.58 Az vt
3.66 TRV, Ui BT 4L FR 26 BE ] ELEAE AR A e 0 kAT 3 3, thon] S8 il e i T L T e B
ZeAE L. B, & 3.58 R AR s XK 1A 3.64 .

From Placerment Cutline
Taper Angle IW
ICDnstant vI
Relative to:
IFau:e Mormals j

3.66 Floor Outline F % HE % T

1 3.66 FT /%o TEATE A 38 IO B A4 Y2 5 6 3.59 BT i 1l AE PR e B SR ABL, R AT a3 B 43 11
U, T 0 24 15 TR T P JE0 e A L R e Ry, BT TR L v B A s B T, 8 B TR 10 T R e PR
il R R S )RR T R 2

PR R IR B L2 B P Hh e, 0 H AT DAERs, BIAAR B 244 52 77 m 52 2 48 € 1 T
W, ZUE ], ANREEZL. ERRIMEEZE)E, M Floor Outline Protection Vector ElAR¥E H 8IS -
TEER N E A B4 SR B S5, PIFCRIZ L InRe 0 a — M A s RN T o S 4k, iE TG
RS IR e BRZE vl F 2 Fhor = e PR HE B4 mT DL B4 A P TAE X R BExd Gk e L, B
— kBRI A FLHE M B AR X e 30 G X, 1 o —HE SR 4 O ST I8 30 B 33047 i % B4

4 Target Body ( HFRZ44)

G I T R BRSSP A E BT AR S Lo 4 FBR SEAR 2 55— AN B T T
TR SEAREI IR, e AT OB — IR 1 B AR . MW B TN, SRR 2
— AN AL, WU E B ARSeh. AR, FERR i B T T — A S B P
.

6) 2 | placement Outline Protection Vector (i i J5F 4% 5% 17 1)

2B b T 1 e OB R R LR B Ty 1A 2 0L T e B 2 A AR T T I, NG S e B £
BB T % AT R T MR B e Bk Ja A Had . iz &br, NI 3.58
TR T AR R DORH N 3.67 Fran . ATAE T R sUHIRME b BB 5 ) 58 O3, AR FR e L
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ST o

Specified Veckar j

Marmal ko Plane of Curves
Specified Mectar

Specify Mew Veckar, .,
+aiC Axis

+YiC Axis

+EC Axis

Selected Dakurn Axis

3.67 Placement Outline Protection Vector X HE 2 1

U SIEFE T 1% R HEF ) Normal to Plane of Curves &1, I E [ EF L& L3t . Hah, 78
R M Ja, AU PR R [ FE BRI 25 U7 Al BRI, RIS B T e BR AR i 355 5 )
Fe B Te g I CE R, A HABEE A,

o=
7) :i Floor Outline Protection Vector (JEIH%C 52k 55 77 19])

ZEbR TR RIS B I BER T 7). 2R T A BR LR ANE R THT I, AR e 8 6 4 ) JER T 45
SEINJT A % EbR R IR R A FR R J5 A WoE . iz Elbs, I 3.58 A iyl A48 (B 7w XK ]
3.67 o AIAE NI ARAE ARk $EFE T R A2 53, SRR R ARG TT 1Al

=i

8) 271 1 Floor Face Translation Vector (JEIH #4477 1A])

Z B T 48 R H B T A 2 B T B Ok BRI T 15 2 SEPR R T, MR e i
771 o 1Z PR S A SURTHNN — AN TN 4 30%,  BP 24 Floor Face IEIUXT 1 AE A1) Floor Face
YET5 K Translation B4 3505 .

iz by, WK 3.58 tPERET AT AR SR DOR AT 3.67 B . TR T a8 3 AE ik #4517
A HRE 7%, ARJA E BT A . U, N ORISR ER R i Ja, AT HOY B e 8 21 1 i
k.

9) @ Placement Alignment Points (Jifl B [l %8 BE 2k %) 5% £

ZE A T8 € B R BRZL X 55 R, 2 5 )R FE BR 4 EAH RO 55 5% . ZEbs RATE
JISCEEL THT 2 JBR 2 A EC THI 8 JBR 2R A A e B it 28, HLAE P 3.58 XJ1EHE R /511 Outline Alignment
Method &I 1% $E Specify Points 1% T 741505
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HAREFN T 7k R BT TEHE AR ik 3% i, BAE Filter Rk s 05 U5
FRERER ER R, WA B B 512 eI I R R E R T . 55 Ra, R bt
FERRICZ R, JFAN L ITAR,  $53CE e B RS T 7 [ 5 b P 5

JECE, T F8 Rk W B RO 57 8O H B R T e R 2k v B O TR A B H A R, T LA AR e B A
FAREAR 5 [ RN TR A, RS S A — BRI .

10) @ Floor Alignment Points (Ji& [l 48 R 28 %) 5% 51D

Z B bR T8 K T 5E B 0 55 i, 2 S5 00CE T 6 BR 4% b AH RN 55 s 5% . b RAEE
[HI 58 3R 26 ARG THI B8 JBR 4 #1022 B ptu By h 2k, HAE ] 3.58 XJUEME T J51#) Outline Align Method T
HHiEFE Specify Points LR A g . BAKEAE 7745 Placement Alignment Points FEIFRAH A

7EE 3.58 XHUEHEH, PR VPP IRERRSN, A —eds e ishl 7 AR ESHNED, IX ik
Wik, H7 Outline Alignment Method 117 75 2 7E F 265 PR bR N A 300 -

® Outline Alignment Method (8 EF 2%t 5% 75 20)

IR T T8 R TR R B 2 AN T R BRZR X 5507 3K, HAA 7R3 E I #E BR 4R 5 ik T 48 )3 42 21
JE B R M 2R IS A4 IS . R TS Align Ends (i EU6ES5%) o Specify Points (F5 & BXT5%) o
Parametric (Z5Z%%5%) + Arclength (ZFilKXI5%) . Placement Spine (JiU'E [HIAZX55) Al
Floor Spine (JECIHIAZEXIFF) 6 NI,

1) Align Ends

T IE TR RE 1 25 F8 B A T o )0 5o B R A FE P RG BR R B B )i s 0 AR (R I AR AR ot
(N PEPS Badihf ey Yo AN s o N N T A R S S e S E RS- BN IR

2) Specify Points

12308 T FH P %6 3R 2R e BRI G B f % 55 . 18 1Z T, 1| Placement Alignment Points A1 Floor
Alignment Points BIAR T, 1T 48 8 P8 2550 BR 2R X 55 1o

3) Parametric
TR € W BR 2k S 0T X 55
4) Arc Length

IR T MR R 2k P AU BEAT X 55
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5) Placement Spine

AT E P8 JER 4 TBUEL T AR Atk AT % 5%
6) Floor Spine

AT E PG JER A RS TR 8 R 34T % 5

® Placement Radius (CE M4%)
VI T8 e — M 2R i 1 T I - 0 o e 4T 15 AR 24 . AT AR TR O I i B SR A T
2 ) BRI 4 i) e e e AR PR L T PR, B K T4 T 0,

® Floor Radius (JETHEARD)
I T 48 — M Y 1 S T -5 0 o ] (4 1 A A R RT LUK R 7 8 B8 FAE I T
B0 | BRI 2 o o v s 2 s TR 4R, HE WL AR T4 T 0.

® Corner Radius ($5/F42)
IR T 48 e — M I s 3 i) 45 A AR

® Attach Pocket (fft&—MAYfiE)

WRRIZARIN, #5 HAR SR Ak, MBI — RN R, 5 AR Rge G R —1k; 25 HbRse
ARSAR, TGV — MR oS, SR 2 — R . SRPZ IR I, TG Y — M T s o —
NPT S2AK o

o I RAIEIIAI T Tk

— R, TARE R, kR 10 NP IRER ISR bR, IR AR T B A R
%, HEEMNEERSE, REREFHEERINTFHSEET . —8okil, EFBER. & X
B A ERZR . USRI E SUR TS B LR 2 AT 4 AN B TR, — B s BRI 818 5 IR A )
wr (BrEfa—4, HRBRPTHAEE .

1) EFFNEI (Placement Face) o WlIEHF—PEEZ R, B MAETH. 80— mE
JECE -

2) ESULEMFEERL (Placement Outline) o T EL#E MR ife e i 2R B e 3, thmT I
BR SR E Lo

3) € BB A FR A AE L PRV RCE I L, U NLdE e Tl EL T FE BR LS Ui 17 (Placement

Outline Projection Vector) -

4) 5ES(JEIH (Floor Face) o BEWPAE— el MR, s MEHET I B HE AR
T st AT DA 3 i % B RSB T SR s G PT DASE e PR T, PO A2 B e O 3 1 e i .
KRR -
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5) E XKLL (Floor Outline) o W] HE MARAY L £ ith 2 s 455 3, AR Tl i 44 4 i
B IR E L.

6) AIRIMFEERL AL E LR b, N e RN ER %5 /7 M (Floor Outline Projection
Vector) -

70 A5 JO T O A R S L T R E S, B e e 5 1 JER T R S SLIRD DM i G T T e ik

7718l (Floor Face Translation Vector) .

8) A TS IHI 0 R 246 AR THI 68 B8 2 08 A >R FH e 436 b 2 B0 5 SCHG, T I 415 7 8 B 2 o) 5% 77 20
(Outline Alignment Method) .

9) HR RN K TR 2 M 5F (Specify Points) , N 45 5 B TR 6 )51 26 %7 55 /4.
(Placement Alignment Points) FIJE I EEZ %) 75 & (Floor Alignment Points) . BEHT, PIERERZE L
(PRI 55 U8 H 20 [

10) R¥E T EIR € — N HAFRSZEK (Target Body)

11) WRIBFE G E MR E I (Placement Radius) JiETH (Floor Radius) Al (Corner
Radius) AbH[R F - 121H .

12) EFRER PG — BB (Attach Pocket) 1270

13) R4 IR PR B A AT RN (Confirm Upon Apply) %37

14) Hiifi OK B Apply Bl — A .

— R ST AR MR TR RS AR L, AETRARANRE ) 5 Th SN 2% . EEEERIAE LR LA

DR v &iLYicyiingss & NI ICTR > Srive e 1 T T PR Ve 8 = 0P S R AP b i el Vb S TR (B G T
2) A AT BLE ST, Rk il i (R T, i e R AN RE S SR .

3) MR O T T (IR AT e R i 2 CE i 2] DAL SRR D SRoE
SCo - HLE i 2 RT DUASAE G 5% (1 0 T B i

4) — MR T AR R TR T B T - EL 0 T ) [ A
5 MR A 00 TE A TR T - e T VR e ot 2 1) ) AN D 2
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3.3.8 FEMAA

Pae SNy e el A B PESE A4 Insert»Form Feature»Pad, R4 K] 3.68 i
NI T & RS HE

: Rectangular |
General |
0K Bacl | Cancel |

K 3.68 I & RA N HE

T & R AR e M — BTN G RRERO G R, MEFEERNE
i Em)E, FRERBLENSE, TeEHEIER NG WREE BTN ERE, N
25 8 — R AR TER QI — BTN G . NN H— XM & .

1. Rectangular (GEIEIME)
TETT N & RSB HE IR FE Rectangular 2R 5, S 9 X GUAIUIEHE, 1A P& BER N
B BCE I . 425 00 8 18] B FL A e 328 0 B P TR B AH R4, e P SR 3R T B2 v~ T S T ™,

SHCE . EERERG, FERKFSENR, KN TR EESR R . ek (v
MG ATFSHET . RESH TR, RGHLAIE 3.69 Bk G S U0 IEHE.

Length |1|—
‘width [
Height [
Corner Radius IEI—
Taper Angle IEI—
0E Bacl | Cancel |

K 3.69 TN & S HHEE

ZAEHEF LS T Length (KB . Width (FE/E) . Height (%) . Corner Radius (3}
%) Fl Tapered Angle (KAL) SHCCANE, ESCAERMAMNSEG, FIH &M 7 605
e, TR NMamMERS, WrigfheSHOl@BE NG . K 3.70 Froaafst X # o 2 el

136 /454



mRTE

FFAEETER

3.70 SN E
2. — MG
TET TN &6 BB UHEH IEFE General 284, S5 WK 3.71 Fron i — T TN S X UEHE . 1%
XPENE_EER R EIbR, FTHEeald— R e gl g AR RRX, T8 E &AM
WIRM G XA RS EORE; FEOv@EHEmIX, AT REE &N S S5
KiFE . ZAEHE & BRI S I S CA SR S — M B s 0 R A R L. (HELE R —
M7 T £ HR RO T ORI, PRI — MR T £ R T T 5 — e 28 s R e TR (I 2 AL
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General Pad

—Selection Steps

SIS
¢S
=

Filker IFaces = I

Zutline Alignment Method

I.ﬁ.lign Ends j
Placement Radius Im—
Top Radius IT
Corner Radius IT

v Attach Pad

[~ Confirm Upon Apply

1]:4 Apply | Cancel |

K 3.71 — BB G XHEHE

3.3.9 e

78 T B B prAs b BRI AT S Insert»Form Feature»Slot, %<3 &l 3.72 A
T RS R AR G T A
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i~ EBall-End
 1J-5lat
" T-Slat
i~ Dove-Tai

[~ Thru Slak

0K Bacl | Ca.m:ell

K 3.72 HEAEE TSI HE

TR K25 G145 Rectangular (JETEFE) | Ball-End (BRJEAE) , U-Slot (U AYfE) , T-Slot (T %Y
1) 1 Dove-Tail (GEREFE) Ffp, [FIBSSAPSEAYFEEI AT % BN Thru Slot GEFE) 7720,

FESEAR LAV — BOD BON: B RE SRR, PR SEAR T T AR AE T T 1 Dy A
BT AEME T, R, R BRI S8, RIEERFEEN T, e e
ek ERIALE

FEQIEE %R, A E e B OB P AR A BE T 1A . AAE 1] 3.72 X AE e £ G
FERHEIT, H BN GOEFENAEHE, LR SRR T, Tk S AR T B v T D T
. fREME S, SGER PRSI EN S, TR EM R, B R s
(LSVINTTEE- G2 LSS e D L PN IR N ST

AER 3.72 XPIEHER, LEFF T Thru Slot JEI, WIAETR €K Z2H TG, SRR R IR
TEHE, R IR PO S AG T 1 . 25 B fa] B PLIN PR IE AL A R A, el ke s -1
T, FZFEIRE e BE A2 P . & 3.73 Fros i 2 0 2 18 R 1) — AN a7 S i

TEHAT OB R R E T, PR A T 2P R R 5 AP B0 /AT, T HL,
DS P TAAS . G R 7 0 B 1 P T 5 A T, IR 7E SE S B A it
£ Length (KJE) Z¥. 4k HEAE T I (B OO P I SO M T IR, T 4 A 7 )
SRR S5 SR B

T HEBAID BN AT - 3.72 R TR R AR
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a=Ti]

K EEETIR —

BIER &

3.73 QIZIEFE
1. Rectangular (JEJEAE)

AN IEHE P ILEE T Rectangular 87, W RTAESCAA EQUEAEIEAE . 7R 78 & - i AN
RERTFZHET A BIKETTRD J&, = 3.74 Frs S S HOT T E.

Rectangular Slot

Width IEI .B
Depth IEI .0
Length I 1

0K Baclk | Ca.m:ell

3.74 JEIAEZ B AEHE
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R

3.75 Rectangular 7=

ATTEAER AL T Width (58D . Depth (JREE) il Length (KJE) = ANSHCUAMNE, 7EK L
AAEFENMNSE G, R EM 7 NEHE, fe i a g, MRS n e seik EEd s e S5
PHEAE . B 3.75 B e 1X F 07 X B4

2. Ball-End (ERJEFE)

FEBEAE ST X T AE 38 3 Ball-End SR, WU RTESEAR b QI BRI . 7R3 00 E 1 i AN E 7K
T (HIKETTRD Ja, 2l 5K 3.74 AR ERIERE ZHOEHE, PSS — NS H0CK
HEIXFAZ04 T Ball Diameter (BREAR) o ESGCAMEF AN SR, HH e A7 S TEHE, i
SERRIMAEAL E, W ARG ATESAA LA TR E S B ERRME . 18 3.76 Pras s X f 7 L1 6.

<
HE®T
A.U‘::{f N
A

i 3.76 Ball-End =

3. U-Slot (U Zlf#E)
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FE BB S AN IR HE Fh ik 8 U-Slot Z8AY, IR ESLAR B Al u B, 7EiR B E 1 i A4 € K-
Z%J7m (RKETRD J&5, B 5E 3.74 MR U B SEERE, HP 2 722800k
HE Corner Radius (45 ff° 4% o TESSCAMEFR AN ZE G, FIH @ A7 O TEHE, #fiE U BYAE
A8, W RS AITESR BRI 2 S50 v 2R, 18 3.77 Ao st X dp o7 =0 1)

y=

LR

3.77 U-Slot 77 =%
4. T-Slot (T Zif#)

FERERE AL AE P L d T-Slot S8M, T /ESEAR I T AURE . 7 b B8 B 1 AR 2 7K1
2T (AR Ja, 5l 3.78 Froni) T RS HOIEHE.

0. 25

Top Width =
Top Depth W
Battom Width [os
Battam Depth W
Length Il—
)4 Bacl: | Cancel |

3.78 T A SHOTIRHE

ZAHEMET S T Top Width (Tiiw 55 Z )  Top Depth (Ti¥miRFE ) . Bottom Width (JE# %
J£) . Bottom Depth (JERFHIAREL) H Length (KJE) 5 MSEOUAME. 1E& SCAME i ANAHRLZ %L
Ja, FIHEATTUEHE, #ie T ARG E, WARSG I ESE Faldfs e300 T 288, & 3.79 fr
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7 IR T S E

"» KEE
ke
— [~ TR
=54 f L L
— e rgEe R

3.79 T-Slot J5 =,
5. Dove-Tail (feZEfE)

FEBEE SR U AE 38 35 Dove-Tail 87, T AESAR b GIRE 2 RAE . 7 0L FRBCE T i Ads
EACEFZE TR (AIKET D 5, 2l 5K 3.74 UM MEMSERHEE, Kb 7 —1M2H
MAKE Angle (A1) o FERSCARMEF AN ZEUR, FIHE A7 sOMEHE, i e R AE A7
B, MRS BRI ES B EM . 1K 3.80 Fron a2 X fs sC K1 .

En 1

— [ HE A
L]

'
f
R

f-

] 3.80 Dove-Tail /7z{
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3.3.10 IfHstE

-
1F T B B prAs b g AR B 472 Insert»Form Feature»Groove, ZR&i<x3Hi K 3.81
FoR BIPR TEAE R T HE

Rectangular |

Ball End |

L iqroove |

(1] Bacl | Ca.m:ell

3.81 IFTEAEET X EHE

IR 2R R AL 3G Rectangular (BETEIATEAE) | Ball End (BRIEFRTEAE) A1 U Groove (U HYFRTE
D o ESR FRIEINEAE N —ROP BN SRR AR, BRI A SR A T A A A
JEN, AERENEESE, &) ef 7 AMEHE, e RSk EAE. RN
A DL SR R L el SR B . B 3.82 Tz HI A& % T I T At ) K431 o

ggﬁw
! TR
Bl
RE— [ -
7 T
I N il B S e
;-r |_l_| ?\\
x/ \ PR
SMEPIRTG SMEITTAE B ER
i =] PRI

K 3.82 I Al 5
N A VEAS A — N IR =R SRR
1. Rectangular (GHIEINTERE)
TEMTEAGR BN AHHE 8 £ Rectangular 288, W ESEAA FEVEHTEIIERE ., kP )s,
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SRS GOR B TEAE, LR SRR I A IECE T, R S U 5 A v [ A
Bif. REaifliinlE 3.83 s B LA SHON 1R AE .

Rectangular Grooye

aroove Diameker |1

Width IEI. 25
(1]4 Baclk | Ca.ncell

K 3.83 MBI IEAE S HOH T AE

ZATTEMER AL T Groove Diameter AR E1R) Fl Width (TE/E) SHCUAKMNE, 18 CAKEH
MANMNZSEE, FAEM TP AT ER (Paralle) 3, HiEH s E m EAE, N
RGN IESAR L3 ds e S BOVEIE T IEFE . K] 3.84 Fn st & X Fh 7 = B

Hir

3.84 Rectangular 77\

2. BallEnd (ERJEIRTE A

FETEABSR ARG HE T Ball End SR,  WIRTFESCAR QIR . diizitl)q, &
5 0 RO TEHE, AL e BRI BB, AT A S A 30 39 (B A T e 5 1 A D R
M. PAJE =55 3.83 MBI ER IR IEAE S HOEHE,  JU2 LA (1) Width SCAHEARSN T Ball
Diameter (BREAE) ZHOUAMNE. FEAME A ABREINEAL IMEAE EARMERIS )G, IR EALTT
HAREHE, BE A CE T LA E, W ARGHE AR %R € SRR RN RS . & 3.85
7N IR T S E
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e HET

[ 3.85 Ball End 7=

3. UGroove (U BIFFTEAE)

FEI ARG RN IEHE L HE U Groove R, MIWIFESEAA LA U RIIATEME . iR,
SR GO U TEAE, LR IR A TG (B T, R S A 3 6 A v 53] T '
B, e sl 5K 3.83 ML U BB S HOEHE, RAEHFZ T —4 Corner Radius (33
AR SHOCRNE . AECRNER S AR S HEUE )G, MIE R SO IEHE, 0 e AL TR
LRI E, MRS it E S HaE v PR, 18] 3.86 P Hml 21X Fih s s &I 6.

y B
BHiz \ mAaFT

K 3.86 U Groove 51\
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3.3.11 #HAEIEHI
TX HLKs DAY s R IR T S BEAE 1R BB AR, )3 A 4 SR B rh JE AR 1) 2 () 3R I R
1. BRI
1E 3.3.7 N HIRATENH T ZA PO 718, 7R VEB] R Ui B anfa) 61 g — M s

D TR AT, EARE RN FREETURR b N B B A
PR R 2R 0 7> FIThRE, K w70 U B G AR T 1R S TR 2 X0 55 i 5 #R A ) .

2) Elﬁﬁiﬁﬂljﬁﬁiﬂiii%%ﬁﬁé\ Insert»Form Feature»Pocket, 1F 7Y fiss 2R X%

HEFFIEHN General JETH . #5485 H K — MR U JEE XTI HE K] Selection Steps HHEHY i Bbr, JRifkit

BRAAR 2R T Dy HCE -

EH T L3k
Cylindrical
Rectangular
T —
(o | i
0K Back | Canc
=)
Limd
2
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3) FE— A XHEHEN Selection Steps FR B HULEL bR, FFUeBXHAA ) BT R (5 E]
S DY B [ A Bk ) N B A BRZk . ARG BB n AR R X A LA Tangent.

General Pocket

—Selection Steps

RiTi&ER FHHE

Filker all =

i I

7
4) {E—BAEXTTERE R Selection Steps HTiEHL Blbr, JFIEICERARR T RN .

—Selection Steps ??
il
<&

]

&=
&

gl

i ERTRE i)

5) £ AR EEXTEHE R Selection Steps EPiz*iEX@@ﬁ, F AR BT 2R AR (o
1 PR DY B [ I B 1D DR JRTAR R LR . IR B E AT AR B R X (AL TN Theoretical o
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— Selection Steps

Filker all -

IThenretic;
Reverse |

FiriZRA A8

6) 17— X TEAE R Selection Steps H izt HY @ FbR, FE7ERTAR R X ik I e
Specify New Vector T, FfF H o< Q@I HE R L —AN-Z B 1), A g TS TH 6 0 4% [ 30 B T 4%
A NAC

Selection Steps

Z] .
Bt corConsructor
2 g
/
&

Edge/Curve Vectaor
i

= A LA =]
= | mlL
Filter IDatum Axis
[specfiedVectar =

g I I 0. 0000
gl ,
[Specity Mew Yeckor ., J 0. 0000
+iiC Axis
+YC firis K ~1.000

;;gc?:ésDatum s {+ Cartesian {~ Spherical |
Show(Edit Constraints |
Cycle Yector Ditection | EEMEEAM
Edit Vector Grigin |

0K I Back I Cancell

7) 1E— B E ST 1EHE Y Outline Alignment Method & X5 1 HX Specify Points 110, K48 & X575 Ao
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Cutline alignrment Method

Alian Ends j
Align Ends

Parametric
Arc Length
Flaar RadiFlacement Spine P
Floor Spine_ I

&
8) TE— MY X UEHE Selection Steps EPiﬁEX:I KR, 78R4 IR X Hi%k$E Point

Constructor ZETH, | I s G XS TEHE () mO T, FE OB e B2k i 1. 2 I ARl E T
FEERER X5

—Selection Steps
Jrom: constructor
i End Paoint
7
_______ AL AR A
Filter\ I_,:Dntr,:II Base Point
e —
Yo 0. 0000000000
i 0. 000000acon
|6“ WS  Absolute |
Offset INone vl

Reset I

0K I Back | Canecel

9) ) TE— MR EXTIEHER] Selection Steps EPJ‘ZHEEX@ Bltn, TERIAF B R[X FiEFE Point

Constructor T, | I s QXS TEAHE S B T, FESR IR BR AR _BIE % 1. 2 WO fF i I 8 5
2R X5 R
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Selection Steps

@)

@)
Filter IControI
A

A

Jolpa)

Base Point

o o 0000000000
YC 0. 0000000000
ZC 0.0000000000
= WS " Absolute |

Offset INone vI

Reset I

[1):4 I Back | Cancel

10) FHJafE— B E X UEHE T 5B 1) Placemeng Radius SCASAE T, 15 B — 204 Jlas T i ) 15 £ 45
{6 0.3, 7E Floor Radius SCAHEHT, 1B — M 4 s B I i) 5 428 0.2, FFIEHL Attach Pocket
SIEHE

Placement Radius IF
IC-:unstant = I
Floor Radius IF
IC-:unstant = I
Cotner Radius IT

[+ attach Pocket

1D SERIA NS ER, £ R TEHE S $idr OK 8L Apply %41, RGUmt =g fix
b Rellfe S ety
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SEAERE 2=

2. INJEAREANGERE 1) 1

£ 3.3.10 M1 3.3.11 MR IERATE A Tk TR A A QIR Tk, X MEs] e il
A LEIEE AR R _E BB I PR AE .

D BT EVEX RS2 AT, SE0IE T Al DY BB R S, SRS AR st 1
FEIXASLAA L

-
f=—==

2) OIS, 6 T H EhrA s = ok i B3 iy 4 Insert>Form Feature»Groove,
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FE S BPAEAEE AL TR HE F B L Ball End BT, JFAE SR RIGHONIEREf5, 12836 8] — B i [
RERR AR AT 1 T L

Rectangular | %%2%%@
Ball End i
L Garoove |
Ball End Groove
Mame

K I LBack | Cancell

3) WEASHREES, MARENEENSE. SREAEN 15, BIRERREN
0.25. HEm, 23R MIEREAL BEREAE, Ok O T /e s T A O H AR, IR G R
SRR SEAR XS N e A TN TR, X 25— ML E S IHE, B E XA (8] 1

FEEN 0.

FiriseE Y

Ball End Groove
Groove Diameker

Ball Diameter

4) SENCE R, Fdr OK $%HL, TR ST 78 i e JBCE T 1Y B /o i B e — A TEAE
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A AR A

5) TREIEEM. U T QIEE, JoEA R LA BNRRIE: B 5% XC U7 R B HER AT S
HH B I A AR D7) (1 B T T

6) Elﬁ*ﬁﬁqj$$ﬁiij’%%$ﬁé\ Insert»Form Feature»Slot, 7E3 Hi 10 EE A2 Y %t
TEHEH £ R Ball-End 1L T . £ 2 3 B 00 B T e IBOR S AE U IR B A s RS P T
TCE T
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" U-glat
= T-Slot
i Dove-Tal  pyame

[~ Thru Slat Il
Solid Face |

|
J— Datur Plane |
0K I Back | Cancel |

7) ERURCE MG, 7EHH X UEHE FIEE Accept Default Side 1T,
SEAR,  FREECE SRR N K FSE T .

BAE AU B R Ay B AR

Accept Default Side M. I

Flip Default Side |
_ Mame =

1o |
— End Point

Solid Face

Datunm Axis

Datum Plane

Vertical Reference

ERAYE

OE I EBack | Cancell *ﬁ?;ﬁg

8) ENZHE MG, =iEMESHIIENE, % # Ball Diameter 4 0.2, Depth 4 0.5,

Length 4 1. SIASEUA, FE5 I AHAEE A AHEHE S, LERK-PE A 30
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Ball Diarneker

Depth

Length

1) I Baclk | Cancel

Reverse Mormal I

] 4 I Bacle | Csa.ncell

9) IEHUKFEA TG, 23X GG RO TEAE,  IX ik H R B IR A A 3R 1A AR D B bR
%, BHJSLE Set Arc Position XTiGHE I HL Arc Center 1B T7, 4575 -1 BT B S 1) 45 23 R 9Ky
THi, XA ESEIEHE, BEER BN RS T EBZ BPESEN 1.

4R RE R
WENE ®ingig
B EILA :

o | End Point |

Arc Cenker i

Tangent Poink |

Horizontal

g | _ Mame

! ) HEBL40 B 47

Create EXpression

pag
0E
()4 I Back | l:am:ell

i

10) EHCEMZEHIWEG, Hii OK 4%, HRGUM 22 B E KB S5O E AL S B B
[ AR S 1 61— A
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3.4 FHEMT R

HMRF LR IE R mi e A TRFAE 5 2 L AT S A O AT pth 2k 5| P 2R LRI . R AE R
7 PLHRFAE . R RFAE AN FUZ R

3.4.1 FFAERYHIMH

7E TR B e S Bk PSR 5 A 4 Insert> Form Feature> Extrude, % 52 i ) G i Y
XPTRAE, R IEEERR R, AR5 PR E R APRF AR A N 28U B AT e b R R A . 18] 3.87 Fow

FRT e 1 L1
R (R féfrgziz;\

R f{dfE

3.87 HFAEHLfH

BN G T SChr R R 2o B RLAF RN, BE AT B AR 2 B AR X A S ZE A
MR, WA RO IEHE AR E R RIS, FAEL B AR X gz Xt R o an R
a8, HAEFERITE, TS AhEF I, AR g, WHER R L, BRI prE X R
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AL Mk P AL o AR TR B, FTBLERZ AR ERN R, HEN TRl
FLHURFAE, 0 2500 DR B0 28 58 SCIR R AR AT 1 2 B (1 o o 78 L i PR A 2 B30T A 75 225 A\ A%
(Offset) ZHUfH, WL SCHIFHR T h 25 203K I

EIEFRRARN R G, RS H W& 3.88 Fran 48 € hifh 77 XS HE o 12X AR A DY Mz e 7
A, EA14r7&Z: Direction-Distance (1% /71 5FEEHifH) . Trim to Face/Plane (FifHZ|FEE M)
Trim Between Two Face/Plane (7E#/~48 7€ [ A 42/ ) 1 Through Multiple Bodies (%% /™ SR,
i) o FHEVEAENH— T IX 4 P o7 U .

Direction Distance

Trim To Face|Plane |

Trim Between Two Faces|Planes |

Through Multiple Bodies |

1] 4 | Bacl | C:a.ncell

K 3.88 F5hi 7 SN HE
1. Direction-Distance

T IETAE AR 2 K7 [ A EE B R RN R o BRI, 25t an ] 3.89 Ffr s £ R 75 1]
XU R AT 2 7 48 R PR AP T 2R A ko

Accepk Defaulk Direckion

Reverse Default Direckion

|
|
Select Direction Reference |
|

Veckor Construckor

0K Bacle | Ca.m:ell

Bl 3.89 ML AT [0S HE
RGUE GBS R IZAEE K 2 R AR N O SUREOR PRSI, R BT 2 T X
RIS IEFE AR G P SeAA L S sloT T th 26, U R 5 1) s 72 2 DA T 2 )
Hates A5 URFR AR GO AN PR~ I SeAARad, ISR D5 ) S om £ 5 — 2R B Jm — 2R i s
A LT B RLARS G e TR il 2, % W) SEAR I B (A SefAid 5 ih 2R 4L 5 58, W AR e REHEWT sy
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M), ZE TAEX WA RIRET Wk, 10HE 3.89 X iEHEH A H I Accept Default Direction 55
Reverse Default Direction -/ NMETT. FHI4A— F K 3.89 XFiHHEH ) 4 kI,

® Accept Default Direction (FE5244HrkJ5 0]
WERZIE I, WS RG0A SRR 7 ).

® Reverse Default Direction (J#4EL 77 0]
EPZIEIT, R KRG FIIHAR 5 .

® Select Direction Reference (i&#FZ J5[7))

ZIE TS IEFAFAE U & (il JEEREE ) Rw 7 a). e Fazikm, <
OO GOEFNEAE, LIRS E TN EIEFESE TN, L REERESE TN T7E, B
FEPR A EE R IEFRAH RN B ] BRI TAEX RIE BAERNT B, el , RS0 B shHE W prade
%N Edge End Point (I1¥i £5) B Datum Axis (JE#EH) BX Line End Point (E Zk¥i A1) o FHIN4E—
TIX 3 MR T

1) Edge End Point

BRI HTIR AL, FHR R 5 7 NS I 2257 1)
2) Datum Axis

IR S BT IS HE R E ORI 2 T 1A

3) Line End Point

ZIETHRE I HTIR A ELZ, IR R #5170 2255 17 .

® Direction Subfunction (KEGIZEIIHE
ZIE T R AN EHER & R 7 A IEPRZIE TN, R BV TENE, AP RE L —
MNREAE BRI ST T W

FEFRE WIHAR T [N, DA 2B A6 RIEZ A AR 7 1) 2 PTG, B RAE0T GoE SRRk i
M, wWhid 7 mi ey, WA &b — . F Select Direction Reference 1ZE T 1] ) Fii {H14F
fiE, 5 A7 B B o SOCHE, 2t WS e SRRy M O R, e SRR
LT ES o RN e G P i S B < P VAL 10 e ) = YA 8

— BRI, 2 B AR X 2 SRR S R s MR T 17, TR s P MR 26 ik o (1
e 71, Rt P 3.90 R AR S HO0EAE .
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Extruded Body
Skart Distance II:I
End Distance |1
First Offset IEI
Second Offset IEI
Taper angle IEI

—Taper Stark
% A Defining String
" Af Start Diskance

1] Bacl | Ca.m:ell

3.90 BLHBH IFHE
A EHEAE P AR T A T

® Start Distance (EIGFEES)
ZCANER TR B R AEE AL E . H G A A8 7 180 1 = A

® End Distance (& IEFEED)

GCARKER TR B R Z b E . AR RN AR T &R S A e~ & 1, HIEHR
2 AH X Fr B 7 19) T 5 . End Distance 5 Start Distance 2 7= 1026 5 (B B N hr B R v Fr 8y 1] 1)
K,

® First Offset (&5 —{W%)
ZOCARNER TR E A R m A R Ia A S . HAE RN AT T dh 2k & . HOE SR A
XHwAE A LR R ER R W) M.

® Second Offset (28 —fWf%)

VZOCAAE F T B A i 2 w2 (02 b0 B . HAE IR/ N A TR thZem &5, HOE /2
AHXH WA 75 M1 5 o First Offset 5 Second Offset 2 Z& 4 XHEL N SEAR 1 JEJE . 45 First Offset 5
Second Offset ¥ HUE, W Y {0l th £ Ay df A1~ 1 b 2Ny, S e ARe A0 2 AT g fef 8k T b £ e ]
DX P SEAR s 75 T AR RO 2 4B T b A g T 2R 1 Ak o S i th 60 5 P FLI,  First
Offset 55 Second Offset Z%{H 1 HEe NE .

® Taper Angle CHRAEAEED

GOCANER T W B AR 7 m b A i, H4XME L/ T 90° o Taper Angle KT 0B, &
WRLAR T A AR /N T 0 B, RV RLR T A M AR . AR T 2 S AL, FLEIIR
LT 17 WA 4 AH o
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i {HEL R ﬁ

\ &

IREEAT & T
Fr 8T

AT HfE

3.91 Direction-Distance 77 o i

® Taper Start (JFTFUGRBEE)
ZIR T T 5 B B AR E RO I GG B . BB & At Defining String (B X HIZk4b) 5 At
Start Distance ECUGFEESAL) PHANIEDIL

1) At Defining String
TR I T B B ARRAE SRS F S 46 A7 B P ade BCP) e A A i il 2R A
2) At Start Distance

LI T 9% B B RHE SRR R e A B v R ARG B . 24 Start Distance 2N 0 B, Hf
fHRR 5 At Defining String IETIAH[F]; {H 4 Start Distance A8 0 I, H1 T & AR A 12k 5 47
R A A B A — BB, WL hH AR 5 At Defining String 1WA A .

K 3.91 Fr/x [t Direction-Distance J7 2 | iz i (1 45 .
2. Trim to Face/Plane

I TR E W7 A S SR, SR P R B SRR s e T i . %y A
IRLAHIRAE, R TR B 0T R TR, 24 1k 48 5 1 S AR SR T BT 1

WFRZIRIN, FZRTA T EAR E R e, 23R 3.92 B BT A B EHE . 28T
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RV LA T TR LA i SR T . R4 R ] 3.92 X TEARE PR I 9

Trimming Face

Filker I - I

Trimming Face Options
% Do not Extend Trim Face

" Extend Trim Face
" Try Both Options

[E | Bacl | Ca.m:ell

3.92 & BYHIE U TEHE

® Filter (JEZH)
ZIE T 148 & 10 B BT T B (1 PR A1 iR 2858 . mT 3 4% Solid Face (2K ) . Datum Plane
CRAEFIHD A AN CATE SR SEIOR PR Hil i PExT R,

® Trimming Face Options (fZBUTHIIET)
ZIEWUA A T e e s m . B Do not Extend Trim Face CANHHEMEEITHD .
Extend Trim Face (#HJ@MEBYIH) 55 Try Both Options (Wi H BNHIH]) =AML,

1) Do not Extend Trim Face

ZHIET T A RBABET I . St REe b fm A2l B BT, 8k i,
2) Extend Trim Face

ZHIEIH TR RREETH . SR REhii 52 B BTN, 8 HZIE T,

3) Try Both Options

ZHIEIUH T R 8t E S AW SRR BT . SASRERE fr N R fu s £ S 2 E BT
I, A%

PR SRR T B HE P T A F OV IE BT i, AR 2 B AR X 2 o Hh R 2 i S o I A% 5 17 »
It 5 & 3.90 AHLAIH A ZHOEHE, HEEPRARTN AN SHCCRE. WEHFHSE)E, &
SRURH . F8) A7 7R A T R AT S8 iR AR R4 o 1 3.93 From M it i fh oy 3K B 1
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R[] g (BT

& 3.93 Trim to Face/Plane 77 RFi i1

3. Trim Between Two Face/Plane

TIE TG AR E N7 [ 5 SRR, AEFE € NPT SRR T B HE T T [R), Fr e Xt R o 2%
WIRT, AZATIRTESR AT AR, A 3.92 oS MS BT AN . SE i B A BTk
UL, SRR IR SRR I BT VSR BB, FHL R RE RS BT . SE BBy I ik
Ble, B TAEX b2 Bon BT LR A Iy, JF# 518 3.90 AR R 2406 15 HE,
LB NN SEOCAE . B RARSEUE, RO B AR 2R 38 A 7 2RI R] e il 5
i K 3.94 Fros (st X f 7 sUR B
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i (R Pi{dfe (FRANERIE)

K 3.94 Trim Between Two Face/Plane J5 0 {H

4. Through Multiple Bodies

LTI E R, AEARE N2k b, BT B R EPEHZEI, 5t a0k 3.95
Fos IR S HO TR HE

Extruded Body
First OFFset |E]
Second Offsek IEI
0K Baclk | Cancel |

3.95 P SHOTHHE

R AEE AR Hbrsedl, 2B TARX & on R kR i e Jr i, s
RS AR, ARG e RE. B 3.96 Bros (& X b s 20 B .
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R {HRTER

AL ffifE

& 3.96 Through Multiple Bodies J7 I\ HifH

3.4.2 ¥HERIERE

F T B Ebrfs ey @rﬁiﬁﬁ%ﬁﬁé\ Insert»Form Feature»Revolve, Z 452 H X Gk HL
XPEHE, b P e T R e GO T e SO i ik th 26 .

PR G, BEn] RS B AR X R B e e (s 5, B ml S e X U UG 1 HE 4
SETERER R, AL B TARX i Bz R RO R o R (a7, HR#E O07 fF, "
SRR FE T AR R g, R R L, WA BRI Bt RIS AR Rk 7 A BB
FEGRFREFERT R, wIEF 2R G, b bR SO thZk. O 1 REVS B e RFIE, 14
2t DR B 24 58 S e SEARTID I 28 AR BERE 1) o A5 AE LR M e S RO TEHE R 2 A\ W Fe  (Offset) Z
HUE, 0B 285 LA e e AT Hh 3 b 22 ST o

e TN JE, Rt i 3.97 B FHIERE e ZTEE . 20 EHER = Mgt
A, Al Axis_Angle (FETieFE 505 e % M 77 e ) « Trim To Face (iE#%E|F8€ M) A1 Trim
Between Two Faces(7E /M8 7€ M B FEAT i hE) . NI mA4H— 1 X =Fhiehs 7 N ag k.

Revolved Body

Trim To Face |

Trin Bebween Two Faces |

0K | Baclk | Ca.m:ell

Kl 3.97 IEFEHEHNS GO AE
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1. Axis_Angle

TIE TG AR E NIHERE . e ke an A 28 b A 1005 AR IR IO B o IEFRIZIE T, S
FUEHOSIENE, AR ke ™ AT DU P BR 10 R e B 2 0 T VR R e e Bt LIS 114
Xt G BR A AT AR PUF

® Edge End Point (313 &)
TR B BRI, 48 170 ik ity 2R 7 [ A e e il

® Datum Axis (FEAERD
2R TG 5 T B FE HE R S el

® Line End Point (B 2k &)
IR E R R B L, FEAR ) Fride s i (177 [a) N e e il

®  Axis Subfunction (£l %)

ZIE TR O e DR ta e e i . e RZak I, o SR UEAE, N AR BRE BRI T
TEXFEE—rl, BN E S . SR TEXBREAHE Sk, KR RGE e, JFh
RAEQVENUEHE, F e — N RE W, VR R 5 A BRI 2 e .

57 RO el L6 ZUASE R e ) R G2 it P e 1), RV X R 5 SR T e Bk T st 2k 8 Je e el e
Femt, AnprEAARKRE. — BRI E R, %K TEX & RoRSLef hRoniehe i, R
LR REEFT AR R T A . B 2 A 3.98 JTR (1 iE e 2RO I HE

Revolved Body

Start Angle IEI
End Angle |3 a0
Firsk OFfFset IEI
Second Offsek IEI
0K Baclk | Cancel |

3.98 e SHOTIRHE

ZXHTEHE LS T Start Angle GEZUG/A) + End Angle (ZZ11/f) . First Offset (55 —1fWf%) Al
Second Offset (3 —fW#%) VUNSHCCANE ., EXTEEFRRANRESE)E, HA AR /REEXNTE
HE, e —FpAn /R ¥AE T8, BITTSE et Bl . [81.3.99 BT B st X Fh oy =i 1491
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FTIARER TR

Revolved Body
Start Angle IEI
End Angle 180

First Offset

1]

Second Offsek

F4.3.99 Axis_Angle J5 5
TG A T e S HONTEE & T A

® Start Angle
PRI TV B IR R AR A, JLAE A RN AR T e it th 2 b, & i 2 i fE
IR &, 07 1 BLS e sl st 3 W 7 1) 4 IE

® EndAngle

T TR B R R LA, FAE RN R AR T e i th 2, % 2
FEFIET F K, 7 Mt 5 e ascs T W IE. %5 start Angle F{E KT End Angle F{E, U1
Jid e o RGRI@ e Sl i) S5 7 1) Jig e

®  First Offset
ZIE T T B e 0 R G AL B, FAER R/ S A T e At 26, S ih4im &
(1), HIEFURAR R T M ELRETELIT) 15 1.

® Second Offset

ZIE DU T & B e w2 b A B, HAR R /MR AR T e th 2, & 2k
T, HIESRHRAEN W M (B RERTLTTIM) 15 M. First Offset 5 Second Offset 2 22 1) 44
SHE NTARE B . #5 First Offset 55 Second Offset YU, | 24 g &A% 1 ih 28 At 1~ 1 ih 26 A,
iR 2 R 1T A K T A T e 1T ) 48 o BB TR 3 ) S A, 75 U)o e R A A D i vl 2 ) Ak o e e
AR M 2R 5 N FLES, First Offset 55 Second Offset ¥ HAE N,

4 3.100 Ffras i)l A& s B BN AN R A2 5 2 R B
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R[] {15
RTIARERE AT 5

IErmiw s

nall
J Iy

|

|

|

\
e

FrmimtE

3.100 A AW 5 =K
2. Trim To Face

BTG AR € WIHER . e A e R 2146 € SR M BT . 207 sA 2 e
ik, BT R RN, kT80 I SC AR I B . GEFZIE T, 25 ]
3.101 Proik BB BY DR AE

Trimming Face
Filter

0K | Back Solid Face
Dakurm Plane

3.101 1ZEBYTH XS EHE

FH P 75 BL48 5€ Filter $ET0, JE$E All (FTF) . Solid Face (SEAAZKIH) B Datum Plane (JE#EF
D) YENEBTHfE, S SORBOMEHRE, 1EH P ke, feeheimims, ESETEX TR
SRR R I, [FRE R B A EER R R A Ty A, 5 1K 3.98 AL TiEE S
FOEHE, RAEHAERAE TR, WEBFRESE, FR A REEXENE, B —MAm R igAE
J7vk, BI] S he e A . 181.3.102 Fras B st X Fh o = A B4
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FTiEmEdE 7 5.

e

z

k, e
X X

[.3.102 Trim To Face 77 =

fe¥Efe

T

3. Trim Between Two Face

TIE TG A 58 (NI HERE . AT R PR A S A3 T Bk P~ T o [ BB 6 o B o 1207 A i
IR RFE, AR T BTk i 58 — AN SRR I BRI HE P TR, 2% 1B T it IR 58 AN SR R TH] Bk v~
T o

WFIZEI, 2 # A 3.101 Fros B BT EHE . F85E Filter eI, LLHF SLARZK I BAEHET
NS — BB e, PR ) — SCR R I B T A v s 88T . A R eseh)s, %
TAE X 2 R FI SR 2 fi Sk s el RN Bos R 4 S o i A 77 ey, JRah 514 3.98
AR S HO e, WA AT TR WEFRESEL BRI REEEXEE, #5E
— A R DT, BRI SE O R 1A . 181.3.103 BT Bt X A 5 3G B
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4].3.103 Trim Between Two Face 5z

3.4.3 $FERFIH

FTE @]*ﬁ*ﬁﬁjﬁﬁi@ﬁiﬁﬁiﬁﬁé Insert»Form Feature»Sweep along Guide, RZE L
HOXT GRS UEAE, 1B IR R RAE RS Sk, &L SL G, S 3.104 Froasn
RS EOTEHE

Sweep along Guide
Offsetk 1 IEI
Offset 2 IEI
0K Baclk | Cancel |

K 3.104 FHSHEHE

ZAHEHEF L4 T Offset 1 (E—1RFE) il Offset 2 (3 —{mFe) W/NSECCANE. 7EXHEHEF
NI SEUG, R R ERESURAE, 02— P R ERE Tk, B AT 58 e s F 16 r 44
P 3.105 ATz sl A2 SR AR 1
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R &

o

5157t
(FEEE, 7=EHL)

P 3.105 FAHEHERAE

AL AL, 5 ] Axis-Angle S A7 AU BLARRFAE AE S T L2 AR R . HUHI BT
WGl 3Lk, AR TR Axis-Angle H iy AN BRI 1A, BI SIS LAH S TR0 1A . P X
BIET

(GR35 TIPS el Ul b= 91 S PRNTTE oA G DR CIDAY: ¥ S = k2 WA RCIFRR I £ 7/BU S REHERK TRy = 1]
AR TT AR A0, T AFARFALE P LA A RS 4R P 2 — S B B AT AR B s VBT F R P4 1 0 4 P
NG FEIRE, TS ARRF AL (14 v B o ) 2% LB B B Rl be 46y 8

2. B FEONELR, RGERAHE T FOREIEEPULSIHRFE . B, I A 2%
RETFAGRLA, s FOVE LA RE, ST F R MITaahr i A iy B4 T7 ) o

3. 45| FEONBINN F Oy IR . R G R e 77 SOk B UL SR A, 1t
I, e oy R I A2, MG R i 2 AT AR e e, e ) i B N IR I R I

3.4.4 BIEEH
X LA DA AT FH £ R R AT R AR O B VE B ARER, 1B 3 A 2 SRR B S TR RS e 1Y)
(SR

1) 76 T H B hpAs s 25 ok i B3 B A 4 Insert> Form Feature>Extrude, 3 H % 5 i BUHHE
HEJ5, SEHUH [ A 1 DU A B b o #3236 1 30 HE R 7 U6 AE 7% BX Direction_Distance
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W, FAERE S5 H S HE A L Accept Default Direction 3£, #252 R4 E BHIHAH 7 0]

Mame

Solid Face |

Solid Edge |

Direction Distance

Trim - !
—— I - .
. i
0K e Accept Defaulk Direction I ﬁ?ﬂ%g}

Throug Reverse Default Direction

I
Select Direction Reference I
I

= Mector Conskruckor

0K I Back | Ca.nr_'ell

2) e TRAR T MG, iR SEOERE, fE Start Distance SCAMEF A 0, 7E End
Distance SUAHEF 4N 1.5, 7E Second Offset SUAHEH ¥ A\-0.5, 7E Taper Angle SCAHEH 4\ 45,
Bt OK %4, RGNS R B SHOIAT R AE, B PTIE thZ& 1 H L .

Extruded Body

Start Diskance ID¥
End Diskance Iﬂ/
First Offset [
Second COffset Iﬁ/
Taper Angle Iﬁ/

—Tapet Start ———
{* Ak Defining String
At Start Distance

0K Bacl | Ca.n-:ell

3) PREHAT AR, £ TH l’ﬁﬁﬁ*%ﬂi@ﬂiiﬁ%%iﬁé\ Insert>Form
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Feature»Sweep along Guide, 7E#H X G BN TEHE, FEH i — BB LA B0 SAE AR %o

Sweep along Guide

Solid Face

Solid Edge

CUpwe

Chain Curves

Sheet Body

e 4 OE |
AT E

[IE Back | Cancel

4) WHETHIN 5, BN GUEROS TR, b 5 A 1 DR AE i 1 5] S2¢

Sweep along Guide

Solid Face

Solid Edge

Curve

hain Curves

Sheet Bodw

R A3
0K Back | Ca.m:ell SRtE

5) HFEGI LS, EEMITAXHEHES, 2EH Change Direction 285 FRAEHLH HOFHE SO0
THE, R ARGHERSH, Bl OK %4 FJEAEA /REAERHTHE T EH Create 1T
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Direckion Cik

| _hange Direction

0% | Sweep along Guide

= Offset 1 IEI
Offset 2 ||:||

Boolean Operation

Creake

Unike

Subtrack

Inkersect

)4 I Back | Canecel

6) HE I A/RKIRIERA G, Rt A% B E IS A EH AL

3.5 RHL#RAE

FHAEERAE R AP AE S AR BAFAE AT B O I IR SR AE AT DU ] S A AR 57 R 2% ARFAIE . RFAIE
BAF RO, IR R BB BIRS . BRI BTSRRI B SRS A

3.5.1 (&
?’:E:I:E_Fé_—l*— M. = A@S 2 A == AN H A PR
A m*:qjﬂ‘iﬂiJEZJﬁi‘¢ﬂe$nn 4 Insert>Feature Operation»Taper, Z i< &
3.106 Fs [P SEARSR AT RS IHHE o

XHRAE_EFRA EIRRIX, T IR SR it RIRAL S IAR AP 3R, RNl A2 BoRIX, Hf i
NN PR SR T AN SRR 0 BN N Z B0 T, T SO I8 F SO S H0E T

RIS RRRBAG R 1A% MYIEREM S HIL . HSCARRT, B IERARRA, ik
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AR 3R, IR B S L KRR AL SEAREAT IR . R I 20 TR 40— N S Rk
RIMRAL BRI i o

el

|'Selecti|:|n Steps ———————————————

Filker

angle |1EI

% [socline €7 Draft

[T Taper All Instances

Preview Faces bo Taper |

Reverse Draw Direckion |

Distance Tolerance IEI. ool
Angle Tolerance IEI. i

[ Confirm Upon &pply

0K mpply | Cancel |

&l 3.106 HSZARSRAR ST TG HE

1. @I Faces it [P AbisLid )

IR+ NS5 (e T IRDT A6, S35 AR B, xR E SR R AT
I R MR SARI A7 3 MRBOP RS, T A T eI AL,

175/ 454



Faces to Taper CEFHR )
AR BRIGE T Tk — AN BT R R R I o E B P AR SR X H () 2 20N 25K Filter
GILJEAR) 1ETT, BAH T Any. Face. Feature fil Body VUANFRHIENETY, H iR EELE
TAE X A I B SR BURHAIE H R — AN ERE AN R T N AR 2R 1

° “| Draw Direction ($8 7€ #kA% 77 7))
ZARK D BRI 48 @ SEARIR IR T 7], RGUASRIIRIE T 78 2 TR IE A . i BOZ bR
i, AR R RIX HOE IR Vector Method (REBIZETIRE) &, o] HE & XIRAE R 7 o

° Reference Point (§E 2% /)

ZARBOPRE DU 48 8 TR B 2% . RGud 2% fe — AN B TR T W R
[, FESRBOERES, SCRFESRBT sk th e A R AR IEBUZERRES, AR B IR X Hoks i
7~ Point Method (RS GIEEDIRE) 1R, H o] e @ RS .

K 3.107 Fros B R A T 30N, BT AR T A T ) 5 23 RN 225 i, 0 Sk AT ik
R AE X L B

3.107 iR MR SR

M R R SRS, Pk AT R ASRE S AR PO R T VA AT . OB RFIE 5 2%
RAMREER, HWEREESE gy, WARSE B Z% e & R E NS5
AT SEARSNR T RS, R LR T 0, WSRO [h 1] AL FAORSE ;5 D4R BT i 1] A4
o BTSRRI AR, 5005 RSN R I WIS AR B . 1] 3.108 Flraas Al A& 450 A K
T O, JEFESLAR A SRR IR B
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EARE R
s

K 3.108 SEAk AR TS

2. @I From Edges (I8 i i A S 44)

ISR NSRS A b B, 858 M Se AR AT i . 122Ky
WSS ARG o ISR, B 2 DRV IR RS I SR E
BT, PR — NI B fiE A R . NI — IR IX 3 MR BRI

o
° A Reference Edges CGEFRIKIES 1)
ZIRBOD RIE T T IR B — KB 2 ki, 1ENIATIREMN S50 RO EIARES, ARG
T~ IX HOE SR Filter SEIT, 7 AR B IR B SR — 2R B E SR NI S K1

° Draw Direction (#8EA%J7A])
PP IRIE T T8 8 SRR 7 TA), B ERSATT mOA 2 flE A . S D7 vE S R A4
HIAR T -

° # Variable Angle Point ($§ 7% f FE 51 &)

RSP RIE T TES % B SRS i i, R & H S BRI A, N
T SV S 25 10 SEARBEAT AR M FE I3RS . 1% bR RAEIESE T S B 1A% 5 A4 WiE . EBUZEbRET,
AR R IX AN 3.109 Fin, WIPESHIA FE L — mEE mifE il s, FF s oo 4 s
AR HAREAEE . FEHAH— T AR R X A SR I v .
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Poink FMethod ;r/ -«
*

Yariable Angle Im

pkd angle = 10
k1l angle =10

Maodify Point

Rernove Poink

e
| -

K 3.109 TR B IR X [ 0

1) Point Method (5614 J7V5)

ZIETH S ThRE, L ESHE L BR e R AE RS S, — iR —AMEH S,
Variable Angle XX AHE, Modify Point ¥£15, Remove Point 1% I5 Al 7] 25 £ 55 41| R HEH i, [,
Variable Angle SCAHE A B 7m 247 ] s Ab B SRV RB A S, AT A8 A BE A SRAENG B s iz 2 i) i 42 A 4K
A

2) Variable Angle (RJZAZff ()

ZOCAHER T2 Sz H S AL AR L . A EHERE — MR, ZSCRRE T R A8 BRIk
B RL, I T BB UL R SR B . T DAESE SCEPTA S % i, FET AR A
PIRAE LI T BB 5, SR s i) s A B BB A P B AE 2 SO AR T, AT A AR £y
JE 1B .

3) Modify Point ({& &% )

R T ez RS B B E. AR SR RETR e R, WRARSHL
s S B L AN Sy VA A9 R A L, BTBU P T BB R R B ThREAE 22514 45
PR, AR FZAE U S ] R B

I T ZIETE, 2T 3.110 PR BB SEE S S IEHE . R AR i E 2 KR
AR 2 f 2R 20 B Ry SORME Sz AL E, BT DO 1 Bk e HA E .
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Modify Poink

" Arclength

¥ =% Arclength Im
Il:l i

a0

L

1] 100

Resek |

0K Baclk | Ca.m:ell

K 3.110 B kdzl] RO 1EHE

4) Remove Point (FEZS% &5)

IR TR T2 AR R e R AT AR A B A RAME e BB K i R, Sz ag R ) £ 2%
S0 L ARE I R

FEREATIXA T AR, SR P 2250 R R VIR S R [m R R A, UK
TR 1558 2 B O BOFAGZ LU, F 7 T DAASE 8 28 M FEA% ) i, IR RIS 51U
M Angle SCAKEH BB AR AE, I SSARBEAT B8 Ay LSRR . WERAESRARIS , SRR [F— DRI 2
Bt NS 100t , R 2RISR RE DR . B 3111 Jrosisl £ R —R NG E 2 BES%
AT AR 451

TR
A RN FRIE
%
kRS
et R

3.111 [A—RN £ %S % Uk
3. @I Tangent to Faces Gl i AH V)3 HI PR AR SL A4
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ISR T 535 T AR A s X SAARBEAT IR, I (8 SRR T AR D T8 € s Rk
Mo %R T AR D) R T A5 ZR TR RFFAR VIR Ol JEIE ARV R IR Skt g 2 D
W R RE AR E AR, N PRI IX 2 RO R

Faces to Taper CEFHR )

AR RE T T B — AR M B M VIR TR AR R . EBUZEARE, 1R IR
X Hef IR Filter BT, DU, AT7EZ B TAE Xk £ SR BURRAE H 1 — 3R i sl 2 ME DI R A E N
BRI -

° “| Draw Direction ($5E #k#% /7 [7])
AP IRIE T T8 8 SRR 7 7], B SRS T WA 2 BhE ). S A D7 vk S R A 4
IAR T o

K 3.112 Fron Bl 2 XM 30N oA 1 B 1

R

(1. 2, 3 4 5 6
AR B YR )
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& 3.112 Tangent to Faces R IR

4. ﬂl Split-Line Taper it 43 #1310 45 - 5244

ZARIERI AT NS5 e P I GG, S3R7 R R A BE, W8 e 10 7 B0 Sk 347
PRI o IS AT A SARTE 7y B AL B A 7 BIARITEAR,  E0E T SR A REER TR A PR R
TEL. I RIS HE 3 AP IR GBS HIL. FBERE MR ESH s, NHAH—
N UIEETIX 3 ANMRBUD IR .

N,
° O Reference Edges CGEFFZ#14)
ZIRBOD RIE T T IR B — 2l 2 2 Stk L, AERIHATIREE 21 . HAE A 7 vk AbaE

AR SEARAR ] o

° Draw Direction (#§5 kM7 1H])
IR R IE T 48 0 SRR T 7], AR SRR T )R 2 BB . AR vk Sl R i
PR SARRH [

° | Reference Point (3558 5% 1)
S BRI T T8 2 SEAR IR 255 /5. RGUEN 2% e N3 B TR 7 18] (3R
I, EREGERE T, SEARFESRESE T L A 2 A R A AR A .

B 3.113 P it A X ARy 20T Shobag A i B i
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ERE

& 3.113 Split-Line Taper kR {E
3.5.2 BIEfR
Eiﬁlgl*i*iqj%ﬂi@ﬁiﬁﬁﬁﬁﬁé Insert>Feature Operation»Edge Blend, F%i<xii
Wi 3.114 s rI4E] 3 A0S HE .

O TEHE E AR AL TR IR A SRR, R U T i B R A S8 B,
SeEXT AR s R AR, WEBRAMFRESE, BASETIEX hikfe s 2/ M rg, WA
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Edge Elend

Blend Type

’VF Edge " Cliff Edge

Filker I all vI
Default Radius 0. 256

[T add Tangent Edges
[~ Blernd all Instances

[T Specify Setback Data!
Paint Method i
7

Respecihy Edge

|
Madify Point |
=)

Wariable Radius IEI. 2

Remove Foink

Tolerance IEI. ool

Crerflow Cptions

[~ Confirrm Upon Apply

(1]:4 Apply | Cancel |

3.114 {315 F1 0 HE
1. Blend Type ({2l 7770

ZIETA AR BRI MR, RGRt TR EM 7K Edge GAEIM) M Cliff Edge (BE
LD

® Edge (—fiLfEIf)

— M2 R [R] F o TR v e R a2, P [ AR B A 0 SEAAR BY A A AT (30 A, S {30 15 Tl AH
1) Vv & a0 1 TP o 1 1B i o S (= DA el ] D= WOV R YV r= Dl M N -1 DN O %2 W A e
172, BB RIS B ] MUAR AR E TR, S, RAZRPAREIR . AR EAREE, W AE
PRI EARE 2 A AL IR R BIE AR .

FE R 8 AR R A I, O [R]— B3 AR, BN P R AT (R A i H, REAE
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(7 IR 3 42— AN T R L S B U HEAT (B B R o 0 AN R BEAT (R A I, e 25 E 2 A AR H
TARRIGEEERAE, M DM EA 1T 18 3.115 Fros Mt i Ah s A1 i i B .

ik A EIED

=

FERE
K 3.115 — Ml fa) £

® Cliff Edge (FEilfaIf)

B T30 5 £ R ARV BRI BE I, 8] s - A S sl B R idb AT (8 R, s 400 ) v G i 4 52 PR B
0, BB AREE T AR ) SREHE R A 1) AR KT Rl S BIR 2 RIEE . K
3.116 P A2 1 Ry =3 15 A ) B
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TR AT
[z1pe] IEHLFIREL

FER/E
K 3.116 BEil{3 £
2. Filter (REJESS)

AR T 48 e (30 (5] A Bk O G i BR i )2, AT % ¢ Edge (J4) . Face (RJH) . Body
CSEAR) FT AN CFTE I e 0K PR il e B0t R 28 7,

3. DeFault Radius (45 #¥-42)
12 SCASHE F T 150 B [ A A3 [ A B 1) 2 A2
4. Add Tangent Edges CIIAFHYIIA)

IR T W E RS HAEFARYNIL . EeFzIem, HikFmia 5L ey, REENE
FH ML — R EE A . (Pl MR R L AU I .

5. Blend All Instances ({37 Fr A5 X %)

LT T BCE RS T B PR RA (BB A o GBI, P USRS T MRS IR ) —
ARG, U Rl e B S R A

6. Point Method (/&G TRHE
TERA R BIR AR, ZIETH T e ] 3 A R ds il . EPZIE i, 78 kil g e
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o EAEIPAR I S, WAEAR ARSI RAE T 281 A Pzl i R L2 IR i 1
— kAL JE A -

7. Variable Radius (A[ZAZ244%)

POCAHE T Bz i fib 48, NMSEBLTEEEL TR E 2 AL IAFEAR, X sEikel
FARBATEIR A . BOESEAR R AR SR AR AR R A R R 5, P RSP AR 2 B A
SCAKES,  SRJEE NGB AR E B AT o A2 G FERHE T — AN S ARG -

8. Modify Point (f&I5td5 i &)

ZIETUH TSR] R AL E . R EB IR AL M B R AR AR R P R, PG
FAZAET, ARSI AP 6.110 P B G AE AR 7 EE SEE ] R AL E . B AR T
— AN R A B .

9. Respecify Edge (L Fi{gE1L)

IR IR — S I S ] R B 05 — kil b0 P n] LS B AR AR 21 AT Hh 1 B4 il
R BREREZIET, SRR S — ARSI H A QIR IR A AR E M
JEA WS, IR T AN AR

10. Remove Point (#2245l &)

LT E B WA 6 S R £ me AT DA B i AR AR 1 RAE A2 AN 1
FREFZALITEI AT

11. Tolerance (/AZ)

ZOSCAHE ] T4 € P A A2 7 SCBEAT (BB A I R A Z2 48, RIVFE P AR AR BEAT — R (B0 8 A1 14
{80 B A R 22 N A AR i i N ZZ T A

/NAZENIZIUCRE 3 MAE B /ME: Tolerance {8, BIZiETIH X E M)/ AZEE . 7E Modeling
Preferences (FAESH) X E MR /A% (Distance Tolerance) fHFlH/NA]ZZE42[x DL 10 HI1E
AR B A TCEEATI, A4 0 A 28 AR EI AR K, N s A ZZ B I R 1

12. Overflow Options (¥ 3% 151

T T4 0 B A A 5, BRI A, G N RO AR . PRI T,
S AN 3.117 PFras i Oy A IR AE . P & B T A AR
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Overflow Dptions

v @llow Smooth Cverflows:

v &llow Cliff Edge Crverflows

v &llow Mokch Owverflows

0K Bacle | Ca.m:ell

K 3.117 & 7 SOGHEHE

® Allow Smooth Overflows (fC¥FGHE % HD

ZIRT AV, RIZERS X el 1. BERS R G0E 2 AR 5 H A A1 B2 i AH ) 48 [ £

® Allow Cliff Edge Overflows (0 ¥FFEiZ s H)

ZIR T VFBEIA G RIS VRAE R H DXIRAFAE Bl o SRR ZR G0N AT 12 T 0 320 G e A3 15 £

® Allow Notch Overflows (R VFMTE#E HD

ZIEI ARV O, BICREEAHUIR @RISR, MG TAERHERTE I 7 — @5, o7 07e% H X
WA IR R

3.118 BT B A2 X — i Hh 0 =X A3 3] £ 10T LE 1431
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&L JrreiEER
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IR FEIDEIER
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=
fEIELL W FHER
IR R EERE

3.118 =Fhys 7 At B

EEIRMAERER, YHREERE, RGoasAMmERRE R T, FmEngRety. R4
R H kR O ARG R, ARTENSS RE, A LR E R T R . REEH )
R 7 SR TR, SR TE 3 M T P2 B S8 Allow Smooth Overflows 73, #A)5
i Allow Cliff Edge Overflows 773X, 5 /5i%HL Allow Notch Overflows 77 3.

3.5.3 mfElfA

1T H @[*ﬁ*ﬁﬁlﬂﬁﬁgﬁﬁ%%ﬁﬁé\ Insert»Feature Operation»Face Blend, ZR gt H i
K] 3.119 PR TR ARG HE . Z0HEE IR B P BREARIE T, ThEhn] R EoRIX, HT
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BEARME AR, MR B A NSRS T T RHEHE A )
M.

Face Blend

Selection Steps ——————————————

TR
Filter [ =]

Reverse Mormal |

[T Include Tangenk Faces
[v End Tangent Creerflow
Attachment Method

| Trim & attach all > |

Blend Tvpe ISpherE vI

R adius
R adius Method

Canstant j

[¥ Project @n First Sek

Lt start || LimitEndl |
Talerance IEI. ool
Helm Paint |

[ Confirrm Upon &pply

IE | hppls | Caneel |

3.119 THHSI A X HE
1. Selection Steps GEFELIR)
XEAE FACNIEFE P IR EbR . — BT, RaMBZEdm 2 NP RERR, B] 58 s~k
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M CEHER) MEEA. RAEREELT, AREMBALN 2 MDERER.

)
° First Set (& & —EIAMH)D
ZEAS AT IR BRI A RS — A . B Ebs, P AR SR s R B — AN E AN
TERE— . ERE—INIEE, B TEXYSEBR—RKET k. WRETELMIZTE 5 M
frly, WERBERETTIRAEGEK, 7 LLEHE Reverse Normal &I, K HI71A

FE
° Second Set (B 5 5 A 1HI)

ZEbRH T EBR A AR E A . Az EbR, B R SRR R — AN EE AN
ERE AL EEEATESE, B TEXP2ER—KET L. RETLM T A5 M
PGy, WRAREI T AAEESR, 1 L% Reverse Normal £, K4 H 5 .

° L'::ﬂ Cliff Edges CiEHUEIL)
bR TR . Rz bR, B AR S — AN A AN R kR — K2 KahfE
BEI, A8 A AR SR — AN T AR RN S AN AR L AR D) B BElAL

BRAERT, W R RS — AR b, MR — A LR REIL ;SRR A T AR A AN
&b, WARDI RIS — AR LIBEL . ERAERIER, JFEA—E 2 AR AR EbEL. K
3.120 i Iml 4R 1 BEIL I (T 2] #1 41 o

g 7]
B—E

1EHR FIRED

3.120 HRGE T BEILI T

° H Tangency Control CFHT)$ I B 26D

ZEbRH T IRBA I 2E . Rt ia faw ARSIt 26, CRIFE] A R i AR B A r)
AT, A FESE A AR R & R E . b EIAR LA TE Blend Type (31 A125AY) 1% Sphere
8 Conic BTN A H 2% Bz Elbs, PIIRSFRAEAN L B ih S5 E o Uil th £ .
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2. Blend Type (fE[f257Y)

B AR ET 6B A I TR . KA EE T Sphere (k) . Conic (—{KHHM) . Disc
(A% F1 1soparameter (2554 4 FhsA,

® Sphere (ERH)

ZIE TR B B AR AN T BRIV —ME e PR R ER AR R Sk B 00 P A S AH D) 2R 4T 131
o EFZETE, HEANIGHER AR R RX N EWE 3.119 Frs, H el H Radius Method i
W, RiEdE AR, HPE S Constant ([E5EH4%) . Law Controlled (HRfHHZE) FlI
Tangency Controlled (FHUIHIZE) 3 AMETT.

1) Constant ([fE¥15)

I TR A [ (AR TR . ERFZIEDUS, 7F Radius CERED SCARMEF A KT 0 1Y
HIBME . JER), 6T PUET % Tangency Control AP IRE bR, & VISR ZR, SRZ R [E & 2
%o

2) Law Controlled CHRII &)

VIR TR A I e U 28 J2 th 28— RPN SR, st PR E . ERZIE D, iR
TESCRE I B 2, )5 R R B 2RSSR RE (O 4.3.3 /NI o wlE SN2k, JFdE e ]

RACEAR. IR C 2 e S RN b2k, 5 P 3,120 Ffross (0 G S8R0 2 P 4R AE, P W] A
PO TEMEXS A AR B EAT S, T Z O R 2R . S MR A %2

Face Blend

Change Law Parameker |

Change Taolerance |

[IE: | Bacl | Ca.m:ell

3.121 ZwAH I h 2% 1EAE
3) Tangency Controlled CFHJ )

IR T I T e AR — IR B A b 2R A 80 A T S i T AR AR FR E I h Ze b AH DT . EE
Radiu SCAHEIE K T

® Conic (Kl
IR BB A SRRy it 7 =0, BV Mm AR NG € FPE A B — ok th i, ik

191/454



BT AEA DI TR A o S PZIE s, B 3.119 WHEAHE AR 19 v] 48 o X AR A an i 3.122 AR
e N PSR

First Offsek 0. 25
ICn:nnstant "I
Second OFfset 0. 25

ICn:nnstant - I

Rho

:

Auta

Define Spine String |

3.122 Conic ZETUH AT AR 7R X

1) First Offset (ZF—1{mFZ1E)

R TR B —E L mEE. Er % E N Constant (& E ) F1 Law Controlled (H
HEIU Hh 2z D) AT

2) Second Offset (%5 — W% 1E)

IR TR B 4 LWL E. BRI E N Constant ([& ) A Law Controlled
CHAN ez AT B 3.123 BRIt e B 75— WA ESECN i ki
131 A 1 B 1

— F_mH
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3.123 R R
3) Rho (Rho fH)

kA T E kit s Sk m 2 e, Rho KT 0 H/ANT I, # Rho BT 0, TIEIA
[, BNERE, FRIZSEESGESH 4.3.2 /N IHRIMEINH. R E N Constant
([E €M) . Law Controlled CHIRRI Hh£EF2H1) A1 Auto (HZBN) =F 55,

® Disc (A%

T B AR AR AN IR ALy =0, B s SRR A S 8 AR TR A TR A . I RZIE T,
K 3.119 XPTEHEH L AT AR B OR X AR R —/NME T Define Law CE SCHRNID o JEFRZikTR, D5
e SCHEIN) ph 28X TEAE, P AT AR R E SR AR A

® |soparameter (Z:Z¥)
ZIE T B B AR AN SR . B S Disc BRI AR, B =EEH. CHES
FXTIR A A AL AT (A

3. Include Tangent Faces CfL% BT AHYIIHD

EPEZE I, ik — N WL E 5 AU AR B Sh ik b
4. End Tangent Overflow (& 1EAHI% HD

EPRZIETI, W R GG ERIL R, R EEA KA
5. Attachment Method (% J530)

TR T T A B AS BT AT E 7 . AR Trim&Attach All (fEBY H: [ 2 430X
%) . Trim All UBBIFTEXT4) . Trim Blend (f&89f8]/) . Trim Blend Short (JE{RIfHTHI) « Trim
Blend Long (KARIFHTHI) A1 No Trim (AMEEY) NAMEI. FHIANEE— FIXSAEI L.

® Trim&Attach All ((EBIFEE)
2RI TS B M A FE AR BRI A, AR £ T P A S A R PR 4R b

® TrimAll (f&8Y)

T TAE YR A AEAE PRI 5, (R A AN P B AR PR 4R

® TrimBlend ((ZEI{3IM)
VI IR TS B8 A 1], 5 JH AR JE AR 34 426 T 2 PR ) <1 T F) BIR A1l 32 L o

® Trim Blend Short (45 {34 1)
ZIETE B AN R IL RN S EL, ZEHLRmED AT, FHEE AR ] E s .
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® Trim Blend Long (K:AFI A1)
AR TUE R A IS R IA SN S E L, ZEHAHmEDA e, FEEAmATEK.

® No Trim (MEET)
I T T AME B3R A 1 55 48 e PR ) 1 T A2 B 30 A 1

6. Project On First Set (5235 —TH4E)

ZIETUH T B E BRI R 2. IEFaZIETT, WA kR meE EEGEARDEHIL, &
TE S U PR A ERGE AR VI HI 2K

7. Limit Start (EBIFFAEAL) FI Limit End (fBBIZE T D)

XN IR TR ) FH P T R X TR ME e P, fEIF AR eSS s AME B3] /1. L 7E Attachment
Method & 1% Trim Blend 8% No Trim iEIH, 1ZE A BEE . 25 5E SRR SIFi, @A E
SRR I T8, %k DE, RPN UEAE, el R e e BRI
T -

8. Tolerance (/A%)
V2 SCAHEF 42 (3] A T R B, DA 24 80 A T A — AN T 17 55 — AN TH A% AL B R e B
9. Help Point (FBh D

I T3] A T R TE S e B S A o B B sl 7 W R A AN [ A5 A T B e A
A3 A T B R AE BRI B i — Mo SEFRIZAE TG, 2o R BVEREHE, TR R T AR A T
R — M5 SC—

3.5.4 REMA

EIE@I%%*%%@&E@%%%%% Insert>Feature Operation»Soft Blend, Z%t<x#iHitn
&l 3.124 B EARARTERE . 20 TEAE F bR X2 AT R R B P BR, AT TR E
R4 T R GIE 1, HARIE IR T 150 BB A I 1) 25 I i S 40

AR S TR A R I S 3R A A ) o AN R 2 AR AE T B Ay v i € 181 M 28 B A 3, i
BRI A1 PR W A U1 it 2 AR DAZ B S HOR BUE B AR T4 — T g I HE 32 2k 15
HR)IERFS

1. Selcetion Steps CEFELIE)

XHRAE_EAROVE R R E R, Hpd T ERIEP IR,
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)
° First Set (& & —EIA M)
ZERS AT IR RE A RS — A . Bz Ebs, P g sR sy 4k B — A e 2 AN
TERE— . ERE—NmEE, B TEXYSER—KET k. WRETELMIZTE 5 A
. WG TTIAAEG 2K, A LLEHE Reverse Normal &I, K HI71A

ol
° Second Set (BB 5 Al TH)

bR T IRFR A A AN e dzEbs, P Rk SR A R B — AN E 2 AN
YE R AN

° DH First Tangency Curve (Z5—HIHHZR)
ZEbRH TSR — A LERFRAAYIh L. Bz B@bs, e — A Lkt vy
Mk, A ROV BEIME LS. RIS 25 5 — ST

Second Tangency Curve (Zf —AHUJ#HZE)
Z B TR A HAE LA DI 2k . s bR, RITESE ANIAE Lk R dh e VE N AR D)
MhZk, iz BoaBIMmmAZ. RIMEA AR e 265 58 AN AT,
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2. Smoothness (JGIHTE)

Selection Steps

Filker Al =

Reverse Mormal |

Attachrment Method

|Trim & Attach all |
Smoothness

% Match Tangents

= Makch Curvature
=4 ] IEI. 5

IC-:unstant "I
== IEI. 5

IC-:unstant o I

Define Spine String |

tmtstart || CimitEndl |

Tolerance 1. 001

[~ Confirm Upon Apply

[E: | Applyr | Cancel |

3.124 A3 IEHE

ZIE U T d R @ M AT TR . SEBR b, BB TR BOR AL T 2k m i o ss 2%
AT M 22 e o 1 3.125 P I sl BRI A 728 423 1 P T AR T AR . 1 3E I 7 Match
Tangents (FHYJVLAL) 5 Match Curvature CHIRILHED) 2 AT,
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£ ?I‘EJ]E,:E\

.

N BEISE

N
§ . gzi 3
!I / . /
I| \\\ F_mE
l .
i "
. >
.
E Bk

FEl 3,125 IS E AR R 1 F T BT AR
® Match Tangents (AHYJULED)

TZAR AR A 1 S AR TR AR A DI VT . BERS, AR AR MR B2k, H Rho A1 Skew i T

® Match Curvature CHZRITHED)

12305 T B K FH AR DT UG FE R FH 2R UGHE . LB AT B Rho AT Skew 3X 2 /NI 00 FH ke il 31 /1 1 T
IR

3. Rho (Rho fH)

ZIEWUH T E I Ht s S 52m te, Rho AZIUKT 0 H/NT 1, 35 Rho BT 0, DU {3 [5 T ik
PAH, TR .

4. Skew (RI%)

BOCARHER B R, BRAUKT 0 H/ANT |, 44 Skew HUZIT 0, U5 A i T bR 4230 5 — 1

&, BEEGL T2 . ERZHEHT, AU Rho 5 Skew HIFEHE 3,
iNEtil SRz NI

HEFNTEEA]
5. Define Spine String (& XUH4R)
IR T @ BRI ATE L. mBaZIEI, M E Rt X iE e, R H P Es B ITE
X A e 5 fh 28 B S AR A AR R 26

P 3.126 Flrasimt 2 EAT R AR B B
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F—mE

=154
s
Rt
Sl
o724
AT
S ERE
AR
S

3.126 AR MHERME
3.5.5 EigfA

76 T B B v sl Bk SR A4 Insert> Feature Operation»Edge Chamfer, R4t <xifi
H Wi 3.127 B ER o7 O TEHE .

Double Offset

Offsetdngle

Freeform Single Cffset

Freefarm Double Offset

0K | Baclk | Ca.m:ell

K 3.127 fEIRHA 7 SO EHE
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FEXPIEAE PR A EIRA T2 Bl W IR AR, P R TAR X ik £ 7 22
AL ETRT . BAE 3 H A NEIRHA I S EOSTEHE, SIS EUR, BRS8Nt SLOR REIRL A #R A .
N SRR AT S A T i

1. Single Offset (H.—{W#%)

I TA% 55 1) AR 3 AR HE A P A TR R — MRS (7 2OR G T B (8 M I FZIE T, =5
AN A 3.128 Frosie BRI ML IRHE, BT EEMIN R KU % .

{810 R Itk b ERIA AL . BN, FELKTAEXS, BEREE Kl %S
FRIMIIL, WA IEHE R E — Ak A 7730, ARSI TAEX h ik # & 2 A — 2%
K. GISIHESR AL T DU RN e A g BR 1) 7 5

Mame
[
&l in Face |
Al of Solid |
&ll of Mame |
Edge Chaining |
0K Baclk | Cancel |

] 3.128 B A X HE

® AllinFace (REFHIFTAIL)
VI TR W T B SRR, AR R T AR NI A BIh . ERRZIETSE, Nt — AN
FIEROUERE, HAEE T U = AN ED,

1) All Adjacent to Face (T tHAIZRTH)

I Tk — 3R, 5 LA A A
2) Allin Body (SEAAHFTA R

G T ik PSR Th I BT 3R IH

3) Allof Name (7€ & FRIRTE)

BT T FR9R € 2RI A R
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® Allof Solid (A& T2
ZIETUE L R FESLAR, SRR A L B .

® Allof Name (JBEXFRHIFTH L)
ZARTUEL TR B AR, PR AU AR A R

® Edge Chaining (BE#:14)
IR TEH— %G, WS MG ik .

SER T B RS, # i 3.129 Fron A S — RS BON . 7R SCAHE S
BN IR wAL A, BIAT 5 i — a7 T fay SR (Bl f i g e IR, SR B3 3.127 B (R
T A TEAE . 18] 3.130 Fos st 2 B — e 7 s 28U R .

vl
30 \ itz
: Fm1
e
| eIl
DFfsek 0. 25
0OE Barle | Cancel

K 3.129 H—{mfs S B EAE K 3.130 ¥ {mE S

2. Double Offset (XUfif%)

I T 5 8 AL AR R B T 20 55 R A R R A AR K 5 2OR B fag B0 (8 o PR oh ik o, 3
P AL GAIHE, P LR EEMN 2 5UE, KA 3.131 Fos A WUR
SEOHAE, ESCAME R AN ISR, R SE0UAS 75 20 e SR B o G . [, SR (]
F P& 4.227 IR T X TERE. B 3.132 BRI WU A% 77 & S HU EDR .

200/ 454



Chamfer

First Cffset IEI. 25

Second Cffset IEI. 25
0K Back | Cancel |
3.131 XU S HO G HE Kl 3.132 XU S4L

SO AR A T AN T T R, TR R ] 3.127 XFIEHE ) Flip Last Chamfer (f#%
BJE D I SR RGEOREI A 5

3. Offset Angle (R fMA/E)

IR — A AR AN — AN R e T BB A I MRS A . i I, 2 3 I 3] A ot
TEHE, F P REfR ZEM M — ki 5500 )5, SRl 3.133 P A mF2 48 5 A1 E S Hon 1k
HE o FESCASHE 73 Bl N IEBUR A S A A LA, BIVRT 58 e 5 2 7 2 ] S 3 4 O 1 2
Offset SUAHER] THINIE—/NH LAIRAME, Angle SCANER THINIERI AR, TR AG—AN T
TR, 18] 3.134 From (Rt ks M 27 S5 R

1

BB

Hipriot=iEd
i

0K Back | Cancel
3.133 W i1 £ S B IEAE K 3.134 W AESH

4. Freeform Single Offset ( H ¥ —1fWf%)

ZIETY Single Offset FETl—#F, 372 3% 5181 A A E P AN TR FH R — Mm A2 48 7 a1 22 431
o (BHARFAEN A XA—FE, Single Offset 1 RFLAE, & MNIEPELHTARFL M S 1T; T
Freeform Single Offset " RFZME, NIZF8SLARE MR MM IS . 28 fRIIRE 240,

201/454



Freeform Single Offset 4 /& AI FEFK), T Single Offset A4E /2 AN AT HAM . %3/ 7 REERIES
Single Offset EIAH A . P& 3.135 Fronih /& B B — Wi 7 K& SHIER.

e £ i 2

K 3.135 HEHF—WESH

5. Freeform Double Offset ( [ FHXUF%)

1ZIE T Double Offset MEIT—FF, 2 4% 51810 A8E 18 AN TH 73531 K FH A Rl A A8 =X A 8 131
o HILRBAEM S A —FE, Double Offset H1 AL, & MIERELHARELI M ET; 1M
Freeform Single Offset " IMWASAE, W &da LB AR M KRR . YEIMR IR E R0,
Freeform Double Offset 4 & R SEf¢), 1 Double Offset [{45 AT TR . %8 07 NElE S
Double Offset #EIAHF . Kl 3.136 Frnisi 2 B XU 7 X5 S8 ER .

K 3.136 HHXURESH
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3.5.6 &

7T B &AL h s R PS4 4 Insert> Feature Operation»Hollow, £ 4t H 1 /&
3.137 Fis IS0 TEHE o

SR B EAR X e e et E SRR 50 0%, TR T ot B E S 8. 5
EM TR A, BWEMNKHERSE, FHEOWE KD BRI SE SR e . i/l — T
TS TEHE 1 & 1B I TV

1. Type (FEFEIEM)

ST TR 1 L Oy e R B b ot Hrp s 7 =R SR .

Faces (ZFFERATHT)
TR B PRI SRR, IFHZHRE N SR HEAT e . Stk BT
By ey i, e 3Rl i i e 8% R B AN A (R BE JE

S EN BRI e AT AT SRR, Hrh adE 7 2 MRED IR, g ERm A
ERImEE ROV ERIREA AR

1) Pierced Face CIEFRZFHRM)

SRR T B e RN M E R . Rz E, W ESHR iR s A
T B IERRIE . PkRIEEIZ T E 28
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&)

Filker I,: are j

Preview Hegion |

Default Thickness IEI. 1
alkernate Thickness IEI. 1

Hollow Tolerance I 0.0010

Show Failure Data |

[~ Confirm Upon &pply

[E: | Applyr | Cancel |

K 3.137 SR UEHE

2y Bl Oftset Face (& TR

SRR E R H T AT R e A REEE . i EbR/5, Altemate Thickness (A A5
&) SURMERGT . SeEiZ A NE R M N ZRIBEJS, PRJEAESeiR ke — MR &R, NPk
RMEAEE SR 5k DR B 1R VEE I . FHZRIFER A, rOA e R IR E AR BT . PrHRE i)
AN [FIBE JF AR T M HL R LA 2 Mo AE SRR T, &R T 1 J5 W] AR 7 B AT 2 2L B A
FESAEFIRME L P TR BB W B A,  FHAE Alternate Thickness SCACHE Hig AT i) JE FEE RN AT

P 3.138 Jlras i mit A2 B A AR5 2UREAT W e R AR B B 11
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ZRE R E 504,
FiERE EREREALGHE

7

C FC :
N Jo
ye Tl e[ T
HEFERE W EEREMFEREE

.
-
—
-

ol e I
| o
! _-F
L= Y6 ~
C h\ /

R E

A

3.138 HFIERME R

FERRFREER, SRR T F ik b, JFH, AREAZTERE LT, W
RRGEF BRI, WA E R NEEE ), HLEEEAEN Default Thickness (AT ) 3L
AHEH B E IMHE

° @'Region CEFE X0

SRR T B SEAR SRR IR 3248 R 1T 5 T R A P X ORI SEAR BEAT W e . B
MBI SEAR LT 45, W SLRREAT#7e, H BT E ML 5wk,

R TSI ARI, RO R R AR A, AN T = MR IR R
BRI f8E AR R M2

®

o R bR TR R e R . iz B be)a, ISR Bk el AR E i
SERM e X SLAREATHTEN , T FeR 5 B30 F i 2 18] 1 SQIPR LR AT 5
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2) Bound Face (F8ELFEMH)

PR T R . Rz EbR R, ATESHR Bk AN E AR N AR
T, 305 R AEARAE I AR 52

3) | Offset Face (HE K RFs(H)

P BREAR O iR R g AN R EE R, HAE R AR B R i e e . 2P BRI AR
AT o

B 3.139 Jras w2 B AR Al 5 2UEEAT FE e R AR 1 B 1

SRR EE
o : ¥C i
LI J
e~ T~ ye | -
<&/ (—/C -
%ﬁ%ﬁ?ﬁhﬁ\xfffff}
S EEE SRR EE
ZC
QY’C
XC
RS

K] 3.139 55X 15

Body (H#FE3LAAK)
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G SERMA T EIARRI, MR TE E 1) JE X SR BT 58, R sk, e iRiEnt
R I A A D A AR R E AN F B )R

AT TSR BRI, RO R EAR R A R AR, AN T MR D IR BESE
PRI E R WA -

(D)

(7

Solid Body

ZB IR P h. BZERE, TR TR X ik S

2)

Offset Face

2P BRI T O P R i 48 E AN R R BE IR o AR 07 ¥k (R 5 38 SEAR SR T 5
K 3.140 Hrom Bl 2 N IR 7 AT e R 1 B 41

|
|
|
|
|
|
|
|
|
| |
do R
. e T

K 3.140 V#5ESEiE
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2. Preview Region (Fil'%[X )

PRI T E SO X, A ik $E | Region A Ebr, JF Qs /e RmALL 7
RMJe, ZEIUA BT SR PEZIET, € T X UL R

3. Default Thickness (45 HJE )
ZCAHEH T B B BN, B RN A e,
4. Alternate Thickness (TJARJERE)

ZOCAHE A R FE Offset Face A BRIEIFRIN A e, &M T W ELAE e (R I pir ide % i 14 B
JF o HZSCANERGE JE, AT, (RO R i (BT

FEZSCAHEF AN LA, MZ AR e L N7 BIRAE . R P 2B SO e, R
P TE T EEUN EEEE, FITE Alternate Thickness SCASHE H iy A BT (1 J5 S (BRI AT

TEVZSCARER N RS G, MRZAEW R NRE e i B R i R . N R T IER] f7, (2
HAXHE LK T Hollow Tolerance {H, S MPKE 8. an R4 N EEEAE N IE, ) Bvide 28 1 1) PN fh
IR RN ERAE N7, WFTERE R I/Mee 1 e 1 EEE .

5. Show Failure Data CS@7~2 &)
IR T BoR 5 iR R R R v RESR I, 2R TR E R B 150 A
3.5.7 B

T2 5if 7 AE e i R R T N TR SURHE EI&%%*%HEEEE:@%§$Q/%
Insert>Feature Operation»Thread, RA <5 H WK 3.141 s RSO EHE

208 /454



Thread Type
’VF Symbolic T Detaied

MMajor; diameter
MMimor diameter:
Pitch

Angle

(Zalout

T

Tapped Crill Size
MEthDd Cuk -

Form Unified

Mumber of Starts

[~ Tapered

[~ Full Thread

11

Length

[T Manual Inpuk

Choose fram Table

[T Include Instances

—Raokation
{* Right Hand
" Left Hand

Seleck Stark

[E mpply | Cancel |

K 3.141 MBS EHE

R e GRS e BOR FRIRSCR T, B B TAFIX APk #R QIR S sk . R EIR
LU, B F TIRE SRS, B NRES IR PIERRIRSSH . SRS HRE)E,
RGUMNAE TP SRR B EVEIREC. R4 — T IRSUW T HE h & 1B I Bk T

1. Thread Type (BZEZ(EAY)
ZIRTHH THa e 2 a2k A, Hd4dE 7 Symbolic #1 Detailed P51

® Symbolic (fF5IEZ0)
IR T AT SI88. fFSIRAHBLRRN, HARRIEEEHE, £ TRER-FTHTRR
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BRAUNBREIREL . XAMRSUE T AP AE 5 S 1 A RIR SR, PRI SRS e R, — iRl

BRAUI AL £ %R

® Detailed (FE4HIRZ)
ZAETUH T 0@ FEARLL . X TSR (1 h

SURRIPR N SE, Bl T IX MRS LR R

2k, AN SR KR B A . EREIZR I, RSO TEREAR SN 18] 3.142 PR B, fEH P

LB B ARSI A RS

"Thread Type

" Symbolic

MMajar diameter

Minor diameker

Length
Pitch

angle

—FRaokation

" Left Hand

% Right Hand

Select Start

0K

Apply | Cancel |

FAARRGNT G R R A R T D A2 T

3.142 FEAMESHEHE

[P A HMREC: A R FE  AE Oy AR, A AR

o T34, AP SIREUARERET RGBS, H AR AL 2 kB, B AR S IRguis o, [
BB, MBS, AFSIRSOFA SRR EARRSCAT LU AT E i 8RS, H SRR
HEmSE AR, TR ARSI E O, 53— X A= B

2. Major Diameter (BRZUKAE)

ZOCAHER T I EIRSURAR, AR GME R AR E R 2 10 [ A T AR AT A MR AU IR, BIRSS

RIS N TR58a;, HAER Manual |

nput JET, Major Diameter FIEANGEZ . X T ¢

ANIREL, HMEL] Major Diameter FI{EAREE . K 3.143 PRl RIS ESEIMEIR .
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K

T
u1a‘ — L l
TR /]
b |
I 4255 |

-
41= iIFE=tan (FRIAE)
2

K 3.143 IREF B
3. Minor Diameter (B240/N3)

ZOUARER T BIRAUME, HA GE R G300 B A 0 BEAR A N AMESU TR, EIRASHEER
3. XTFRF5I8Ea, AR Manual Input &£}, Minor Diameter F{EANBEIE . KT 1E4HIRS, W
P24 ) Minor Diameter F{E A EE L

4. Pitch (BZFH)

OCAKE R TR BIERE, HA SR G B B SR SRS . X TR 51840 44
HEHX Manual Input ZETHRS, Pitch FIE AN GEIEEL

5. Angle CFHUA)D
OCAKE ] TR BIELCT S, HATENIRSIARHEME 60 BE. XT TR 5840, A IEEL
Manual Input &I, Angle FIEAREIEEL

6. Callout (REZFR1C)

ZOCAHER TARICIRAL, HA SMEMRE LB A [ IR S HER IS . 40 M10_X_0.75. ik
HY Manual Input IR, 1% CAHEAREIZ M

7. Shaft Size/Tapped Drill Size (MEZCHHELFL A R ~F)

ZSCAHER T B AMESU I RSB RSO B FLRSE, B8 80 4 SURSE, HASER
PRIR B B A I IR S HEREUS . BIESMRASUT 2 B B Shaft Size FR1RAF, A2 N BRSUET 2 H 1
Tapped Drill Size FRIR o
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8. Method (INT. 7770
ZIE T T8 ER S in Lok, HPhas cut (FI2Z0 | Rolled (GRIZLL) , Ground (BEIZ
40 Milled (BERRSD 4 ANIETT,

9. Form (HMRAZUHR#E)

ZIET T8 E 8L brvE . Hoh 5 Unified (48—1840 . Metric (AHIIRZD
Trapezoidal (BEFEHRL0) . Acme (ZEHIMEZL) | Stub Acme CHHEEZEHIIZS) . Lowenherz (Al
PRS0 . Buttress (HEUGIRZD) . Spark Plug CKAEZERESD) « NPT (hnifEHEEIES0) . Hose Coupling

(CFREBLATIZEE) F Fire Hose (VEBTHEZSKIRS0 45 11 Fibr#E. 4IEHL Manual Input JETIRT, 1%k
TANGE B 24 o

10. Number of Starts (#2403L%0
GOCAHE T3 B ARG SL3,  BIA G B Sk MR AUA 2 22 ShIB AL
11. Tapered (4EFE)

ZIETUH T B B MREUE 5 R IEIRAL

12. Full Thread (2404

ZIEIE AR AL LA IRS. AURAIRIZE RN, MRS Length i HIEUE B IR
AR SRS, R8s B3 R

13. Length (BRZCKJE)
OCANER T W E MBS, A SMEAR PR B A [ A RS S AR IS . AU RN
PATHERER 7R, MOECGATH (Select Start) HEATINE .

14. Manual Input (FTHiA\)

LI T 15 B T T NI SR A SO 2 MIRSUH R AE R BOR S, Bz, N
WRSLS SHOCANEHR AT A T804, T Callout A1 Choose from Type £ K i

15. Choose from Table (MF1FFikED

ZIEIUH T MRS FZHE P L BURSIS L, 2RSS H | RME A R4 ZR AT e . ek
ZIHIN, 2PN 3.144 FrosiRSS BONERNE, F AT DR Ak BT 75 AOEREC.
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Z_1j4-4_1)Z_UMC -
Z_1/2-4_UNC
2 Sfd4-4_UNC

0K Bacle | Ca.m:ell

3.144 2L BHH|FAHE
16. Include Instances (fL27[5E%1)

ZIE U T OUBIREES . EBOZIET, i 1 FESIRE R I — A, WRZ RS R
J ARG A R AR AL

17. Rotation (ig#s /7=

ZAE T2 T B AR S e 77, HpfE Right Hand (A IEERS0) T Left Hand (/2 Jighs
80 2 ANk,

18. Select Start GEFFIRSGEELBTE)

BT T 48 € — AN S T s e T O B MRS AR AR AL B . R S48 ok B A 1 S T 1R
IRSUIIGAI B . 2 RGANRE B SRS R Ia A BN, IR FZIE G E SRS A B .
WPZILIN, 2 GORBOMAGHE, L PR IR T . B3 1 SRR B HE 1T 1 VIR
I B, 2R 3.145 FrosfIXimE, i BRI B R YR, IF ] R IRAUN A
T T o

Reverse Thread Axis |

Stark Conditions

Exkend Thru Skark j

(1] Bacl | Ca.m:ell

K 3.145 RO AT X EHE

ZXTTEHEH 1) Reverse Thtead Axis (S 3 BRSUAE A7 7)) 8 100 150 24 BT MRS 7] J% 8 [ 7]
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Start Conditions (ZJMELHTHD EIH T & B2 GHITIEsumd . Hhas TN e &5 7

Extend Thru Start (¥ AR 1EDL, GRS, LIRS EAE; 1EFE T Do Not Extend (AN
PG EI, GBS, IS A SR . B 3.146 B B IX PR T A0 RS
17 Bl 1]

— WELERIGE

%W Extend Thru Start
_M Do Mot Extend

K 3.146 290 IATH X B R S5 0A

3.5.8 [

& TR EFp= s Bk SR A4 Insert» Feature Operation»Instance Feature, £ 4i4:
5 A 3.147 B IBES 7 AOIEHE

Instance

Rectangular Array

Circular Array

Mirrar Body

Mirrar Feature

(1]:4 Bacl | Ca.m:ell

3.147 55 AAHEHE

FERPGHE R — PRS0 TT 30, AR AR I PR SRS TRHE T, g 7R BN A AR, IR
B S MRS SHOSTEHE, W AR SE R AT 58 BAFAE ARSI BRAE . T4 — T & RS0 7 A R A
.

1. Recangular Array (FEFZFEFI)
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277 3 T BB RE S B8 2R R A P SR RFAE, 51007 AL RE S5 RRFIE R . (1T
HXHNHO 5.

WFAZIEI, A 3.148 PR FEFEFVRFER 1EHE . FEXTIEHE Tt £ 75 2R RS AE A4
B E AR W AR X P Ail. SBBURF ARG, A48 S0 AN 3.149 Pl ANFE TR 551 2 500
ERCa & WAV AT RIS /= P I DN v | e sV 7 P N T £ Rl A SV A ST B0
TEHE B 38 T (1 I

Filker |ﬂ
)
CYLINDERL3) -
Method
{* General
" Simple
" Identical
Mumber Along #C |2
nC Offsek |1
Mumber &long ¥ |2
¥ Offsek |1
E Back | Cancel 0K Back | Cancel |
(5] 3.148 1 FEREFIRFAEXT 1 AE K] 3.149 FIEFEF SHCHIEHE

® General (—#J7=0)

ZIR T T PA— 077 AORFEF IR . BT Hah B BT A RIS J VA, 5% B i LT
PEHAT BVENESIE, U AERS,  FESI TG FE o] DB R AR SR R TR [, H R &1 AT DURI— 3R 1H]
HTAARAE, AT LA —ANH 5F %8 3 55 — AN

® Simple (%7770
ZIE T T LA 55 107 sORBESR-IE o 1Z0E R 7 NS General SETUAHZEAL, (HAATH
RS UE AR LR, DR B R

® |dentical (FHIFJ7=0)

IR T T LAAH R 77 SORFESIRHAIE o G IAPAT /RIS B, e R AT ge/b (A iE RS IE
T, B IR R AR RE A BT TR o DRI A AN B 1 1) 18 53 2 SR AR R AR Y — AN KSR I B . AE
FEFIRFIEE 2, DAACRERE E AT 58 AR R B RS 00 P F ke Tt X Fh 7 068l fE etk . & 3.150
B B X =5 AT HOR FE S ) 7
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K 3.150 =M RES 7R

® Number Along XC () F1 Number Along YC ()
X 2 ANSCAHE S 3 T B B B BIHFEAE XC 5 YC J7 1) B &4

® XC Offset 5 YC Offset;

X 2 ANSCRHES A T B FEFVRHERT XC 5 YC 7t fa e, AR AN — N 2 R AR )

AR s DR 1 o

R — Al AR IEREAT AR R 81, R SURFIEAR Oy FARFAE, A 15 2 RFE AR Fs:
PRI TE e HFRRAEB] S0 B DA 5 R B3 22 TR SR AR ELORHR A, #IOR e — A H ARRFALE B0 5 1
SHEATIIR R, WS IELEES A T A B AR AR, CEREAIRAERT, AU OREE 515 1 B

A R AR S HARRFAEITE (SRl . 18] 3.151 Fros i st 5 T RE 51 i 51

Mumber Along ©iC |3—
KT Offset [o.76
Mumber Along ¥iC |£1—
Y Offset [toa

2. Circular Array CGATEFEF))

1.l]l]‘ O O O
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525|000
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275 3 T BAAIE RS B0 2R A P (O SR RFAE 2 FE 51 7 2CAR IR 510 £ ol ot Bl 54 o

.

WEFZIEI, WA A 3.148 Fro G R SIRHEXT AR . AEXT T AR rP s fE AL, BB

FEL: B AR IX AP AL

Bt 55 P 3.152 Fos S ASERES S B EHE, £ B E RS0

NN SHUG, RGRIA] P TR BIRHIE -

Instance
Method
{* Gereral
" Simple
" Identical ——
Mumber |2 Paoint Direction i
angle IQD Datum Axis |
0K Back | E:a.nu:ell 0K Back | Cva.ncell

K 3.152 IRTEREH| S HOTEHE E 3.153 JiE i HhRd UG AE

IR SIS HOSIEHE S Method JETH 1) = FPFE 817 35 FE TR FR A A B IR ] . Number 52
AHEF T B I A _E IR AR . Angle STAHE R 1 &L IR A 75 17 B HIRFALE 2 18] ) AR BE

WE RIS S )G, KFGmB i 3.153 s iefe e ii i, & E8H T8 XHE
%) e s b ) e B 7 e W SR HL Point_Direction (RN R &I, wHF|H R EAIEDIHER € X
ek s, FECL S AT T RE e Ui A B . W R HL Datum Axis CGEHERH) &I, B HE
HU SR vkl , AF ATefeih. B 3.154 T~ st 2 S I BE 51 i 4] o

FiTi&f) B ik

e m v B

Mumber

iy ==
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Angle
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3. Mirror Body CEif%s2k)

207 T DAEHET R GR i i seid,  HBL8 R 1 SR B (AN S SR Bl R A AR R B8k, (H
HAR B AT T i R S 2

WEFEAZIET, 23 N RIEBONEAE, 7R B AR X e e BRI SR Jm, Xtk
FEBLBEME T TN UEHE, AR e AN IEUE T AR GE 2R T i) SR AR 48 58 1 HET- T
PR ANGHR ISR . B 3.155 PR a2 B AR LA E ]

S _ il
N\ | /FRSRpE

K 3.155 gLk

4. Mirror Feature CEE{%451E)

277 300 T DU AE P IR B AR T (R SEAR h O SRS AR . B BT, o i an ] 3.156 Pos
RIS TEHE . H LAy PO BRI, T AOVRHME IR, WESIETE, ERHEGRN
FAAE, FFFREBBTE, ARG R FrERFIEA TR B P TSR . P NG HE
H S TR

° g Feature to Mirror CEAAZ4FIE)

Z bR TR SR P R E R RE . SRz EIbr, AIEZ ] TAEX b BRI 3 7R 245
BEVRHIE, P Ess B I BI SR RHE S ZRAE S . T E SRR SR, B TR RN
FHIE AR, ﬁ%ﬁ@ﬁﬂ, W PTG RE A IR SRR R AE T . RiE T HRHIE, AIESTREFE
FIRMES, W ffiRIE RFHELA R, ﬁ%il, FHINBARFHE SRR R 20 P AT DOk £k B
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AN EEAFHENE A BAR IR . AH 5200 DR BUS (BT RHE ER e 5 12 5 A fid

° %Mirror Plane C(Eif% FI)
bR TG P E. diZEbr, TR B LR X Ak 85— AN SR e T 1 B se AR P AR A
B8 T

Mirror Feature

|:Selecti|:|n Steps J

[T Add Dependencies

Filkey I* [ allin Body

Features in Park Features in Mirrar

TAPER(1)

HOLLOW(2)
CYLINDER(3)
SYMBOLIC_THREAD(4)

4
T

[IE | Apply EBaclk Cancel

3.156 BEEAFEXTEHE

® Add Dependencies (FfhnT4#4E)
TERUZEIT, WAEIRBBARRFIE G, 2R E T B & R e B R B R IE -

® Allin Body (SR 4H4E)
BREUZIET, W) R GOk B SR o 1 T R E N B AR AR

® Feature to Mirror (ERAZ4FMESRAE)
BHGRHIESZRAE A T B P 2k — LB G R IE

® Feature in Parts (ARSI FRAE)
HRAERFAEF ZRAE T 7 24 iS4 A i 3 A I 9 2% AR R ALE
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P 3.157 Fhras i)t 2 B BRFAIE ) L 451

A& R AL

RRTRIRHE

K 3.157 SR UFE

3.5.9 SC{FROEET

Eiﬁlglﬁﬁqﬂﬁﬂgyﬁjﬁﬁﬁﬁﬁé Insert»Feature Operation»Trim, %4t 3nt 4 B
XPUEME, LEF P AR TR EAE BT A sEfk . R B TAEX e B R BB B R seik G, Xt anl&] 3.158
Frs ) AE B T X TEHE, 1EA P38 e B8 . BB BT, BEnT B2 B TAEIX Fhak £ ek
FE  FEVHESF I BN A N BT, AT AE B 3.158 KHEHE ke BT ik, e B
BUTH o 2P UEHERP R4 T HMZ BT A € X J730: Define Plane (€ X °FIfi) . Define Cylinder (&
N A « Define Sphere (5& XFKIf) . Define Cone (5 XIFAETH ) Al Define Torus (i€ Y [RIFR
) .
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Define Plane

Define Cylinder

Define Sphere

Trim Body

Define Cone Accept Default Direction |

Cefine Torus Reverse Default Direckion

O EBacl Cancel 0E Back | Ca.ncell
P 3.158 & SAZBYTHI X IEHE K 3.159 %% A SHEHE

TR BT e, o tunE 3.159 PR iEBaE X iEHE, R EBEm FRRtgiik, £
AEBHNER . FrdiER, RIREEmAER, BRE HinRL B Rtk 2 ke, Rk
IR PR A SRR DB, AR ST 1) A SEAR B 70 PR B o Z5#% Accept Default Direction &7,
DIBRIE M FITHR (SR 343, U i% 4% Reverse Defaut Direction ST, M ik a1 77 i), DIBRAH &
TSR 1B 3.160 Frn (1t A2 BY ik R AN R BEAT B BT R AR 10 45 2R

i EId AR

&
) |
Ry

AT BB H R

&

R,
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K 3.160 AS[EME BTV A H 45 3
3.5.10 SRR E

15 T BB brksp e BE RS L4 Insert > Feature Operation»Split, R 4t2 5 H SEAR 4y

B L IRE, SR IZIRIER N ITA IR PR L 28 #E ERISHR )R, S U RO
TEAE, 1R IR R RISk . $E ot & 3.158 B 5E o BITRHEAE . 4% B A 2810 5E X
EBY I A5 2R SCoTHIED, A AT 58 ey F SEAR 3R

SEMFISERERIEIR, W MEEE, SRR ECIER. 20 FISEOR 1 T BE N TR
o PUASERZEG, SR S 8a it %, AT S8gniE, RN TR bR E b
BEEBEER,

3.5.11 HAESEH

X HLA DURFAE A AN SRS BRAEVE B AR, [R5 S 4R SEAR AR rp R TR AL IR AT IO PR AR L A
1. RAERAE

£ 3.5.1 NP EATCA T T RS ERAR SR 535, AEIX A B AR B B T AT 38 1 5%
TP SE AR A o

1) 75 L HERR qjﬁﬂi@ﬁiﬁﬁ%ﬁﬁé\ Insert»Feature Operation» Taper, 7E# H 1 SEAAR PR AR X

iﬁlitljiz*'é%@liﬁiiﬁ o IXIFFERRAT D PRIE I L HUR — MR IR » FFREF I B AN R T A IR

I -
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Filker

Angle IlD

¥ Isocline ) Draft |

[~ Taper &ll Instances

Preview Faces ta Taper: I

TEE
TR

Reverse Draw Direckion I

Distance Tolerance ID. ool
Angle Tolerance ID. 7]

[~ Confirrm Upan Spply

OE | Apply | Cancell

2) FHEIRAED BRIk R — R D IR I HEA2 R GLHRE I FARAE T 1A -
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Selection Steps
e
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Yector Method //

angle IlD

|(;" Isocline €7 Draft |

[~ Taper &l Instances

Previevs Faces to Taper | E éﬁ?ﬁ'ﬁ E‘:]
| Reverse Draw Direckion i ‘j’z?{ﬁj‘j’ ﬁ
Distarce Tolerance W
Anale Tolerance F

[ Confirm Upan Apply

0K | Apply | Ca.m:ell

3) FESRIE S BRI P RIS = MR (E 5 g T #Eﬂﬂ%i%&ﬁ‘]ﬁﬁﬂ@iﬁlﬁ%ﬁﬁﬂﬂgﬁﬁ,
FEEAR R SNA T B E —ANS % . A SLARBREIEREH 1) Angle X IEHEFHIA 10,
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Taper

® @l

"Selection Steps

Paint Method {:} ﬂ

Angle 10

(% Isocline {7 Draft |
[~ Taper All Instances

Preyiew Faces bo Taper | wEREEA
= e
|

Reverse Draw Direction

Distance Tolerance ID. oo
anale Tolerance IEI. 5|

[~ Canfirm Upon spply

0K I Apply | Cancel |
4) TR ITAERIBRCE G, 1RSSR BAETEHE il OK #4241, RS MR E S H B R ARARHE -

HAERE

2. FESIERAE

£ 3.5.8 /NI IATEA A TRALFESIERAE IS I5E, XA TEBI R T 51 1 Aok R
PR UL B BEAT AR AL R A A A AR o 3K L FRATTAR S0 T i T 81 2 ) SRR S
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1) T EER qﬂﬁﬂ}ﬁjﬁﬁ%ﬁﬁﬁié\ Insert»Feature Operation» Instance Feature, £ H )
FEZ1 77 O TERE & L Circular Array 773 . 7B /5 3 H IR B 1 RRAE 8 EDOGH 16 AE e £ 1 R AME (1 Hp11E
EXTRUDED(3) (RP[EIF ERIFLAFE) 1E TR EREFIFFRE, H 5 OK %4,

Rectangular Array ,,-""I

Circular Array i

Mirror Body I

ERUFLFFEE A
% 22 PSR HFE

0K I Back | Cancell

2) AT SHOEHEY, BWEMIEFESDY General 7730, IFAE Number SXAMEHHA 6, 7E

= Simple
" Identical
Hurmber i Iﬁ q
Point Direckion |
angle &0 -
Daturn Axis I
0K Bacl | Cance
0K Back | Cancel

3) WFF T eE RIS, KU REE SO IEHE, R Pk “‘¢\L|7iiﬁ IHESE K SORHEH
N 1, HAONRGEGRE, BBE 7+Z2C Jr RO, Al OK 1%l H55 2 malg
XIEHE, AL Reset Yo, BIBLE 7 AMKRIR MRS s, iy OK 4%
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Yector Construckor

EdgeCurve \ego) ES&E"‘]E@
ALNA s

Ly
ol LSS

== ———t_— s Point Constructor

Inferred Paint

7. H =+ 2|3 4
I 0.0t @l 2‘
1 0. o[ Base Point
K % X [0. booooo0000
¢ Cartesian " Spherical e ID' 1000000000
zc [0, oonooooooo
ShovaEdit Constraints |(;' s o i |
Cyele Yector Direction
Edit Weckar Crigin o Nﬁ :Iv '\Lﬁﬁ E"‘]
Reset | :ﬁﬁg‘&g‘ )f_fﬁ

0K I Back | Cancel

OE I Back | Ca.ncell

4) THIE T ERATT AR fS, ST R EXE, R IR Yes eI, W R GEH 2 12
BB IS B2 T SURFIE R FE SRR o

Create instances.

3.6 ZMHRHIE

AR R ISR IE S5, R IE AR SF . REBDRRAE R AE FE 3 HE R0 B3 0 5 G AR 1
3.6.1 HEBFHESH

1E T B Eprf iy @ oL PESE B A4 Edit> Feature)® Parameters, Rt W& 3.161 T
TN G AR AIE 2 B VA HE o
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Edit Paramekers

Filker |ﬂ

BLOCK(D)

TAPER(1)

HOLLOW2)
CYLINDER()
SYMBOLIC_THREAD(4)
FIXED_DATUM_PLANE(S)
FIXED_DATUM_PLANE(S)
FIXED_DATUM_PLANE(7)
MIRROR_SET(S)

(1]:4 Apply | Cancel |

3.161 YRABHFIESEOTEHE

MR FE TR E RSB RAERS,  BERTE 2 B AR X s BB A 20N RE, tBATE 1%
SHEHE (FIRFE 1) RAE PO B B n 4 SR RHIE A FR . ERRRHIESS . S8 g S EOHIERE, RN 7E
2B AR A s I ) M S8, BOEBRFE RN, 58 i gn S EO AR At A —
B HTRAEMRISIR S, 1 H AR Z 0 1A K 2 805 G 2R R HEAR ], T B
B A —— N AR RS HEHE 1.

AR G B B A A XS TEME IR AU, DRSS AR E S B W 5 BB LT N 4. BN e e
RIS A AR ISR ARSI S B R (R AR O RS SR TR A 2 R
B ERIESHEE.

1. Gt BSEARF LS AL

XTI — BCSEARRF AL R TR AL . RIS T B SURFIESE, eI i AR 24
XHEAESREL, GNP 3.162 ffrac. X F2REERpIE, H AR S HO U HE ol e A i) 1 el 2 ik
Blo R 2H— N R AER &L T i
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Edit Parameters

Feature Dialog |

Reattach |

Change Type |

(1] Bacl | Ca.m:ell

Kl 3.162 Gl SBSRAARRE S HO T HE

® Feature Dialog (HFAIEXTTEAHE)
ZIR T T I RE AFE S H . B FZET, RGO 8 Prade REAE I R 6E B SO0 T HE,,
B TR E S S EE RN .

® Reattach (EHIE)

ZIE U T E ¥R 2 BT R G P . BlanfE— AN RS S, A Ak B 5 —
AR B2 EPZED, S 505 BRI EB S XTEE (W 5.2.3 /N1 o TEIZSTIEHE
W, AR BERRAE RN, TR AR D SR AR AR A S S - TR 5.2.3 NTHEENHT
T TEAE A IR U AL, RN R0 B B R PR IR, T AR I Dh g A Ad F 7324 2
—FEM . NN — R A B A B LRI

Specify First Thru Face ($5 25— % i&/M& 84 )

LT T T R AR EEOET E SR — N B T BB B . A PR BAT 57328 T s A2 BY T
S A S, W PUBSLRFAE . SEAERRAE . R P T [A)RLAR BN T KRR IS S 2 bR A RN
e

LT T o0 T R AR ST € SR AN B I BB BT . AR I BRI B AT P 5 T A B
1] iNREALE AR SCIP Pui VG el i 5 AN S R T I E A G W i 2 AR A D RS (TR I AL v = A VA

Specify Second Thru Face (¥ %5 % & /ME81H])

i
3) % Specify Tool Placement Face (f&5& L H )
IR U TR BT IE B P B s SCRAIE B FE TR

® Chang Type (ZtAz2#)
IR T T O T R AR Y . IR BRI, R G5 H I BT e RFAE B (156 S ARFAE S 2850 13
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HE, EFERT EASEAY, TR IE A SRR A B SR . I U AT AE PITIERFAE N Holes BX Slots
B S RHE RS A 3

2. G LS AL

X TR RS TR RAE . R RS UL AL . R R E B AT R S
FHMRF IR 2k B IR G, B RE 2 SR SRR R IE S HOR R . G AL
RAERS, AR S HONEHESREL, 18] 3.163 P . 2 GHEARYE TR AL I AN F] 22 Bos AR Y
I, X RLERAE, HA S B AE AT e A A P LRI, N 2 TR E A 0
HR)SERFAS

Edit Parameters

Feature Parameters

Edit Tolerances

Edit Direction

Edit Defining String

Replace Defining String

|
I
|
Edit Curve |
|
|
Reattach |

0K Baclk | Ca.m:ell

K 3.163 B MIRHIE S O HE

® Feature Parameters (JFESHD

ZIETH T YnfE TR S E A E S 8. S PZIE T, Ko B S EOHEHE, ZHEHE SR T 61 g
ZRFIER IS BOTIEHE, 7EXTIEHE RS SO M AFAES BRI AT, W T R 40 8 2 I S 80T 18
Mo

® Reattach (FEHME)D
R TUH T E e BT IRRRE F B I, A E T VR RRT A H R A [E

® Edit Tolerances (4miHAZ)

ZIR T T ImEITIR R A 2 o EFRZE T, 2398 w2006 HE, Hrh a8 1 Chaining
Tolerances (#EHz/A7) Al Distance Tolerances (FEEAZE) WAL, 7EAHRN I SCAKEFZMA ZE
5, W RFi2 A sME S TERIE R A % .

® Edit Direction (Zm#%E J717])
LI T Ym i BT IR SR R 7 ) BERE 77 I B 7 IA) o IR FRIZIE I, 25 H RS AT
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TEAHE, P AT UAGIEE — R ETT A, AFOURFESLAR . e sd 8 iR B 7 17 -

® Edit Curve (ZmiEHNZE)

ZIE U T 9w S EARREA DGR R 28, Wi th e o] FL65%F . EFZiEml, <5t &
4.112 FoR g 2RI UEAE (O 4.4.0 /N5 o Al B U A ARI g 260 7575, g5 prik iy
TEAE SCHRA Hh 42

® Edit Defining String (4w%E 52 X Hh£)

1ZE T T SRR TR A dh 2R AN 5] T2k, EET e LRI, DR gl 28 sl
TR R i 2R 551 28, ol NIRRT th 26 A0 5] S 4, B 2 — e dh 2Rk
4,

WFAZIEI, A 3.164 P in / B0 ZAHEHE. R I/ — N T HE ik
D) SERF

"String Tvpe

* Sectioni ¢ Guide

Filker all -

Referencing Feature

0K Baclk | Ca.m:ell

K 3.164 WNI0 / B8 5T BATEME
1) Section (ELHIHIZE)

BT T gm A th 2k . G FRIZIR I, W BT RAE i AR 2R DL iRy e s o WUR Py
MR AFERN S A5 L, WARS S B Ak %

2) Guide (5|54
LT T 9nte 5| T4 . EEZED, W PTIERHEH I 5] S AR TR

3) Filter (GEJESS)
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T REREN R, A3 Curve (HIZ) . Edge (1) . Face (KD A1 AN (FTA)
PyFhae AL,

TE B i SRR BRI R e BN R RS, nl AT RN e £ th 4 R . R E
AU S 2 T e 2k e 5] Sk, nI#EL R DAE X A B BB R N i 2R B0 o o S AR
T Hh£R B 5] SRR RS 2 J U XS G, TS S 424E Shift 8, FELERRH i 2R 5k 5] S 28 b e B A2 25 1) il

® Replace Defining String (A& X ihZ)

ZIETUE R e &, BEm R sk th £ ain] F4:, REnT i i, el B
P, EPAZIETN, 2 A E SO HHEHE, & Hsrmt 2K 3.164 XFIEHER) 5.

TEAT B He A ER, SefEXEHENT String Type 1E TR 15 B B 4w th 25 1257 Section BY, Guide
T3, FRAE Filter IETIH 8 B EBEN RIURAL . SR, AT Shift B, FE#RHE Hh 2R ek 5] T 48 Hh ik B 2L
e B M 2Bl , PR TARX Hhod B [R5 H ) b Zemliads, DT it 2ot & 4 Sk i h 22 5451
SIS R

P 3.165 Pl il A2 A8 cld b s A Hl 2 1) L6

=

FEBEN P
B2 Fr L
B Lt

4] 3.165 B 4k
3. GHFEIIRFIESEL

PTIEAFIE N FE SRR AERS, H B S EOHEHE & 3.166 s (A LL#RAE A Reattach 1%
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Edit Farameters

Feature Dialog

Inztance Array Dialeg

Cloclk Instance

Uneclock Instance

Inclock Instance Set

Change Type

0K Bacl Canecal

Kl 3.166 ZwiE PRSI RHIESEO T HE

® Feature Dialog CFFERTIEHE)

I U T gmE B A RHAE B ARRFIE A S 4 S PZE T, S 7R B AR FHIER 12
HOEHE, P MBS B ARRHE I RESEUE . (B SEUE, FEFIRHE S ) B ARRHIER BT A % R 35
SR E NS HGE AT B

® Reattach (E#IHE)
1573 v 1 e e vt e B 1 ) = ST e = 2 | e e [ N E R Rt 1T O vk
T, B0 IO UEAE, ERE A S AT A AR [ .

® Instance Array Dialog (FE41%F 15 AE)

ZIE U T 9w R 0 T 3 e ECH SRR AT R o Bz T, A s ) H bRy
AR RO TERES ], 258 K] 3.149 Fros AT RESRHE S B8O IEHE . 25 I B B ARFFAEER
B NITERES ], 2258 5 K] 3.152 AHLIATERES S B0 HE, HH 2 T Reference Point (JiE
22 50D H Datum Axis GEERD PIANED, BT TH TESCR RS F e . 1200w ZE 8 m
ZHUE R, W RGIZTRE 2 BUE Ui KA E FE SR .

® Clock Instance (HE B P —[%51))

ZIE T T SO RS R A B EPRZIE T, R R AR AT RS, T ] 3.167
7 SE SO T BB s 53 A B XU AE , ] AEX U HE R o BT IR R A AE X T A Y JrmI A B . A
Fr i BRSO RE ], D3 L 1] 3.168 Firoas B B &1 B R A BRI AE , AT FE R s AE Th 4 € Piride
BRI R R R SR B S BEMES)E, Wl B 4448 e 15 1 BB R A B .
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Clock Instance Clock Instance

R adius IEI. 3 R adius |1

Angle IEI. 1] Angle |9EI|
0K Back | Cancel | 0K Back | Cancel |
P&l 3.167 T SR TR 51 A i3 o 6T 1 AE [l 3.168 T FRTEREFI A 3 o B 0T 1 AE

IR REB R T A AL B, T FESH H RRRAE A7 BN ASBEF R R B . AR 2
B HFRRHERIALE, ISIFF Reattach 16 T0 A (AP BRRAZ 4

® Unlock Instance (VK& H—[5%1))
12358 T BT aZe B 4 1 0 [B] 2 BB A vp ) SR AL B . R FEFTE R R AL BB s, A BB
BRI, EPEZIET, w]fd iRk R AL

® Unlock Instance Set ({RE 4 &84
MBEGIRE 2N ES R A SO TALE, WIHERES A & B INZIE T, Pz E I, RS
i AT AL AU AR R, AR B JF R AL B .

4. Gl (R f AL R TR RS 2L

PR N B A B A R I AFAERS , Hgn S B iR AN B 3.169 B 3.170 fos. N
I — N BRI .

Edit Parameters

Edit Parameters

Feature Dialog

Add/Remove Chamfer Edges | AddfRemove Offset Faces |
0K | Baclk | Cancel | 0K Back | Cancel |
3.169 A5 1 SO 1S AE 1 3.170 4 i F% 2 1 2 B0 1 E

® Feature Dialog CHFIEXT1EHE)
ZIE T T gm R 3] A RHE B WAL R RFIE I S8 mPIZIE T, 290 R A B A2 26 TH R AE )
RIS BOGTENE, AR UEHE RS SO 2R I 25

® Add/Remove Chamfer Edges C(isNELFS 18]
R I T INERE 2 SR BRI il . EERZIET, Sor B RGBS UENE, PRl AEL K
AR X A ade 45 75 BB A )0 BCEL RS 2 481 AR o
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® Add/Remove Offset Faces (¥NINElFE L mfs L)

ZIE T TN 554k E I mFE R . IEFZIETN, 9t X GUERUMENE, R R
fAs 2, A BRARTE 2 B AR X U SAk b 2w % (R B AT . G R 2R R mfs R, W Jed%(E
Shift 5, FH bR 7R B AR X sefk b O m e (R BT .
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ZEEEM
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.
0

B,
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SECES
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5. YmiEHERHIESE

AL S BT L AR T o R0 LUBIAE. BAMRGE 5 SRR L. HhgW i S AN
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3.6.2 wWBEMNRT

Eiﬂgﬁﬁqjﬁﬁi@ﬁiﬁﬁﬁﬁﬁé\ Edit»Feature»Positioning, Rt 5K 3.161 #H
AR B AE X TEAEXT TG HE . FH P AT AE 2 B AR X B BURFAIE s BRAE T A (1) 4R 11E 51 ZRAE H ik
PR B miE A B RHIE . IRFRFFIESS, 29 &l 3.75 Frndm i e A RSP HEHE (I 3.6 /19D
[FIRF,  Frde Rk B e o RS AE S B AR X DA S B R o P ] AR P s A RS Sof 1if HE Sk 28 e
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3.6.3 $¥EBEN

FE TR bR A o iy 8 BE PR LA 4 Edit>Feature>Move, R 4ot 5l 3.161 MBI
PEFERFAES TEHEXS T AE . P AT 72 P AT DX o AR S T A (O RAALE 51 SR AE e 33 7 EE A s A B AR
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D
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(1] Bacl | Ca.m:ell

Kl 3.172 B BhEFAERT I HE

1. DXC. DYC fl DzC (ME/E)

R 3 ANSECCANE I T BT A AR B Xy Yy Z T ARSI R . B A R
ML IX =AMMEM B RFAE .

2. ToaPoint (Z|—f)

ZIETE NS 25 B H AR R E (77 17 SRR, R TR R A RS B B AR AL E . 2LE
ZIETUE, A CIEIEE, H P B E S RN E, HEE HAR R A BRI,

3. Rotate Between Two Axes (Py#i[a]igd% )
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RBVEXIENE, $RE — R, SR RERIEXITNE, i —REMF NS HH, BWiES —RE
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4. Csysto Csys (AR RZFIALARR)

ZIETERG FINERAE, S5 AR R AR B B H AR 8RR (R — B . izt
U, BRI ARRR R EUEREHE, F e iE AR R NS B R R, FIE AR R AE Y H AR
AAER R BIT]

FEARE RSN RFIEAL B 7k R ,, IR RFIE 2% 6 A BT 8. (HUL L 4 RISl RF LR 7
%, AR AL R A HIRHIE -

3.6.4 EFHF

Elﬁgﬁi‘éqj%%@ﬁﬁ%%ﬁﬁé\ Edit>»Feature»Reorder, R UIE 3.174 Fizs
A )] R A 0 5T X 1 HE o
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Reorder Feature

Reference Feature

Filker I*
| BLOCKE I:IIII

—Choose Method
{" EBefore (% iFrer

Reposition Features

BLOCK(D)

IE hppls | Cancel |

3.174 VLR NG o) TEAE

G HERFAL MU S S AEXTHEAE b B AR AL SR AE L £ —NRFAE,  VROURFE BT HE R 10 R HERS
fik,  SERHE R B E ARSI RAE T, 81 R % 2 AR 5 R (R . %P Before B

After BWEFFF T, R)a NEHSIEFIRAE S, B3 — D EEFHPPRAERI T, R Gk i ifeky
L EHT A RIS HERAE 2 AT B2 5 o N2 — T HE A S T AT

1. Reference Feature (FEUEFFARIEIIZHE)

ZIETAAE T Filter GEUERS) FFEAERFESIZRAEP AN IE T, FEAERFIE S RAE H T BoR sefkrh
W IER T ERHME. AR % RHNEF BT B RHEE NS HERRE, RS TIEX Fik
5 BRI IEE NI HERRALE

2. Choose Method (EHET )

ZIE T T48 EFF AL HE R I 7. A5 Before 5 After PR/ NIE T,
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ZAE T T8 B T HE T BRI AR 2 AT .

® After GEHERFEZ JE)
LT T8 R HET BRI TR MR )5 -

3. Reposition Features C(ELFTHETFRHIESIZRAHE)

AL AN RAME T Bos FURFE R AR BRI 5, RERIEBCE R E AT 30 (Before BY After)
H D HERL, B A IR AFAE A T DLHEAE P SR AR 2 BT B S5 T TR B HERAE 51 R AE
B B AT HE I ARFE AR, TR 2 B A X G 5 2 R HE Y AL

3.6.5 MIBRYFAE

HETHR @lﬁi‘éqﬂ%ﬁ@ﬁiﬁﬁﬁﬁﬁﬁé\ Edit>»Feature»Delete, R G 5K 3.174 FHALHY
I BRFRAE X TEAE o X VEAE LS RFIE ZIRAE A, B T AT TRl R I AR I BT B RHE, RN
IRFFIEFIRAE . MIBRFFIERT, w7 TAE X A EAE X TEHE I RE S RAE S, EFE— AT E

T ERFIRFAE,  Prifefr il & SonfE AR RS RAE T, RGN MR R IR . R A4 —
ST R SR AT I T 1 7

1. Filter GIJEZS)

LRSS T BR AR AE S M T BT SURFAE R A2 FR o AT ZERL SRR SOAAE i BB AT “*7 A
“P7 . R RORRHEAMTMER AT, WRAFES, W AR R R AR R A4 R
“?7 FORFHEARRT RIS TR Bl “S*7 RORERFIEAIRME T, S PTA LL €S JT Sk
ALAFR: 0T “S?” FRoRAERFIESIRAEF, FIHPHALL “S” TRk, 2 NP RFRRF LA R
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ZARAEH T 5 2 A A b (i pE AR i € T A RFIE R A2 AR . ATAE 81 2RAE P I 35 75 ZE M B
FIRFIE AR, PINERAIE 2 B 31 R osFE CIERHIE SR AE T

3. List Dependents (i znAHICHRED
RECZED, NEFE AL G, HASURHIE S B 3 EL .
4. Selected Features ( CLIEHFAE)

CLEARFIES R MEF T4 T ZE BRI ARFAE 2 PR . 2475 2 B A X rh AR P AIE 51 R ME e SRR AIE
I, PRI AR = B 3 BoR B IRNE . WUEREHGFE MR R CIERrIE, TSR
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Offset INDnE vI
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R
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=
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ot 53 BOORH R HERT , 8 LRI B P BT M ot 52 . By OK 3L, 738 0 ey 2R HE
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Alternate Thickness |3
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77 s EHE IR B Direction_Distance 1610, F-7E [ 5 5 H 10 15 HE HHIE HU Accept Default Direction
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252 /454
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Circular Array
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EXTRUDED(16)

OE I hpply Back Cancel
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LR 1 HIEAZH Arc Length I, P AT DLEESCACHE g A\ (w8 mi s it 2R w2 oK . ke d% 1
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i S U AN AR 2R, 7ERRE RUERIECH, SRR IR RS R e BRI E (ED Y
KA E S, s AN 0, S5 AN 100, HiFRonttis st g i, 45 ine
MARRZ D o K 4.11 Frosit g VK T7 B R &R 1

Mumnber COF Paints |8| =
Start Percentage I 0. 0000

End Percentage 100, 0000

Kl 411 KTy G Rtk

276 /454



® Equal Parameters

FEZHTAGNE R, PRSI T SR, R R g DU R KNk A
REMALE, mREOR, PR IEREGEOR, 2N 18] 4.2 B LSS S H07 A1 R

Blr

Mumber OF Paints |9| +
Skart Percentage I 0. 0000 1

End Percentage 100, ooon +_;'

Kl 4.12 ES507 00 4R

® Geometric Progression

1E U 21X #7720, Points on Curve XJIHAEH &2 —A> Ratio (LU HICAKE. EXE T
HASH a5, EFERE — N EIME, & H R e SR AR A8 1 5 W 2 B FE 2 5 AT
MERE R B 4.13 P2 PL U gt 7 6 e 1.

Mumber OF Points I A 451
=B
Start Percentage I 0. 0000
End Percentage IIDD. ooon
Ratin [0 8000 + + + + +
F PR = A ~| B = At 5]
D= cthil

4.13 JUAT gty A s 4

® Chordal Tolerance
TEIRNGZ IR ZEIXFI 7T, Points on Curve XFiGHEF HF —> Chordal Tolerance SCASHE. F 7

B2 IRIRZERIRN, FEQIE RRE R G0 IR IGZ R ZE MR AT AL B . JGZ R 2 (E
AN, PHER B, RN B 4.14 s LR iR 2 5 SUENE AR BT .

277 /454



BB
~ BifisEE

4.14 YaziRZE J7 a0 N 4E

® Incremental Arc Length
EIRIE L IX A 70, Points on Curve XTIHHEF 5 H A —A™ Arc Length SCARKNE. P 75 24y
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7) Points on Face 1%
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® Unbounded (ANFR#HIILFL -
WMREFIZEIEE, NN ELRE LS S& 0N nERS B X iR,

® Delta (JE&)
IS TR, T R G2 LU LA 77 Sk O . (e — AUR, A ISR R
(19 XC. YC A ZC SCAKER 1\ M4 A 4 — s 3 — A

® Point Method (kT
FIRZ FRig0F, el PLk B T InEcos .
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WIEREFZEIENE, WA B LR R H I E— 2 B Mo R E AR S, 4kakfld v —
KHEZ.
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IR AT MRAEE E 4 .

® Parallelto XC. YC. ZC CPATT X, Y. 25D
FATZ R DA R AR RL R, B 1 B AT 5 0 e I AR b
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5. WA, QIREAAAEELK EMENEL (B TTEERD
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FEAE, BN RUEREE T R e BRI o, PRSP, mEEU—E AN
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WP S MRS — s, MBS P A VI — 265 5l kR 5 D sk
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10. BUEERAMMIAT 70L&

SRR B ARACTAT L, 3l AR E AT RT3 1F), 88 AP B K R BBE — A4
AR RN R, MR G LAANTAT B IISE R E N AP 2 2R R IR 1, DABCE I B
B2 ROREVE AT 2R

11. QUEPPAT HE Lk

IR IR PAT B2, FRAE T RALH) Length SUAHE AN ELZRHI KL, RGN B %R
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13. G —ELRI MLk

SR HAXHEHE ) String Mode RIETH, HAFIEFM K HL, R TRFN offset U4
HEFP IS 20 5 s EA MR, REMTAREELRmELE GERTATL)  MEKTTHS
EFFRRAVEFALEAT R, RIEFERRE R LR, (W0 — 2 AR w2 -

4.2.3 EK

1F Basic Curve Xﬂ‘iﬁ*@qjﬁﬁi%@ﬁﬂ, Basic Curve X TEHEN]E 7~ AU 4.33 Frosii = 5K,
AE FLIH

Basic Curves

2

[~ Full Circle v Celka
Point Method e
7o -

[ String Mode Break Skring |

Alternate Salution |

% Start, End, Point on Arc

Creation Method
L" Center, Start, End

[E: | Appls | Cancel

K 4.33 [HHNKTIEHE
TE X [ S EAE Fh B A E FAE— S8l (5 B TEHEAA R L DA EHAH T -
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® Alternate Solution (¥ #)

290/ 454



ik F B PR AR, Bz, WARGS Bon 58 Az A G 2 [ A
IR B[R FIK

® Creation Method (E:7 7))
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K 4.34 REGEEIE IR P15
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/ ) HIEREE
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K 4.34 BEEH 9T

4.2.4 [REf
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AE FIH
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[T FullCircle v Dela
Point Method

[T String Made Break String

[~ Multiple Positions

OE | Apply | Cancel

K 4.35 [T XHEHE
W& H Multiple Positions EIEHE, RGN E 6| SHT—FTEAHF R ZANE, iy Q24558 %
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W | Trim First Curve T (BEIE—Eahit
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EIERE

* = EEHNLE
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® Trim Second Curve (fBBYZE —25HhZk)

& 2 Curve Fillet BRI A7 B, REA SBOFZEIERME. EEZEEDL W7EE R A &R
G B ETIR B A2k, A2 WA RS T 3 Curve Fillet 81 A 7750, WIZE EHE
FRiRAE A Delete Second Curve (MIFREE 25 MIZR) o EFXE LI, RGN A 2> G EUP) 26
Tk h A MIER, R MAZ

® Trim Third Curve (f&BT%5 =2il2k)
B IEFE 3 Curve Fillet 1213 £ 5 U, ZEIENEA SWOE . EPEZEEDL WERIE AR, &R
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(1) Chamfer XTUEHE. R —IL3EHE TRMEIF AT Simple Chamger (% Z IR} ) F1 User-
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Simple ChamFer

ser-Defined Chamfer
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2. User Defined Chamfer
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TEIXAXTEHEF, RGIRME T =Fri 215887 7 . Automatic Trim (H31&8Y) . Manual Trim
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® Offset and Angle (fWFS(E 5 M)
PR AT T I, RGE R E SHENE (W 4.47 EILFTR) . 22 BIALE offset J2 Angle SCASHE

s NAREEFI AR S, B Rk PeMi 4 1 Jth2k 2, B fm o — MBI S R KRB BRI AT, iR
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4.2.7 EF

75 T BBk otk D sk 32 8. 45 4 Insert>Curve> Rectangle I, Z2 %45 23k AN SE T A7 1)
AE. IXHT RS SAVENEHE, IR BEERNE— A E, AR5 FERCE AN A
MALE, XFERGH TR — MG,

4.2.8 [F%ih

T AR s ©
HIP Polygon ThRER1EHE .

R PRS2 Insert»Curve»Polygon I, RGi2ssfi i 4N 4.49 fow

Polygon
Polygon Inscribed Radius ]
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Circumscribed Radius |

0K Back | Cancel

0K Baclk | Ca.m:ell

Kl 4.49 Polygon TEEXT THHE
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HTEI A2 7 B EE . 7EIX B —JRgn H P4 ft 7 =M ia e X7 Inscribed Radius
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1. Inscribed Radius
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4.50 Inscribed Radius 57 2\ i £ il &

2. Side of Polygon
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Polygon
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()4 Bacl Cancal

K] 4.51 Side of Polygon X} ifHE

3. Circumscribed Radius

WA DI LR BdZiETE, KRG EEE (W 4.52 AT
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3 LH PR SO TR AE 1 B IE 2 IR TG BRI AT . 1] 4.52 s S i A = B4
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3 Semimador [
S Semiminor [ 1 oooo
IR — Start Angle [0 oooo
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X (AR T 2 M S Sl ] 4.54 T

302 /454



A /w? //—;i\ﬁﬂﬁﬁ,

{ | %mﬁ‘\—’}; A
1 \ 1 x\/ K
L, " 4 L >

Kl 4.54 HilA

ZHME X

4.2.10 M

CE T EL PR o s L o S 26 Ay 4 Insert> CurvePlane [, %% 23t 411 4.55 i )
P R AR

303 /454



Three Paints i — =&m|

Two Lines I — MWE#
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4.58 Point, Perpendicular Curve 77 208 8 F1fi

4. Plane of Curve

RIS T — AR i e P Pdzizils, RaGaten A P — %2
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IR A5 2B 1 51

e I
AR S R R
et
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7. Principal Plane
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I
I
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YC-ZC (YC-ZC V1) = ZIEIHEE 2 A AAAR 2 ) YC-ZC ARAR-F- T Dy %€ SCF

ZC-XC (ZCXC VMDD = IZIEIIEE AT A-AR 2 HH 1) ZC-XC ARKR T T DN E SCTTH -

ZCConstant (ZC [ElE) : IR T 48 E AT AL bR R b ZC ARFRMEN T B — > Fill. A&
PP IE 5 EAE 2C STACHE i\ [F 58 BE B 4H -
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® XC Constant (XC [l5E) : 1XIEHUH TH55E HHTALbr R XC ALFME N R BN — AP, 4%
% F P A6 75 HEAE XC SUAHE g N ] o B B9 4A

® YCConstant (YC[H7E) : ZiGIWIH T-48E AT AAbR R YC ARBRE N B I — APl B
P75 EEAE YC SUASHE i A ] 58 BE B .

8. Existing Plane

e T 3 ] T O A AR T E 9 7€ I -
9. Two Tangent Faces

IR T AT, 2 SRR ek s R AT, A zaRiE, REaR
R PG SRR T PR T AR e Bk D, EIUE, RES R rER T gk, B
I FH P AR e 4 75 228 ST VA2 7 Sk BI AT o 18] 4.62 Bt (it @& X F oy 06 g P i i 1)
Bl

EEEmATE
sl Gl

K 4.62 Two Tangent Faces J7 2081 Ff

10. Point, Tangent Face

IR I T A0 M i e L5 0 I 5 4 1 s R A AR D) i . Bz e
RGP 1P Bl ST (PR T R AR R B AR AR T ), 3536 2R R R B X T AE
TRE R, BEJE RS2 R BUR T MIEL 5 7, BRI F DOGHR £ 75 20E SOV AL T 7 i
Yoo ARG E ORI A S PR R A VIR T . B 4.63 s (R stE X F 5 2081 -1~ 18
7B
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4.63 Point, Tangent Face Jj U812 -
11. Coefficients

123 T A Nl T R R I . X AN SR, PO RN Ax
+By+Cz=D, HHFHHTEHEHTERE A, B. C. D KRHiE.

FlniZzik s, A 4.64 Bt e SCP 7R R B IEHE, B E$E wes Bk
Absolute HLIEITHE FT R KIAAFR 22K JG, 70 04E Av By C. D SCARKEFHIA AL B. C. DR
BAERIW] o 25 i N RBGERWE 1 s, A BE S o 0 R VR HESR & — 1 Al BA
ARG E TN B B CRECARE /-5 HAE O T LI L IR BB U B IE AT T
NSRRI AT A= D

] T
' —
c F—
0 E—
0 WitS " Absolute

)4 Bacl | Cancel

Kl 4.64 Vi )7 2 R BOMIEHE
12. Parallel Through Point

ZIET LB Tl 25T A€ R QT T i EE R E 1 RO 5 2% T T
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1o Bz e, REHE LS5 PIHAEHE, Z0EHE S 18] 4.55 Fros f0°Fi THEXSTEHER)

Al 11 Bise e AflF. & XTS5 i)E, HA B S QU IEHEE G, RIAT ST i
AR E. & 4.65 Fros g2 X m s 2080 1 i 1 B

HEFED — =

TEES \

T R, ]
almE "
g

4.65 Parallel Through Point 5 36122 T~ 1H]
13. Parallel at Distance

LT Bl g € MR R B i, T i AR E E R RS T 17 B S 5%
RS BOE R . R IZEIUS, RGN E XS T IAEHE, 2 It S ] 4.55 Fr
(R3F  E S TR AT 11 TS MR € T S5 T e, A 0 R G 2 A

m RTHRE QU I A RAE J5 17 . B R RGE 2 R i o i B AR, FH ) S A\ 75 2 A (e ED
"o B 4.65 Fron (it A& X A5 s T 1 B

LN
Plane Par at Disk i =
Listance I 10| {lﬁ@ﬁ:]i |
0K Back Canecel b,
| FoleTm —

P EE AN
R

4.66 Parallel at Distance J7 21 2 ~F 1
14. Perpendicular, Through Line

PRI Tl — 225 P A — 4R E BRI, 2P Il 1R E B AR BT A
KIS, Rz bie, RERHHE XSH T IEHE, 2 IEHEt 5 4.55 Fros 111 T
HOSTEAERIAT 11 BEE AR €T 2% P H)E, MRl EAH T QI T fh &
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GZHLAREEE THAET )

4.2.11 #4EEH
X BLRE USRI R BRI EVE B DA, e IR A R B PR A R
1. AR

1E 421 /N, FATCEFEGMIANA T AV S B S M7k, FHIRAIRIA Points on Curve Fl
Spline Poles iX I Fh 77 R A1 2 i ¥
® Points on Curve J7 R0/ & S BT

1) %ﬁiﬁ@lﬁﬁqjﬁ"]ﬂﬁiﬁﬁiﬁiﬁé\ Insert»Curve»Point Set, J-7E3H ¥ Point Set X
1EHE FP % +% Points on Curve JE T,

I

Paoints on Curve

Add Painks ba Curves

Paint ak Curve Percentage

Spline Defining Poinks

Spline Knat Paints

Paints on Face

Point ab Face Percentage

Face (B-5urface) Poles

Group Painks - OFF

|
|
|
|
Spline Poles I
|
|
|
|

()4 Baclk | Cancal

2) T Points on Curve X UFHEH % B A K HIS4L. 4 Spacing Method % # N Equal
Parameters 73\, % & Number Of Points S N 5, HASHHARHKE . FHENCHEER—%
FEZ M ZNEAERT 5, FEdy oK #2450,
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Points On Curve

Spacing Method

Equal Parameters j -
Mumber OF Poinks I q
Start Percentage I 0. 0000

End Percentage 100. 0000

_;Edéct Mew Curve I

0K | Appl}'l EBack

3) RGUIR[E Point Set XFiHHE, JFAEFTIERIFER Ik Eica e B ESHOIE T 5.

Cancel

/

® Spline Poles J7 2 A1 A f

1) B T HEAF E‘Jﬂﬂiiﬁﬁ;ﬁ%ﬁ*ﬁé\ Insert»Curve»Point Set, FH:7E#H 1) Point Set X
TEHEF1 % £ Spline Poles £ .
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Painkts an Curve

Add Paoinks bo Curves

Paoint ak Curve Percentage

Spline Defining Painks

Spline Knot Poinks
Spline Poles

Paints on Face

Paoink ak Face Percentage

|
|
Face (B-5urface) Poles |

Garoup Poinks - Qff |

0K Baclk | Cancel

2) HH R REHONEHE, B AR R I — 26 Rk I 2O IR TEXS B, JF il OK 4%
Hl.

0K Back | Cancell

3) RGIR [ Point Set XMFARAE, FFEPTEFE A Hh 2 i BRI 1 .
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2. P A

1 4.2.10 /MY, FATCEL VAN T RIS M, FATF A Parallel at
Distance il Two Tangent Faces iX 5 /7 2K A1) & T i
® Parallel at Distance J5 20612 F 1]

h
1 T HE B R s Bk SR a2 Insert> Curve > Plane,  FF7E 5 H I -F 1 €1 & 7 =X
S EHE %L £ Parallel at Distance 117 .

Three Points

Two Lines

Paint, Perpendicular Curyve

Plane of Curve

Plane of W5

Plane of C5%5

Principal Plane

Two Tangenk Faces

Paoink, Tangenkt Face

Existing Plane
Coefficients

|
|
|
|
|
|
|
|
|
|
|
Parallel through Point “/
|
|

Parallel at Distance

Perpendicular, through Line

0K I Back | Ca.ncell

2) BEEALE I E XA T T AHE HE iR B Existing Plane 3&T0, FA X Gk BOWEAE, %
FOAFTE I — AP IHAE N WS -1 .
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Offset Plane

Three Poinks

Two Lines

Point, Perpendicular Curve

Plane of Curve

Plane of C5Y5
Principal Plane /
Existing Plane

Twa Tangenk Fz [l e A ETE

|
|
|
|
Plane of WS I
|
|
|

Poink, Tangerk F Mame =

Coefficients ||

| Back | 0K I Back | Cancel

it e il

L

3) RJE ARG R EEXEE, R e E AR T 1. X BRI R — A A AR D
Mo J7 1 i, FRCERE A 3 R A% B B O IR RE SRS A P R (mA2 P B 8, X HURE B E N 0.5, JRH

o7 OK %41

Point Constructor

InfFerred Poink

|7;I_I_ILIiI
O A

Base Paink

HC 0. 0o0oooaooon

ve [o- 0000000000

ZC 0. 0o0ogoaooon
Qe e ﬁbSDIUL Par at Dist

Offset Mo Distance

Reset DK“ Bacl | Canecel
O I Baclk | Cancel

/

&Eﬁﬂfﬁﬁ-?ﬁlﬁﬁ

=

/

4) B R G R m - m Ay A TEAE,  JFERT R E RS R B A B B AR T S S

FTHPPAT BT 1
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_— FrelZHEHFE

[
/ol
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L/\_\ -

—_—_—_—__———\_

® Two Tangent Faces J5 A2 T

.
1) A T HEERRE ) S BlUE RSB 2 Insert>» Curve > Plane,  FE7E 5 HY B~ i A1 & /5 20 H
X 1EAE 1% £ Two Tangent Faces 1%

316 / 454



Three Points

Two Lines

Point, Perpendicular Curve

Plane af Curve

Flane of WS

Flane aof C5¥S

Principal Plane

Existing Plane

Paink, Tangent Face

Coefficients

Parallel at Distance

|
|
Parallel throwugh Paink |
|
|

Perpendicular, through Line

1] 4 | Baclk | Cancel

2) P 0 RO TEHE, AR FE CAFAE I A AR IR A V)R T

AR I - T-1EH0 R0

Plane

MNarne

NE: I Back | I:am:ell

3) RJE ARG AR AR R AR PUA VIR E DT R LA S, 7 AR 5 2k
PO A — N RETT .
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BRI AW

4) 5 TOPPIERET )G, REwREPFmEE )y XHEHE, JHEPaE R BT
EBIEE T A5 P R AR T AR )

2EHE T E

(>
(>

4.3 QIR IR IIEL

BT N 1 — S8 I QI TE, A/NTR TR 41— Se R — el 2k, ankE 2% i
2. kb, B ihZk. SRFeL. ILANXLh 2k I U5
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4.3.1 HFHhsk

T AR L
P4 28 6118 7 2 R A

BERESE HLAT 4 Insert»Curve»Spline ), Rt K 4.67 Fini]

Ev Pales i — AR
Through Painks I— BiTEY S
Fit |—— A0
Perpendicular ko Planes I— ¥
)4 Back | Cancel |

K 4.67 H2% HIZ AU T7 AR TEAE

FEAA M ZR 2 DL 2 DX T P2 AR 1, 18 UG RS Fr i S IR 25 i 28 #2 NURBS 12k (Non-
UniFrom Rational B-Splines) . R Lt T DUFh A iliAE 25 #2677 30: By Poles. Trough Points.
Fit Al Perpendicular to Planes. ¥ 4.68 Fit 7~ I /& F) H A = Fh 5 @ et 2 th £ 41, 1 49 )
I — T IR PUFR G AL 2% Hh 22 1 7 2

Pk n

Through Points F
* \ +
v

+

By Poles

SN

4.68 GIEFES L

1. By Poles
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I8 T I 1 A I ) 2 P RORAE B — SRR SR it 2 4261 il 1R B T3 92— AT P -
A5 FH o B A SE SCmt A A ST A AR 3 A ) Ao

RHZIEDE, R4 FREINE 4.69 BRI iEHE, IXANEHEF AL E T Curve type (HIZRSS
M) . Curve Degree (HHZEMY%0) . Closed Curve (FPIHHZE) . Curve Analysis Display (il 2k 53 #T &
7~) F1 Points From File (A SO ARz RS 2D X JLAN DY BRI

Spline By Poles

=ik seail] Curve Tvpe
#A5ELY — | ¢ Mulkiple Segments
BE—35ES — | Single Segment
BT — - Curve Degree [ 3
Fitpit —- Closed Curve
iZurve fnalysis Cisplay | — St ET
Paints from File | TR S

0K Bacl | Ca.m:ell

P 4.69 =il £ G RE % Hh 2 X T HE

® Curve type
AL T BB FER M 2RISR, AR 1 275 BOM B — 5 B 2 M 287

1) Multiple Segments

kPR IEAE, AR AT, S X TERE T B2 (Curve Degree) HJBLE K.
NI HON 3 I, WLAZIBEE 4 MER AL, AL AN BRI A 5 MEHlAL AT
FESL 2 NHTBRRE SR 2

2) Single Segment

MR AL EHERT, XEHEH ) Curve Degree & Closed Curve PN HE IS . =0 H B
FEE =N B RE SR T 2R

® Curve Degree
ZOCAHELEFTIT Multiple Segments BT, A 95 30E, FH T B 2 prE. P BB il 5
OB AU & O 1, B WTCE R SR 4
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® (Closed Curve

ZHEEHELESTIT Multiple Segments ZEIUIN A 8805 , T B0 BE 5 28 BUAORE 2% il 22 75 3 A
EFZIEI, Pl @RSk M A SO 2 S S TEF — A B, AN — Sk B PIIIRE SR Ml 2, 75 0 Al —
SRR ZL . 1] 4.70 Firos BOIUR THBOM S PR sCHIRE SR i 42

2 P3 Pz P
|
P1 P P P
Tk "
== E =
o %T@ﬁm

B 4.70 JFIRANES TR U 2% 22

® Curve Analysis Display
A AT BT SRt et & it a5 R . dnzddile, Rgai i’ 4.71 Fiosi
28 AT R XTI HE o L — LR IR S

1) Show Control Polygon (& /Rf#IZi47E)
EHIZEIERER, RESFTIFFE L H 2L .
2) Show Curvature Comb (&7~ HiZ4T)

EHIZ B ERERS, TSR TR R ST T i B B R IR . X I 1 2 P80E X HE H )
Scale Factor SUANHE, 1% SCASHE FH T 158 B 2 A R B R/INS

3) Show Inflections (@7~ il &)
EHPZ R IENERS, ARG EoRFE Sl 2R Sl B A B
4) Show Peaks (B /RTHiA&D

WrZ MR, R RRFERIZR AT B, AR 2% 0 il 2B K
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Curve Analysis Display

BeriE#lEnE —— | show Contral Polyaon
HmphEs —— W show Curvature Comb
Borkh bl F38r —  sScale Fackor I 1. 0000
1.00
"
i
05 5.00
B s — Suggest Scale Fackor

BrFphS Iv Show Inflections

By — [ ShowPeaks,

0K Back | Cancel

Kl 471 2o B ot i HE

MNP U 75 L SR B A 8 R T, FR A AR CBERE A 2% a2 #8422
2, HAGUC R 5WE 471 FPHER e BN Hrai . B 4.72 Hdf Bonizhl 2 d
AR TN HE S /NI N DN T ol P “R b Sl NP S B S R iR e B S ESpIAT

FREEAT Bk

4.72 Bk b2 #

® Points From File

Bz G, AT A EA SO B ] A 28
2. Through Points

IR I I e A A 2R % SO, AR ARl % E SORIIRE Sk 2k Bz dtlE
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RS AP 4.69 AL S A BUEEFE S - 2R A TEAE, RZH A2 7 N4 4 Assign Slopes (% B
FHE) Al Assign Curvatures (BEEHIER) , HIXE XN ZEEE A S 25 oK G, KRGSt
4,73 Fros i SRy SR EAE

Chain From &l | —— FEhEHE

Chain within Rectangle |— e eEsE
hain within Polygon |— N REE
Paink Conskructor |— ﬁﬁ']@ﬂ]‘ﬂ'ﬁ
[IE Back | Cancel

K 4.73 RO AXHEHE

ARGttt i DA e R0y X GEWT il SOfF b BRSO, B =05 s R A
PRV - LR ThRERT, T U R 2 . NI B4 — R X DU A e &7 K.

® Chain from All

I U T 1 B i 5 & i () 1) s R e SRR U R it 2. izl e, R&GiR
TN PR UGERERE A 2R S ST 5 2605, 58 R0 ARG R SR S MR s 4E, FERL
FEARERINE, WA 4.74 PR,

5 i
EJ '-'.\.\ n + /

4 +

FoRRTD I SRt

T~ N

4.74 Chain from All 77 =\

® Chain within Rectangle

AT T AR A 2% i AR R E 98 X RORAE R SR i e . B izd% )5, RS
SRR F P SURETEHE R 2 — M SR 3 A, BB AR TR rh 1) R TPl R SR i 2R pl 5 ¢
o RGER B S e fiMN & (i A 4R, JRRAB ™ AR e SR 2R, i 4.75 P
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EIES
a3
- * o
+ + *
2
N NEpEs
S E “fs
SeR AR et

/’rh“hayffﬁyhxxﬁ

K 4.75 Chain within Rectangle 773\

® Chain within Polygon

IR ITH T 2 0Tk FRE 5% i 2 1) )UARAE v 0 SCRCRAE RS it 2. B iZ 4% LG, R
el E X 2B S TR, BRAE 2 1R i) m AR I PR AR R 5 208, W RGK
H ZhHEnll AL RO LU T pidE, FRRA AR SR i 4. B E R IR S AT —Fh 7 2R

® Point Constructor
2326 T T s B X 1A i SORE 2% M 2R I & SRR AR e Akt 2. iizddlfs, FIA
58 ) AT IR HE B B R, RGU LLIX L5 i P AR AR it 4k

MR P SRR AR SRR E S, RGNS BRE R AR IR XEHE, AidiXey, 4%
H Assign Slopes F1 Assign Curvatures 4 THGEIRE, AP AT LT et 7 E -

1) ¥ Assign Slopes #%4lJ5, R SHH N 4.76 Fiznf] Assign Slope (E XRFE) XHIEHE,
b PR E & SRR
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Assign Slope

FlZETY — - Slope Methad
Ealiy " Automatic Slope

{" Direction ko Paint
" Yector ko Point
(" Slope of Curve

" Angle
%%Eg—mc 0. 0000
D m
Dz m
Dewiaticn Im
Threshald Im
el Femaove Slope |
EAraERE Remaove &l Slopes |
EFfETIE — Redisplay Data |
HH — Undo |

[E | Baclk | Cancel

K 4.76 Assign Slope ST iEHE

FETARIX B LR PR E R R A e, FRHERRARR BRERE SO 30 IEFEAF MR
T BRI RGNS A i ER . I IRIERGRR, BOE prik e SRR . Bk n]
FHEFHEE AR BE R . BRRBCE SR, RPIR AR E—XHHE, o] EARE SLhr
O, R A AL SR T AT 2R B A% e ) 70 A S 2 SR TR 1

E Assign Slopes XTIHHEH, 25 F P HRAE TSP R 2 e X J75: Automatic Slope (HBIRIZE) |
IS A=

Vector Component (&4 & ) . Direction to Point (J7 A £) . vector to Point (K&EZ5) . Slope
of Curve (HHZRFIZE) Fl Angle (FAFE) o FHIDANH— T XTI

® Automatic Slope

PRI, R GUR B ST SRR i g SCRBTRER .

® Vector Component
EFRZFRIE TN, EH N7 DXC. DYC. DZC STAHE 143 Al AT 4 it B A P ide & i ) ok
HAE XCy YC. ZC ARARHTT M R B2 S, U ARG ABEE I V) R 5 R 8 SUPde i€ SO R . [
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4.77 P Bt A P IR 5 QB AT 2% it 2 i) Pl 451

FREEHE
EEHTE S TEHHEE
f
D [ 1. ooooo r
D [ 0.0000
D2C [ 0.0000
12 EE R E o
EEOIEFE

4.77 Vector Component J7 2\ 61 #5452k

® Direction to Point

EPEZHIETN, FEH S BOE —NITR A, WRG LTI E R AR 1R1Z T 1) m R R &R E X
Fride & LR IR

® vector to Point

EPEZ I I, FTER P BRE — R, W RS LTI € XS FR R s i R R e AT I e SR
IR . Aid S E A BIRBUANE], 2 make & th & IR

® Slope of Curve

IEPZ IR TN, FHERE—AAEIIER, RS LU Hh 4 o o A R 3k e SO e SRt )

® Angle
EFEZ PRI, £ Angle SCASKEF A A ELAE, W ARG LLZ A R E SOk E SRR

fE£ Assign Slopes X R AHE A3t A3 HAth — 2L 3T, A AR 20 0 22 -

® Remove Slope

IR T8 2 5 & LR, £ TAERIXHIgE 7 —E XRJa, oG . wdiziz i
AR Pt e R P E E SURER

® Remove All Slope

PRIZEI, W RTHS A 2% it 2 v i A o SCRUR B E LRI RER

® Redisplny Data
BB BoREUE, PRI, ERVHTER S, AIE TR X P ERT RN E R R MR
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2RI T e RAEE S

® Undo
IR TAE I R 25 Hh 4y, FRAL TE e R IR BRI . IR BRI, WIHGH 4 A e
R 2B R AT — IR SRR R

2) i Assign Curvatures #5415, RGie ot i 4.78 Fizn ¥ Assign Curvature (G X HI%)
XEAE, 1hH PR E & E LR IRE.

Assign Curvakture

HRETEST

. Curvature Method
Ey " Curvature of Curve
& Enter Radus

Radius I 1. 0000

[eyiabian INu:nne - I

Threshold I —1. 0000
@'fﬂjﬂﬁ Remove Curvature I
EERERE Remove Al Curvatures I
BETEE —— Redisplay Data I
B mdm I

E Back | Cancel

] 4.78 Assign Curvature XJiGHE
ZAEHE T ZE TR B AR M e Cmin 2. P i BRakmie i 28 i O, PRk FEAH M
e SO, FRRE AR e R R E, R, ek e e Aok Hith %, thxiE
SETEE, RGUR BRI —XENE. P ol AR LR oL, R B e R T A T R 2 B 2%
LT RGN E .
7E Assign Curvature XJTEAEA, REFLAEPFH IR 2 X J73: Curvature of Curve (HIZEHI%R)
F1 Enter Radius CIAAZ) o R AN AA4H

® Curvature of Curve
ZIE T A T DA AR 2 i om s Hh 28, Sk SO e Sl 28, B pae l, Pk —
TEAE M2 i, RS A 3l LAt e i 2R 1 B i) h 28k e SCPride e SRyt 6.

® Enter Radius

327 /454



238 T B I B E T e SO ) R A oRoE SO R, R IR, £ R Radius 3
AHE PN R EARME,  BIR] 2 SCPTE E SR H2R

& 4.78 A7~ XHEHE S Remove Curvature. Remove All Curvatures. Redisplay Data FI1 Undo 2534 15
535 B 4.76 BT A UGHE AR OE I ) DR S AT VAR, RO AL X il ZR AT A

3. Fit

I G T A e 2 th 2. il Fit 3% HLR, Kot A0 B 4.79 FrondHisAE, AL
SeBE 5 F5E CREFJREIRT TR ) AT LoE PRk 2K R R . 78 R B IA, RGE 3R ]
4.80 FRXfiEHE, FH P AT DUESBHUE 7 (Fit Method) , FFELFAHMN IR E BE, X RS S
A SAHRLRORE S 2k, JFSR X IERE, b BoR A E R i 2 A i K 2= . DK 1&] 4.80 Frzmxt
TEHE T 2 ER IR A IR

Create Spline by Fit

Fit Method
{* By Tolerance

" By Segments

" By Template

Curve Degres

[ 3
Talerance I 0.0010
I 1

Seqments

Chain Fram All

Chain within Rectanagle

Zhain within Palygaon Assign End Slopes |
Point Construckor Change Weights |
Points From File Curve Analysis Display |
0K Bacl | Cancel | 0K Bacle | Cancel |
Kl 4.79 Spline XfiGHE Kl 4.80 Create Spline by Fit X G HE

® Fit Method (3U& 770
IR TR BRI R A 0. H it TR 3 M E 7 =

1) By Tolerance (MR¥EAZ) « 1%77 XM TARIEFE 5% it £ 5 5504 £ s R VP AT A 22 28 it 2% il
2%, EPZRIETS, FEXHUEHEF A Curve Degree (HIZEINED) . Tolerance (AZE) AKNEH
Sl N 2R B ER B 2% i 28 5 B0E R B KV il A 22 R W B AR it 2k

2) By Segments IRHETTBL « LI TARIEFE 5 h 2 (-1 BB IOFE SR T2 . 3%
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WIS, TEXFUEHETEFT Curve Degree (HHZEMME0) . Segments (TTEIE) SCAHE A 43731 N\ 2k
B0 A 25 il 2 1107 BUEOR W B RE S i 28 .

3) By Template CIRHEMIMR) « % PULITURYEMME S MLk, A i th LR B i f 45 m WP 34 S5 46
B AR R IAE SR T 2 B FEZ IR TR, RGN P PR 2% i 22

® Assign End Slopes (5 & % S8 %)
ZIE U T 48 @ FE 2R th Skt S5 24 Rl

® Change Weights (E22 N0

TZI% WU T 15 € P i Edis s R 2% th BT AR el IS IRl o ISR 10K, TN 2% il e bk
PTG EAHE A Rz, WEE . HIARR T AE, WEDE ISR T RG220 P 8l . m85i%
U, EETEE COEREERE 5, S8 5 7R3 o B HE 1 1 Weight SCASHE ARy Nz 8508 SO imAL
[Al-F- B AT

4. Perpendicular to Planes

IR T A DA IEAE T 1 1 i 26 28 iFE 2k 28 . By Perpendicular to Plane ¥4l 5, Yok #f e
o T DR E SCEIGI, PRk RRh A, B R R aGE a i D Re e SO — AN o S
SRR T ), SRR ARELIR BT TR S, SR ERIA, RGUE R AR — A AR 2. B
B IR DA ek M 2RI, PR Akt 2k S 2 IEAS Ak BT T i 2 AN Re eI 100 .

4.3.2 =Xhsk

TR ORI MR L. g (A 4.81 ) Ak gk, AERT AT 2
2l TIREARE KGR TE, AN EER R IR R BT, A R A
LRI T v, AT AR ST /N1 TPk

Circlo Ellipse Parabola Hyperbola

Kl 4.81 LI LARR = it 2k
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T B R it B AR 45 4 Insert> Curve > General Conic I, R4 21 11 4.82
FF AR — R R B 7 SRR A

General Conic

Z Points, Z Slope, Rho

5 Paints [ =
4 Paoints, 1 Slope | — 44, 1§
3 Points, 2 Slope | 348, ogl=E
3 Paints, Anchar | E— E‘J—"_ ' 1%5 'J—'_'
2 Paints, &nchor, Rho i — 28, lEs, RholE
Coefficients | — E3
|

24, 1¢l#E, RhofE

()4 Back | Ca.nu:ell

4.82 IR £ 81 7 AR AR

RN T R 2RI 7 FRAE R T 2, AN AT G, BN RA RN, #
AR — 2 k2. N IHZE A4 — N A 9% Anchor (B 550D F1 Rho (B I Yo

1. Anchor

BRI 2 i )RS R, A 4.83 FR

—1 . —'\uh n
e MRS ZrnphsEREE S

4.83 45
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2. Rho fHi

Rho EL & SCUNIE] 4.84 Flizi, o sl 1) — 4R s AR BR RS 55 HLAE — ok th 28 300 i B
s s BHES I EUAR . iz (/N T 1/2 W, AR AR B R I S E T 172 i, Ik
HZERT 1728, WA .

AN
R~ B ik

RhoEr A AT B ik

& 4.84 Rho 18

2R RIATVEGIN A — T kit 261 7 Fh A= il 7 2

1. 5 Points

SR FIA 5 AN Sk —ikithgk . srdizigdl)s, PR RSN, FH ) S a0
WHEHEAR IR E 5 A5, AH AT AR A — 258X 5 NBE s — 2 IR 2k . e APy U R aT DA
&l 4.85 F1 4.86 A7~ A Fh AN [F] 2 AMI%%%D

M

LANTES £ E w1 85 %
=, FEEsS T =
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EITE s EN SR P2 P3
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EFEMEX EES
O E .
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+

7. I P3
ik s, PRETEE ™
R]‘uﬁﬁﬁﬁﬁ NIE=%23 ",
£ R = & AR 3
=+, !
;f P2
P3 ;“;/ P

Kl 4.86 XU 2T B — Vel 28
2. 4 Points, 1 Slope

BET7 GRS 4 A A — SRR Tkl 2. niZdgdl e, BD NN R SR, R
ﬁE’J 5@ULXT1E$E1§%H*"~/I\)§\, FBCE S — RAREE, RERIRECE R E =N, AR —%
XY BERE i, HLER — RUREER O Ve R 1 K 2

E IR & AR BOTFEF, RSt 17l 4.87 s DU RIS E J7i%: Vector Components
(K4 ) . Direction Point (J7[F]/5) « Slope of Curve (HIZERIZ) Al Angle (AE)

General Conic

Vector Campaonents

Direction Poink

|
|
Slope of Curve |
|

Angle

E: Baclk | Ca.m:ell

] 4.87 General Conic T £ 2 771

® Vector Components

HER IR AR B S A IR RO R R . RN 4.88 s G, HIWE 1 P1 RiHIAL
BF, RARIRMPERED BRSCRERMAS 2 ERE, MR DU EIR N P1 SR
o BRIGRUGEEL P2, P3 FI P4 &, REGHaAEM K.
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4.88 Vector Components J7 2

® Direction Point

P L LT ) s A BRE iR 2Rt 3. 7Ean1&] 4.89 o EIEIH, F A #isE 7 Pl
RIALEJR, RGBSR HETT IR RALE, B ata DO7 1A AL E R E X PL RURLER .
WG IRUGERL P2, P3 I P4 £i, RGUHLSAEMK IRHIZ .,

maghm—

ks
E

: P2

(2] P3

P4

4.88 Direction Point 773

® Slope of Curve

PEAE TR PAS) — BRI R R E IR RE R . e 4.90 oy Gldr, P #hE 1
PLAMN B S, RESERA PG —AAAE M 2 s, BRI st aZam AU AR E X P AR
Ko PRIGRUGEE P2, P3 P4 15, REIELEAEMR IR
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4.90 Slope of Curve J5 =\

® Angle

B I DA A 7 Aok e LR 2Rt . R 4.91 Frosi B, H e 7 Pl
BN B, RGBSR MNAENE, I SSumEERE X PL ARRER. RIGHRIGE
HU P2, P3 Al P4 1, RSB —ikiMiZk.

| AT

TC
15*

.

4.91 Angle 73

3. 3 Points, 2 Slope

BT FORFIAT 3 A mATPASREROR R k2. iz dZdlln, B WRN R Gk, FI AR
) B TR B 5 — A, FBOE SR — RBRER, MR RIRBE L E A R, BURBESR =
R, EA AN Rl X = EOE R, B — R B = mRER BN B B0 R — 2%
K. 1B 4.92 Fros g2 XA s s E
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K 4.92 3 Points, 2 Slope J7z0
4. 3 Points, Anchor
7 SR A 3 AN SR SR A ki 2k . iz, BP RN RGN, FIAHBH T

A BVEXHEHE MR IR BOE = AN il AR)E RO — DMl R, AR KB R = E s, HIH A
NBEE A — S ki 2. B 4.93 BRIt Ao 20 B .

K 4.93 3 Points, Anchor 7\

AL B B0E AT DLRDRAZ 20— R i R, B 4.94 Bl IRl A2 4l O 7 B — Ot 26
S R PR o

e &5
P [ P1 f ]
P2 P2 ¥ i3

L
P3 p3
He T
P M —_
+ P2 P2 =
P3 P3 +—="

P 4.94 i A B X R i 2 v s AL 1 2
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5. 2 Points, Anchor, Rho

77 Z ORI 2 A R SRR & Rho SR8 RN . SRz i), B N R Gude
IR, F R ) A AR HEAR IR 2 AN, R R e V12T ), e B — 4 Rho fELA
e R R TR, SRR AT AR R — At 2 ME A, A SN BE S, Rho NEEME A —
FIRMIZ T .

TEHASE Rho [HABFEEMLANT oM 1 20 CRMEFE oM 1) , BN ARG ERERER.
K 4.95 Bz B2 Rho (EXF R EIZRAIEEmT, W3 Rho fE/MT- 0.5 BPEs P2 AR A0 IR, 40 5R Rho {25
T 0.5 BRSP4k, W% Rho 18 KT 0.5 BRI A XU 26 .

7?’“ ?’”‘?""F

Bho=7% Rho=25
e —— e
- —_—— -
- - I_.d""-'
*7, D i
-
Rho=3 Rho=1

4.95 Rho BT Z ¥ i 28 1) 520
6. Coefficients
77 KGE I H W E RO ROk A —ikith 2. sidnxdgiil)s, (R 58 W 1 RO EHE

SCASHE A 23 Wl N IR th 2R i — %05 FE R A2+ Bxy+ Cy2+Dx+Ey+F=0 F1ff) 6 N REA. B. C.
D. E K F, XFERGRISMIE TAEARPRIE 25 AL B AR i — 2% IR 2R

7. 2 Points, 2Slope, Rho

7 AR A 2 A 2 DMREEZEIFIC S Rho (R A i 2. arizizilfs, BPm N R4t
P, FIH ) S AN IEHE SO A A, R ROE R SRR, AR5 1B0E A& U SIREE,
5 R BOE —A Rho B, (AT AR l— 252 A5 2 ORI BOE sl R N BOE REEE, Rho fE N GE
R —2% 2k
4.3.3 Fehgk

TR 2t AL X Y Z ARFRE 4% B KU AR AR AR 2% i 2o R PRI 2 T 2 s A e o 2
LSRR, AR ek TR e AR AR A Al i T IR AR ] {38 [ A 42 ) S AE A
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3 15 TR ) A R T AR P ) 5

15T AR RE b e ™ B PR 8 4 Insert> Curve> LawCurve I, G52t 1/ 4.96 7
71 HORE It 2k 1) 2 77 O T

Law Curve
Conskank | — W
Linear | —
Cubic | — =7
Yalues Along Spine-Linear | —— AR SRR
Yalues Along Spine-Cubic | —— L T AR
Ev Equation | I 3%}5%5‘:
By Law Curve | — ST sk
0K Back | Cancel |

4.96 LI h 26 81 J7 AR R AR

G RN i 2 2T 3E S XS Y Z ARBREIASAC R, Rgtrhde it 1 7 R U h 2k 224k
M7 3

1. Constant

IR TG AR S HAE A i S B R . ik ii)s, EiE & 4.97 Prsxt
TEHER) Law Value SCASHE FH i A S HE BT 7T

Law Controlled

Law Yalue IE

()4 Baclk | Cancel

4.97 Constant XfifHE

2. Linear

T A bR 2 W7 A G i 5o o 7 O P b R e M. Bk TR, 7E
B A 4.98 FT 7 HEE ) Start Value &% End Value L ASHE i A (L STHE I K076, EiE
BRI A B RT
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Skark Yalue I 1
End Yalus |1

(1] Bacle | Ca.m:ell

& 4.98 Linear X ifHE

3. Cubic

26 TR 1) A2 s B 2 R 3 1 Al e R o AR BB Y 2 =k . iz s, AR
SR ) a0 ] 4.98 BT 6 IS AE HH ) Start Value & End Value SCASHE 4 N AR (b JUA (R AE YU B, B
isH[ERATEA SR (=S

4. Value Along Spine—Linear

LI TE I AL BR BB BAE U 20 8 W R B s BITRS IL FR RUER A B) SRR . By i T
Ja, BLMN RGN, Sl TL, HAM AR ERL LKA, RIGHA Law Value
ERITT,

5. Value Along Spine —Cubic

28 T 1) A o B ZS BAE U 28 0 PR A B2 A s IS 2 (A R A ) 22 =0k . Ll i I
Ja, BAWIRN RGN, Bk wE, A AR ERL LA, RIFHA Law Value
ERITT

6. By Equation

LR Rk AR i AL AR B S B AR . FEAT R iZThRenT, JCERH MR s
Tools»Expression, 1% FRiA AR & AR WA T K ARAR B S B i Bk e K. R )5 iz
EOE, e RE 4.99 (7)) FaRAHEHER SCAE AL =S, MG HERE (&
4.99 1) HISCAMEF NS X EAIZ A H KA S B s, SR RIFERIRGERL Y F1 Z |
11 B R .

Law Curve

1 -

QK Bacl | Cancel

0K Bacl | Ca.m:ell

4.99 By Equation XJiFHE
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7. By Law Curve

24 TR 900 R A SR B M A . MEFEIZETTUR , BN R,
SR AE ORI B2, T R 4% S Ll D S A 07 1, A DA 207 25

FESERT Xo Yo Z BRI 7 R0E X, 3B 4.100 Fros BR8] gh 2 5 A7 77 O EHE . i
7 R 2R 1 3 FhsE L /720 Define Orientation (& X J5[) « Point Constructor (% &3k i) F
Specify Csys Reference (fREZHAFR) » WIERAEFEX =FEfi 70, 7] CL7EE 4.100 Frs B0
MEHR BLHE R 7 OK, U R G0k DA i Al b ke e or A i 28

Law Curve

Foinkt Conskruckor |

Specify Csys Reference |

0K | Apply | Cancel |

] 4.100 Fi0U] 28 5 A 7 2ORHEAE
1. Define Orientation

AARZIENE, RGUPERH R EL, JF L% B U RS PR Rl A i T 1
N Z I IETT 1A, AEROE — A RORE X B IETT 7], f5eJm BE — 3k AR AR b AR I B, X
R GUH AL AR BR F R E A B (1 R i £

2. Point Constructor

RAHZEIUG, RGP BE AR AR R R, AR T 4ERF A AR, X AR
Gl LASE AR R 28 5K e (o A3 XA HH 26

3. Specify Csys Reference

Bz ie, REFR M IRFRE NS, I LIS T BTk R R E SRR R Z Fh
FEIRFRER —ANS T, AR R I X SR EADN S B MZLI T, B FER =S H N S%
B, WRIERE T ZHEE, AR IR GOV =TRAS R, IR R 25, AR IR OV S E i
B NSHMIAC - X R G0 LA AR 28K E A7 B AR 28 o
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4.3.4 YRRELk

G T LR ot D 5 4 4 Insert> Curve Helix I, 545 23 i 18 4,101 76
e 17 2R .

FE#r —— Mumber of Turns I
4875 | Pitch [1

A —— - Radius Method —
£ Use Law

% Enter Radius

HrE | Radius I 1

Hﬁm —1 ~Turn Direction ——
f* Right Hand
" Left Hand
T A — Define Orientation |
S8 — Point Construckar |
)4 Apply | Cancel |

K 4.101 #8277 2O TEHE

FEMH AR 73 T T SR AR, RGEI R4 K0 4.102 Fosisgies. T i
I 2 — T AZ X AE TP S T D) fE
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No. of Turns =2

o
|

]

Start value
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Kl 4.102 GIEMIRIEL
1. Number of Turns (J&E%0)
I SCASHE P T 1 B R e 4 e 2 1 el
2. Pitch (MZFE)
I SCASHE F] T 1 B R e 2 A Je 2 | 2 T A BRI
3. Radius Method (34275 30)

PESCAHE T 13 B AR 2 et 2 n 7, Rttt 7 iR 277 Use Law GENT7 D A
Enter Radius (G A\ FRME 7D

® Use law
1207 N TR BRI 4 A0 4% — @ B ERE ATk . BB IE TS, Ry g
4.96 FrXfUihE, AR AR SR AL R 7 PR bR 5 SOk 45 H R e 1 AR Rb 26 7 1 (R AR A R

1) Constant

BRGETHUR T2 R e AR AR e e . PR ZIR I, AR R GTH L I IEHE R Law Value )
SHUERIAT, XA SCAHE (B 2 e SR e 2R (112

2) Linear

AR T T 5% B AR B2 B e i A N AR Ak . BRIk TS, RGBS Il 4.98 R
XPUEAE, FEXTIEHE R 1) Start Value & End Value SCAME 4 A HUE BRI A] (4141 Number of Turns A
20, Pitch 4 0.2, Start Value {E5 0, End Value {85 5 IF, 742 HE4k & 4.103 i) -

HEFEHCIn e,

Hexsetlb =

4,103 ZRMEIBHEL:
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3) Cubic

BRI 1% BRI LR e AR N =k 5 A8 k. B ZIRT R, RSB K 4.98 s
RIXHEHE, 5 Linear AHMEL, ZEXTIEHEG [ Start Value 2% End Value SCAHE 4 NS EE I AT . X Ff
J7 PP A NS IELR 5 Linear J7 A LLEARML, HO2TEIRRL LA LA A . K 4.104 FrosrI6t 2 1%
S H0k B AR Cubic 77 3R e

e e

f’
el

Bl 4.104 =X 7 IBELE
4) Value Along Spine—Linear

BER U TR S B 2o A iR i 2k,  HASU R AONER I . PR Zak s, WM R SRR,
Felk U — 24, BRI R BV DI RER E W 2 B AL IR IR e LA 1% AL 1 AR BT

TEAVEIRIEZE S5, WA B H Helix XHEHE, HEFHEY Use Law FRIEIZE], o5 b
4,105 7R PIXEHE . SEXHEHEF B HE T =/METi: Change Law Type (HUZZRUNIZRAY) | Change
Law Parameter (Z{ZEHLNIZ%0) Fl Change Tolerance (I AZE) &

Change Law Type i

Change Law Parameter I

_hange Tolerance I

[IE: Bacle | Cancel

K 4.105 B IhREXT TEHE

MIEELT RIPNMETY, RGusier it anE 4.96 MK 4.97 FORKISEME, PRI DLETRE
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AR 177 XS4 Law Value FIME . iR HUE = /METIR, RG] 4.106 FosiIA %
XHEHE. H P {U$E T Distance Tolerance (FEE/AZ) . Angle Tolerance (ffifE/AZ) F Join
Tolerance CEHAZE) = ANSHONE SCAKE, F ol DAEIX B ik BB R4 1A 2

Law Controlled L

Distance Tolerance I
angle Tolerance IW
Join Tolerance IW

0K Bacle | Ca.m:ell

4.106 A ZEXSTEHE
5) Value Along Spine —Cubic

BB TR LA AR AL R R G i iR e e . AT b — Moy s, dnizikBis,  Sei HCA
2k, ARIRRRLIT LA L, PR ORI ORI AR R AR BT T . 3R T 2ONTHT — ARy
K 22 57t A MR e 2k e e i A2 AU 5 2, A — Pl d 2 AR A, T iRy s % =R 48
.

6) By Equation

247F Edit Expression XFiEHES (GEHUEHLAF 4 Tools» Expression) & X T ¥ # ARG, FIF%
eI LA+ 2 e HRIA A H e sk . BadnZik s, Rl P fee X LA E A
BHFIAA, FEEKXRTER Y Mz LR ERI

7) By Law Curve

SHE SR TR A FH RN ph 2 A e s MR R 2 R e A . PR iZ A%, Je b B — R 2k, I
SRR ORI MR KT B AT o e AR MR R e e AR 2 IR P U i £k, O HL b A
AT SR RIS ELBA S

® Enter Radius
e T2 DABSUE 1 77 Kok U e BB e 4 1 e i 14, T LIS e 4 g Pl 2 [R) ) AR BN AL 24
WAz, P AT BAE R T Radius SCASHE AR 40 AN 2 1A R e B I 28 A2 1K K/ o

4. Turn Direction (JiE[])

SRR T 2 R e LR I e % T [« Re% 5 A1 R] 30N Right Hand CA7Jie) AT Left Hand (/i)
PIFRIIT I B 4107 P s X PR ieds T SNn e . R Le A ey 30 DU T 19K IRHE e
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Sap S

e i)
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E=)ir

4,107 BRHELR MR TT 1A
5. Define Orientation (& X J517)

U TG T 126 4 B AR BRI R 8 SRR Rl A . 7R R G4 pE 1 3 Fhoy 2O e iR e 4 ¥ 77

7 .

® 7E Helix XU HEH BT OK, WU HB £k 32 A A HT AK PR 3R ZC fli, BB HEZE IR 4G S T XC
L NSy Tl

o HIEALZKITIEX HieE—AEE S EF ] Helix X iEHE A B S QI IhRE W E — N 3E A, WA
FULL I S BT T 2C B AR MBI 2R I Rl 2k, SRR 4 i ah i T i E S X
My IEJ7 PEAT I )
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RIFPAT T X BhE 7R b

6. Piont Subfunction (S GIZEThRE

IR 0 FH 3 9% — R E SRRk 1) A AT

4.3.5 P FI N EhLk
1. Lk

K, BRI R LR AL S, R B AN 4.108 s IO EREHE, P i E A R
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y=a41i] Facal Length | 1.0000
B0y —— Minimumn DY | -1. 0000
B~y Mairnurn O I 1. 0000

FEEmE Rotation Angle I 0. 0000
0K Bacl | Cancel

K 4.108 HLXEHE
AT TEAE R &S50 & L& 4.109 Bk .

A PSRRI TS B: HhENEE HIRTPRA
C: WHhERESIER D WENFEAE
E: ¥R oy F. HMERIEADY
G: IMENEERIE S

K 4.109 &S HE
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|
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f£ 431 /h i, BATCL VRN 1 QIR I 2R M7k, NI EA A Through
Points 77 sR B A 2% 1 £2 .

1) 7T AER R s L s SR A4 Insert> Curve> Spline, 7R H T FE 2 1l 28 012 7 2
FHEAE 313 £ Through Points 17

By Poles

Fit |

Perpendicular to Planes |

()4 | Back | Ca.m:ell

2) #E ARG OSBRI X TR HE, B EE T RAMA TR E, H OK 1%
o FRAETRH P A A 7 AT HE HH % Point Constructor iE T,

Spline Through Points

Curve Type
|Vﬁ' Mulkiple Seqmernts

{ Single Segment

Curve Degree I 31

[T Closed Curve

Assian Slopes

Assimn Curyatures Chain Fram &l |

Curve fnalysis Display Chain within Rectangle |
Pginits From File Chain within Pokygon
‘# Point Construckor
0K Back | Cance
0K Back | Cancel

3) BEJE A S ) R BERHEAE, AR B AR IX AP iR e MR 4 %% SOt SRR By OK 4%
.
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Point Constructor

Inferred Point

i _I/_Idxl

HiC |3. 8326384846

E's
ZC ID. ooooooooon .

" Absalute | -
Offset IN,:,nE vI

Reset |

0K | Baclk | Cancel

4) WEIEFE AR IMZE CRE, LT A A P BT Yes B OK #4241, PRSI 5E S Y
EERE SR 2RI IRHE P By OK, U AR e 2 AL E R E SRR AR I 2R

Specify Points spline Through Points

Curye Type
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| Single Segment
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I~ Closed Curve

Assign Slopes

Assign Curvakures

|
Curve Analysis Display |
F‘piﬁts Fram File |
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4) WA ELE QAR R, ORI oM s R, nIEdt AT DR 2 BER, RSB
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Spline Through Points

Curve Type
|VF Multiple Segments

™ Single Segment

Curve Analysis Display

v Show Conkrol Polygon

Curwe Degree

I 53 v Show Curvabure Comb

[T Closed Curve

Scale Fackar

Assian Slopes

£.9
1

fssign Curvatiures 1

-
12.3

Curve dnalysis Display

Suggest Scale Factor

Points from File

[+ Show InFlections

Bacl |

v Show Peaks

Cancel

5) MikFF [ A& Wk BUE, ERZATT RIS RAEME R L, W AR SEQIER

PR B, BomiZ i otrasi R .

2. BRBRZA B

1E 434 /N, AL HEMEINE T OV SAJ77E, THIEAIFIH value Along

QK Baclk | Cancel
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Spine-Linear 7 AR Al 2 e 2k .
1 BONZTT A T A A 24 R R Lk, RIS e e SO 26, Rl K B AL
FESR

0
somm [JEZNEL. HI ek s TR ERR < |8

) Basic Curve X1 HE A B ol BL£E Pl b e , FENBEZLOIEThRE. REAELKTEX PRI —S/ERN
BN, ARG EENENERR zC %4, S84 T4 T zC i EL. HBESBTAERKK
B SCAKEHHIN 50.

|71IQI_|§|J

I~ Unbounded [~ Delta
Point Method ;/

7+
v String Mode Ereak Skring

Lack Mode |

Parallel ko
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= Mew
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[E | Apply | Cancel |

¥ | -1835 Yo | zor1 26| ooooo <2 |50 Alzamezia T tom

2) N T iSRRI L LA I, B E LR EAERR 10 A B RZ AN Smm. B

& T A @*T*JEPEI’]JT‘ﬁ% SEHLT 4 Insert>» Curve»Point Set, 7E Point Set X ifAE 1 Fid5 Points
on Curve 1%4H, EEUE L NEAEX S, /)G 1E Points on Curve XfiEHE S % B Number of Points SC A

HEIZ 4By 10 RIAT .
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Point Sek

Painks on Curve

Add Points ko Curves

Paink ak Curve Percentage

Spline Defining Paints

Spline Knot Points

Spline Poles

o

Points On Curye

Paink

Paink at Fz

Spacing Method

Face (B-2
—( Equal Pararmeters J
Group | N

Mumber OF Points
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End Percentage IIDD. aooo

Select Mew Curve | T

[E | Appl}'l Bacle | Ca.ncell

3) TESER T BRSNS, Ml eI Eiesk 7. £ LR @]ﬁﬁ¢$fﬁ@@iiﬁ%%$
5% Insert»Curve»Helix, 1F 5 H 02 e 2kt 77 XA 1EHES, ¥ E Number of Turns Fll Pitch (A
MEFIME v 50/4 F1 4, FHiEH Use Law FRIETI .

Nurmber of Turns 50/4
Pitch

~Radius Methog——"
" Use Law
¥ Erter Radius

T i@

Radius

— Turn Direckion ——
{+ Right Hand
" Left Hand

Define Crientation I

Poink Construckor

(1):4 I Apply | Cancel |

4) FEHL Use Law FRIET 5, FEFAHT Law Curve FiEHE A 55 Values Along Spine-Linear %41,
SRIGIEEE 2 NEAEXT %, FHLE Law Controlled XJiE#E A 5.5 Point Constructor %411 .
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Cuihic | :l
Values Along Spine-Linear I 1
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B Equation Mame

By Law Curve | T+

Solid Face
0K I Back | Canc
Solid Edge
Paint Canstruckor

Curve +

Law Controlled
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Ji, AP RUGRIE 2R F B E U 10 N A, FRTEIRIUEE U5, 7R3 H IS B0 U HE i N B
DN EHITERE . M BB N & SRR 2K ION 00 1. 24 3. 4. 4. 3. 2. 1 f10.

Point Constructor +
Inferred Poink

7. H +| 2|3 A i

OlPalls; i

Base Point +
i T2, 06TOTET23

i 19, T13837447 T

ZiC 0. 0000000000 T

{* WiCS " Absolute | 1

Law Controlled

Offset m Law Malue T

eset )4 Bacl | Cancel —+

)4 Bacl | Cancel I 4
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6) FEAS KRR E )R, Hidr OK 154l = IR[PIEHeL e 7 sSNHHHE, F 8 oK %4,
W R GERt 2 4% F 7 B B B IR e 2k

4.4 YnE 2 Tne

AN IR S AR 7 2 R S0 S S U P UE 725 I 12 N 2L S AN
Zehr AN gm AR TS Th e . I 3 5 Edit>Curve NRIAT-SEI,  HI P AT LAFENHH 2 H i 222 48 DI AE

4.4.1 Edit Curve XiEHE

TE T FLPIRRRE e o 3 R 5 5 M A 4 Edlit> Curve> All I, 25530 20l 4118 4.112 o 4
PR LN TEHE . X AE TR A A R A 1 7 A2 IR D RE, RS T AN R 2 TR
EATHAE 5

I THI A AZ 0 1A A — SR T = A E— U .
1. Point Method (S ff#E )
MR T % B RAEL KX i Sy, weit—m5, 2G0T DR HEREE I 5.

2. Edit Arc/Circle By (s[5 51/I5)
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IR T T ik B g th 26 7 e E R EWASHIETZE: Parameters (Z477) M Dragging
HEzh =)

3. Complement Arc (HAMNEFT)

W T FH T 2 s e — [ 9 B[ 5IK

Lo B

Eoint Method
5o -

Edit arc)iCircle By
{* Parameters
{~ Dragging

Complement Arc

v Display Criginal Spline

—Edit Associative Curve
{% By Parameter —‘

" As Original

= &r Length Tikim Method
* Tiotal

" Incremental

arc Length 0, 0ogooo
Ipdate I

()4 mpply | Cancel

P 4.112 24 ih 200 TEAE
4. Display Original Spline (&7~ JRFEZ%)

BEIEIEE Z T RO R AORE SR 2k o A0 2R AT X GOURE SR 2k, JERGZ R IEIT, AT
B SRR AR 2% it 2k DUE 578 (AR 26 i 26

5. Edit Associative Curve (ZmfEIcBEHIZR)

R T st B ORIR 25, IR AR SCERE T A7 E . WISRIEFE 1 By Parameter HLIET%Z
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B, RIS SASSAZAE: I EE T As Original FUEIA, SR MHE PR SRR o
6. Arc Length Trim Method (JR£AZEY 520
BRI E A TR BB AT, CRAE 4.4.8 T itgnn4l)
7. Arclength (5
SH R T 2 SR Lk P P B N 3 v 2 ST A
8. Update (1%
ST AZARAL, AT AR AT — IR e 1
4.4.2 YIBHZSH

Eiﬁgﬁﬁqjﬁﬁfgﬁiiﬁﬁiﬁé\ Edit>» Curve»Parameters i, RGumt oo H a1k 4.113
BT~ 1 g e Bh 28 2 B0 EHE . S2BR B A7E Edit Curve XHEHEF O T B SR, X Bt A
BH——HeEMm& LT,

Edit Curve Parameters

Point Method
Lol

Edit &rc/iCircle By
{ Parameters
{* Dragging

Complement Arc

[T Display Criginal Spline

{% By Parameter

Edit Associakive Curve —
L" fs Criginal

|pdate

0E | hpply | {

4.113 JmiH 8 SHONIEHE
fEgmi th &S HOEES, WE T HAP MRS, BEE I RS in b G S5 g r)
W RRTIAFE AR . NIRRT % (EZ. BOR/ B W63/ R, PR rhZkss)
IS E L g pr
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1. B ELSH
RIEFE MG SR HA, AT DAgn i HLA 1 R BT H LS H (RERTA D .

AR R BRI o, T TR P 20 A 20 2 00 TEHE FP ) R B D BERE OB R 5, R
RHLME; WRIEFNREL ERAREEE R, WA DEQE 4.114 FosriBh TN, B
B N FLHT IR AN LRI AT

o | -2e 780 Y& | 17230 20| ooo0 2 | B7.925 4 | 155,945

4.114 Gl ELAIK R RS
2. GRS 2k

AR PR GAEXT R A AL 2k, AT DUME St A A M Ee S K. F U A2 25
ARG i 4.115 Pros g m s ih 2o 1.

Edit Offset Curve
Offset by IDistann:e hd I

Distance ||1 Ny
Draft Height |'J- o
Lraft Angle ID- o
Trim IExtended Tangents j

Approx Tolerance I 0.0010

Rewverse Direction

Redefine Skring

|
Redisplay Reference Chjects |
|
|

Define Offset Plane

Skring Talerance I 0.0010

0K Apply | Cancel

4.115 GRS Hh 20 THAE

R UEAE HR R TS 7 5 A% i 2R B/ EXP R AEAR [A] (L 4.5.1 /N95) , BR T Redefine String
(ZEX4%) . Define Offset Plane (& X WF£1H ) A String Tolerance (fRfEAZ) =AMk, fEX
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BExrefImfEmE— T,

® Redefine String

LRI T R R WAL (1 il 28 I I 5 R 225 i 28

® Define Offset Plane

RIS R AL T I

® String Tolerance

OSCARKE R T 0T B E A2 B B K 21
3. ZlE R N E [

U SR AT g AR G BN, U wT DAE e B M s B 1R 2 K. el [ 47 DU R g7 5 7%
R GNEE . EAMAIN, SE G iEANES) .

o Rzl INEk[H
PO S Ay B T e o S U ST DTS G Bud st e T e e - i RN O A ot 0 M=
XC. YC 1 ZC SCASHE A4 N [ o O AR AR SR AS Bl AN [ 9k [

o HAMAIN

2% Edit Arc/Circle By #0115 & N Parameters #2451, NRFEZEI T BN, *Adi Complement
Arc #2401, W RS 4 Wiz B NH B AMNAK .

o ZH4miE
2% Edit Arc/Circle By T B N Parameters 1241, #EEE 7 RINELE S5, WATEaE 4.116
B4 Bh B 1 2 BOCARHE A AT 1 [ 9 Es 3 1) S U E B AT

=

¥ | 2130 ¥o| 2156 26| oooo | 0383 &3 | 07eT M| 0.000 g | 360.000

4.116 ZmiE R IIELE S5
® Iuz)
AR B A I s, AT R A 4230 1) D Re ElAH Bh T B Ak e SR o s A2 B s A5 1 FE )
FEF IR ARG, AR 30 D Re R F IR A2 Ak . R[N A, dbn] DUEE a3 D) A
AR E RN

4. GBI Z AL

ULARIEFE Mg AE X GO, AT DB ORI A S R S 8. PR B RS, ARGt 5
4.117 Fos g R S HOGIEHE, WA 5K 4.53 P iiie (W 4.2.9 /M) MFE.
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Edit Ellipse 3

Sernirnajor m
Sermiminar Im
Start Angle Im
End Angle Im
R.okation Angle Im

1]:4 Apply | Cancel

4.117 SRR 2 50 B AE
5. IR HIZESH

UAR LRI G SRR R 2k, T DB AR SR I ZR BN i TR RER L il RN ] i 55
2. MPREURE SRR R, ARG st WA 4.118 Pron 14 A 2% Hh 2L S B0 1A .

LEZSTURHE PR AL T RESA I 2R 1 9 FhgmE 7720 Edit Point (4m’EE X 45D . Edit Pole (ZmiE4%
H &) . Change Slope (P47%5%E X A #1%) | Change Curvature (20255 X A HIZ) | Change Degree
(M ZEF 40« Move Multiple Points (F2al &7 E) « Change Stiffness (7% i1k (1M1
FE) « Fit (FUFDD 1 Smooth P o HANUEHEHIEH P AL : Restore Defining Data (P& &
NHHE) Al Undo (HUH) .

Edit Spline

Edit Faink

Edit Pale

Change Slope

Change Curvature

Change Degres

Maove Mulkiple Poinks

Change Stiffness

Fit

Smoakh

Restare Defining Daka

lUndm

(IE: | Baclk | Cancel
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Kl 4.118 it ie 55 Hh 2 S HOMTEHE
WK o FhAE S Hh 2 g 7 XN 4H R o

® Edit Point

IR T #3222 M 201 0E X, DABSUBFESR M 2R . I FZik il s, o
H & 4.119 FrosdmiE e sk th 2o ORI EHE, FEBROE T H PN 25, IR4E e € R R £ T7
(Edit Point Method) J&, FHZPIARN RN, SaEHINRIT . FH/AH— G 3
BRI .

1) Edit Point Method (Zw%EE X &S50

IR T 15 e FE 2k 2 e gm0, P as 7 3 MED: Move Point (B35 .
Add Point (B fI1) Fll Remove Point (R /&) , HR B 7 sUE B A X HE A AL TR W E .
N VELIANE— N IX = g T 5

(1) Move Point

ZHRIETH TR 80— A8 b . IEPZHIETUE, XHEHE T 771 Move Point By (& X #8377
RO EIABRGE, R k2w S MBsh . mE—w N, REwE— B s sakik
TETE SR XCy YC. ZC ABFREh 7 1A (R AL RS B A,

1E Move Point By £ ZH AL, &AM 8 77 i: Destination Point ( HAR &) F1 Delta Offset (1
=W .

(a) Destination Point

HIEAE S S I 377 0% N Destination Point BAETH, TEITBEE — N HER A, REEIFES
Mk B — e A e OSBRI AL E
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Edit Point

—Edit Point Method
&+ Move Poirk:

" Add Paint

" Remove Paoink

—Mowe Poink By
% Destination Poink
{ Delca Offset

[ Micra Positioning

[Dewviakion Ir'-.ll:lne - I

Threshald 0.0010

Redisplay Data

Curve Analysis Display

Paints Fram File

[Undam

0K Baclk | Cancel

4.119 YmiHEESL HIZE 5 S HEAE

(b) Delta Offset

WAL E X RiIR2 8 7 I Delta offset FRGLI, {EULFE 1€ X rl)a, RGai#liin& 4.120

Jii7~ (] Delta Offset X 15HE, 7E DXC. DYC. DZC SCAHEHZ3HIHIA XCy YC. ZC ARARdi T [l (7%
Jei, RIRT R 5E 58 ST B

DiC m
—

DC 0. 0ooa
DZC I 0. 0ooa

1] 4 Bacl | C:a.ncell

& 4.120 Delta Offset %} i HE

(2) Add Point
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2 LTI T 1032 5 FOAE 2% T 2 R I SOt IEIGZ BIRTUR A LB X A A e
B A RIAT . & 4,121 Bos (st 2380 S AT a BIXS BRI .

N ATE S S \

ARANED R ifiE

K 4.121 BnsE LA

(3) Remove Point: 1% LG T MFESE HIZ A2 2508 m o IBUZRIETS, BERHTIEHIR
MRS 158 LR RIAT o 18] 4.122 P (At A% 25 € SOl Jm BT LA .

B
R ] %%%
EE wEfRE

K 4122 BE LA

2) Micro Positioning (fitif)

I T AR 5 AR 3l — A O, %07 SUAE LAt 7 A 8 — A i A 2.
GRENG, EHANE A, FAERARAA, F2Eh AR, R ST LUE SR 2 ks m B 1
1/10 R BN E SR

3) Redisplay Data (EE#T & ~EdE)
ZIR T T RongmiB G, FEaf 2 e R K277 1]

4) Curve Analysis Display (#iZk 74T &)
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ZIRTUH T LB B P sk AR o i i R Sdnizigtlln, 23k 4.71 Pros XS iaHE,
BEATHN B R, RGeS BN R (I 4.3.1 /M) .

5) Points From File (M AL &

ZIE T T WEE SO SO A B . 7RI Move Point FRIEIZEIRT, 41 #d5 Points From
File 4241, ¥ M3 Point File XITEHE, i€ —DIVE KIEHE M LY A N*dat) o X &R
G HOZOCE A R B, H S S A EOR I S, WA — S IR Sk th 42 BiRE 2%
ith 2 () B i i AR SO S N ) B, HOAN 2 KT TR S5 th S B 4

® Edit Pole

ZIE U T g e 25 th S (4] s Pk IUE, <9t i’ 4.123 s g i) s g
ME. JEFAEH S gmiE 0 (Edit Method) , 7EW BN ZEGE, FEDW RN RGN A]
SERE S S g . NI E— N X TEHE A R R

Edit Method fove Paole
Mave Pole By | Destination Point = |
Constrain IOn Curve Plane j

Define Drag Direckion |

Define Drag Plane |

ﬁj Micro Positioning 0.1 -
[T 20 Curvature Comb

Scale [ 1.0000 —}F———
Zamb, Densiky _I"'

Sugaest Scale Factor

Curve Analysis Display

Deviakion Check,

Paints Fram File

lndm

(1] Bacl | Cancel |

4.123 JmAEAE ] S EAE
1) Edit Method (Zw#E 7))
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ZIR T T B S S g7 = Hiegt 7 4 Mg E 7730 Move Pole (23N 5D .
Add Pole CAINZERIS) « Match End Sope (LAui &%) 1 Match End Curvature ( PASi s IR

(1) Move Pole

7 AT A2 il . EFz 75, W T Move Pole By (#3177
) . Constrain (ZJ%H) . Define Drag Direction (& X#B3J/ M) . Define Drag Plane (& X3zt
[1)  Micro Positioning (Jf) SFIRTRA YOG . EEEIEH A #1770, K375 Eig
€ R s 77 M A . PRl IS 163 Constrain 1ET . Ei%4% Define Drag Direction WETil. BiL#F
Define Drag Plane i UK W e #E Hil s IFE B2, 42 T Rz i R s AR 5 e LR R B A 2
AEFI . B 4.124 Fros sl 2 ahia ] S s e e i .

EHEIR T mma
17 £l

sie
wE

o

BN tEenfg

4,124 ) A

(2) Add Pole

207 AT R RE A 2R R 42 ) 22 0 il e #2005 205, R4S 0P ioE — N
BIAT. &1 4.125 Ffros A2 i i) s /i Ja o B

E$fﬂ%
¥
P3
\_&Eﬁg \}Eﬁﬁwﬁ
FhNET FhE
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4.125 WA
(3) Match End Sope

277 3 T LA S5 — 2% il 2 (7R R BERE BT 2 th 2 (s s R o PRz a0m, A%
SERE IFE o th 2dm SRR RS 5 — i 2R s sl B AT

(4) Match End Curvature

277 3 T BL 53— 2% it 2 o o 10 it SRR BERE P e 2k th 2 (s s th o3 . PRz A0R,  AEE
FERE MORE SR M 2dim s SRR B3 55 — i 2R i s BT

2) Move Pole By ($4z/ 75 )
ZERTUH TR B SR T, B SR ERE X A sh Ty S
3) Constrain (ZJ5%)

ZILETEEFE Move Pole % 75 U5 4 2B, & 5 B T L0 SR 1w iR % Bl B 5 T 26
IR, REERIFEAR IR AR . IR N AR H ) —MZH S ARG RIA Bbs 2 B ide o —F2)
Ja, FEAERARAESEAT, FEEh bR, T R BRS 2 2 B BEE 29 A R -

Constrain &I — M R A 4 N2 ETT (on Curve Plane. End Slopes. End Curvatures. on View
Plane) , IR i%F¢id Define Drag Direction Z¥ Define Drag Plane i&T 5, 43521410 Along
Direction B}, on a Plane PN MBI BN ik 6 AL sRIETAHn T,

(1) on Curve Plane (HHZIH)
2 TUAS s AR 24 5K
(2) End Sopes (Z)Wu M AR

LT TAE DR FFAE S M i sl RER AR NI RTIR T, I B30k i 4 1] B R 2k 2R TR 3K
AR URHAT: 2% sl 2R PR 19 42 ) R 85 R PR P92 s R A Bl 52

(3) End Curvatures (Z)5 ¥ i HH %)

I T TAE DR FFE A% A s it RANAR MBI T, I B0k e 4 1] BHAL AR 2 i 2R TR 3K
LR IANSFE R I ZGE AR 1 3 MZ I SAEEIRIN 3 AR R A BT 2

(4) Along Direction (J7[AZ)H)

FE3E$¥ | Define Drag Direction 1£31, HiEX T —MMRE G, REx B4R E
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Along Direction. EFIZIEDG, RAEHT-TAT T 150E BIRET7 I Hash 5 5.
(5) onaPlane CCFHIZIH)

TEEF | Define Drag Plane i£31, HiE X T —/FPHJE, RASBHINKLAHRIETIRLE R on a
Plane. IEFRIZIATE, HEEFEAT T~ -1 i b e sh 42 i) m .

(6) on View Plane CRJLFTHIZIH)
EPEZIETUE, R BAEGhR I E AL B T B shiz ) .
4) Define Drag Direction (& M Hizl /7 )
EHZIEDS, RARMHRECEMNIGE, HTEHARE - RET.
5) Define Drag Plane (& S IE5) 1)

IHZIEIUR, RSRIL U 4.55 FURAFEOERFE L4210 M) , ATFLAA %
B

6) Micro Positioning (f#(ifi)

ORI TAE S B B S B B, R T ARG B, 4 R S PR RS B B B DR ARt
2y afe_E AR EE A

® Change Slope
IR I T oA € SCRINRER . e FZIETR, 25 Change Slope XTHHE, ©5K 4.76 ¢4
—FE (WL 431 /0 .

Vet 78 i JE, FHEFERIZRNE X730, BUE T Change Slope XM iFHET KIS MG, HiZHH
RGBT . 1) Deviation. Threshold I H TR A4 5% M 2k 5 e SR 18] (1 i 22
Threshold SCAHE A T4 N\ ZE A FR(E, Deviation e T0UH T~ 152 B A A5 22 1) 7 X

Deviation &I 5 T 3 1N%&ETT: None. By Vectors GEII/7[7) K By Markers GEZHRC)
1EFE None LU AL B W 225 1EFF By Vectors & By Markers #E10, W55 4% 2% ith 28 a0 R 25k ik
i 25 A BRAEL 1 58 ST AL AR R AR . 243 F% By Vectors IR T, 755844 Hh 28 f il fE B8 i I 22 A
PRABLIR5E XA AT ko (i Sk AR SR M 2R 1m0 XD 3 14 By Markers 36T, 7E 51552k
S5 T I 0 el 2 A PR AR 1) 5 S Ak DU IR A 5 3R

® Change Curvature
IR T % SCE IR . IEPRZIE TS, 23 Change Curvature X iEHE, & 5K 4.78
PR BTEEAR ] . et 1€ e, PRl n)E 70 (iR g ONEWEiprid) , wE 1
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Change Curvature X[ TEHEH IS E G, FHE PN RFE R,
AN ORI TE T =M ik th st ) & 07 = A e 2k th 4¢ .

® Change Degree

AT T SO A IR B, X P Bt e B 23 . 0 TR BORE SR i 2, TSN
BRPEACILHh R, X T2 Bore s M4, W A A bt 2B 2. il ZeBi 4, FrE sk i 2
TERA AL MG ZER £, WEE K R TIR 5 IR th & A pr 2 m), EETZRIELL.

FRZR I T R IFOR I EHe, IR GEEORAIN, 25 AE5 BB SO TEHE 4 A BT (1
2B AR AT . B 4.126 P Rl S5O th 26 B St Jm 1o Ee B

E%U%-i@%ﬁ
2 3 5 3
G 4 v
1 1
4 L 4 5]
Degree = 5 Degreg =6
DT EERY kg

K 4.126 2 B2 2R L

® Move Multiple Points

PRI TR AR AR A — AT, DASCRFESR I AR o 1B I Fe VB ke 2% i 2 i —
AT BN f LB ER o IEFRZIR IS, FERE S M2 EARIRBOE SAB BT B I JT 46 U &5
WO AETFIR RIS TR RUPR E 11 BRI B 28 — MR8 i, RO S — MU R g a0, AR5
B N AR IR IR B 2 — MR AL RS B RO 38 M L, IR B0 B8 M )
R 730, RIFIED MR RGN BOE S MU AL RRAE, W R GRS FaR ¥ e % Bk g Y
B, MIEAE e B EIRR, B AB ) BB P i s AL B R AN o

EWEFRS TR, KRGk 4.127 BRI iEHE, Hp & 7 =A% Di: Distance
Normal To Curve (IEAZT-#IZE) . Vector and Distance (ZAMEEES) A Direction Point (J5 ]
B o EBEARPNI SR T, B S I E RS A
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Distance Mormal To Curve i

Vector and Distance |

Direction Poink |

0K EBacl | Cancal

K 4.127 %35 X EHE

1) Distance Normal To Curve

B X T EMENN R, BRI, W BrBadim, 5 REET AN, IFH
RG] 4.128 PrsHIRHEHE, ZRM AR SIEE . #5 L MBLRHEELE A 7 1R E
BB, FEERIE AR

FEENRE Diskance

1] 4 Back | Cancel

K 4.128 Distance Normal To Curve X ifAE

2) Vector and Distance

MEX T EBMI RS, EFIZES, RGN RESIENE, A e R s)
Jille %E RGN WA 4.128 Fros X IEHE, ZORM P M Z A B siine . AR5 e
BB, A RERE AR

3) Direction Point

2T ERREM R, BRI, ARG QIR R E R B R B AL
B IR AR FEERAE L B AR X PR E — sl RIAT

K 4.129 Flrs il 2 M Bl 2% ith 2R (K — A5 BUal Ja (oxt L
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i bRt

4.129 FEAREK hZ AT B

® Change Stiffness

e T T AE R AR SRR O i A ) R BN AT T, I 38 i A i BORAB ke 2% i 2R T
Mo EEZIEI S TR TR E SCHHE ORI, R RGEORAAN, S5 ESR H IR0 i HE 4 A
i8R Ei0] eV A T T Qi O = - 2 = s )| 1 G SR 2l i P 7 g g e A L G SO
4.130 FT7 i 2 3R R 2% il 2B Rt 5 AR EE

AV VAN,

Degree =3 Degree = 5
Degrae = 5 Degrae = 3
BT EERY ke

P 4.130 SRR IK B AL
® Fit
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IEPZIE A S M 208 TR 2L, LECR &R, Ak X #hds A R iz dh 25
IR . EPZIETS, 23 Edit Spline By Fit XT1EHE, &5/ 4.80 Ao I THHEAR [F] o G HE
() ESRAIH T RESR 2 3 Ml & 70, ImBEIETT G, HioE 28, REIEDmN R5%
ik ERANE AT

® Smooth
ZIG T TAERE 26 th SR, i a IR S M et 26 B0k 5. BBk ilE, <
s ] 4.130 B xS HE

TEAZXTTEHE FR 5520 ) %€ Source Curve. Constraints T, #RJ51E Threshold SCASHERI Segments
SCAHE H i N 25 sV AT B KRS Sh B AR O (1) 15 BB, I Approximate i IR N7 21 BE 3 2%
HZE I B, F )5 T Smooth #R1E . XTIk EFE 2 I 4211 Smooth #AE R W T 2 Fhoy Aokt
17+

D EAEEU ES e, il Smooth ET, F 4t A SARYE LA _b v ke i Ak 2R T
A 3EAT Smooth #:1E .

2) oA URE S R 1 A 1 JFBEATAHRL I 20 E G, F i Smooth S TR I RE A 5% T 24

HEAT S

Smooth Spline
Source Curve IOrigina| vI
Seqments [ ¢

Approximate |

Canstrainks
[~ Match End Slopes
[~ Match End Curvatures

Threshald I 0. 0100

Srmoath

Redisplay Daka

|
|
Curve dnalysis Display |
Lnide |

[E: | Bacle | Ca.m:ell

4.131 Smooth Spline X iFHE

LA 2 — SRR AE A AR I
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1) Source Curve (JFHIZR)

ZIRTALE 2 ANFIET: original (JRAEZERHIZL) I Current CHETFEZRHIZE) o 1ZIETUH TR
FEAAMIZR I T, Al R Je i 25 (1 i 2 AR IS = H ATFE 2610 th R R R %

2) Segments CTTE%D

ZOCASHE F T 15 B R S5 M R TE G TR AR BT 10715 B

3) Approximate (ITfEl)

ZIEIH] T 1% Segments SUAHEVC B AT B, SEHTAE SRk, (ESLELJRRE SR T 2Ot .
4) Constraints (ZJH0)

ZIETHR AT 2 FhL 7 20

(1) Match End Slopes: 1% /7 2 T BUERE A MIZRAECIFIRAE IS, o R 5 SRR 2% 2R 10
S AR A UL o

(2) Match End Curvatures: 1% 5 A T @ L2 th ARG HR RS, Foom a2 5 TR A 2% it
28 1 i it 2R UL

5) Threshold (HFRAE)
OCARHEF T-80E FER M AR AE IR R IE RS, ek L& nUm RS Bl M K HE 5
6) Smooth
IR I T ARG BOE R ZE R IRAE . ZORSEIETL,  E SRRt 2 T O AT T R A
7) Redisplay Data
TEEHRE R M 25, IR T T 300 R A% th 2R 1 %552 Skt
9) Curve Analysis Display
IR I T 1 B RE S it 2R AT B A0 T
4.4.3 {&BIEhZ

76 T B ERRRE p o S e R B 47 4 Edit> Curve> Trim B, R Geak 2 th i1&] 4.132 Fisif
3T A HERE . FIFIEE AR % (AT, %, P, . AEbsef B i
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emEi e, WREKBUEE E L. N, U e Skt 2R

Trim Curve

Selection Steps

Ele |g] — s

idiEsE —— Filter Ay =

Bzh#EE{E — [ Automatic Progression
B A — | Trim/Extend [Sea +]

R EE — Flare Subfunction |
AEERE AT, —— Method to Find Intersections

[Relative towes x|
EHZTS M —— ¥ Use Inferred Intersection
EEND BATE —— [ Trim Bounding Obijects
B FRh BatsE —— W Reuse Bounding Objects

FEEEphaEsE (B A=, — Spline Extension INaturaI "’I
FcEeM R —— [ associative Cutput
IS HhEE R I —— Input Curves IRepIace "’I

FS S B, — [~ Confirm Upon &pply

[E Appl}'l Back | Cancel

 4.132 &5 28 % EHE

EZXTTEAER BB BT M R FP BR, Hh s — 1 50 R B B shius . Ak A
Automatic Progression ik Ii, WIFEPATER—PR)E, RGHMEFE T —DERENR. R, Wnr
B B e B0 SR EFR AT AH L IR o 7R 15008 0 121 50 RFNARAE B ith 2 (1) A58 s i e 7 AR E
MRZSH)E, BPWN RGN NHEA T H— T IS HE ) 2R T

1. Selection Steps GEFELIR)

WHOP R, fEXT ISt d R, 2L AT 4 MEFDR:
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2 — L FX 5O

°
EFEH AT G by, T E BB RIER 2 — LA R

#

finl

° CGEBEE L5
Sk e U R DO S A I R CLLE S (RO BT

WP

o = (BEREIM

BOE R FETT A bR, 120k 80 R 1R AL mibf € 75 Wi BN Along a Vector I 4 i . L6
SERETT RS, W LRGE — IR R S AHE BTN 2k 2 T8l S A PR RS A Rk 5 1] . fAEIRFZob
DRI, RS AE BB 02 Xk S B e i B 4.133 PR i R B iE 5 U EAR

Yector Method

= =

NAX P AR BN

4,133 RO T X ER

o S Grrmsemmms
SR R R, R A AR . RIS, [ 4132 B i

A s & 4.134 s AR, LR RS 2 ANETT

Extend IEnl:I vI
Trim IInside vI

4,134 N EAE I I R
1) Extend (ZEfH)

VT T 58 e A5 B i 2R AW — it 2B R 2R — 1A ST g, g — i U B B e A R 2k SN
%, Hrp s 2 NET: start (BB M End (5D

2) Trim ({&51)

LT T 15 AR I A XS GO 5L, R BT dh 28 il —38 0 A8 85 . Horh 8 2 NMETI:  Inside
(A2 W) Floutside GAFRZHM &
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FERFEIX VYRR IR, AT PR FEP R /DR FE 4> JIHME Trim / Extend ST T 7
LA T ) Th R e Tt w] A T B0E — AN L AT R

2. Filter GIJEES

ZIETAH T3 e IR R R, HAREE T Any (FTF) | Point (5 . Curve (HIZ) .
Edge (i) . Face (HHIHIM ) + Sketch (PH) . Plane (Jf]) . Datum Plane (Z:#E[H) A1 Datum
Axic CGEHERD)

3. Method to Find Intersections (3¢ fiffi5E J7 )

IR T W e L F RS R B I 2 38 R I T e e 3R AL TR 3 R A N EA E T
e

® Shortest 3D Distance
EBUZIETN, W RSzl St R S5RGBT 10 #h 28 2 8] ) = 24 i Fa 0 55 P W 38 10 38 i, FRAR B
ZAL RRAE BT 2R

® Relative to WCS
EHOZIEI, W RGILZAE ST LAEARAR R 2C 37 1A Bl St R S AAAE BT 1 it £ 2 8] i) B K iR
ERIWTPRE A R, FARIE LA SCRAE BT 42

® Along View Normal

EIOZE I, W) R G AE L AT R TT 1) B 50 RS A B 1 it 42 2 8] P B A R 5 40 0
FIRE R, FARIE A AR B T 2K

® Along a Vector

MEROZIRIT,  WE R T Rk F0 BRIEAREGE, A RO R EQIE IR RE — K&
T, BRGEAERE R TT ) L3 50k G5 R B BT I it 2 22 1] 1 25 R PR 2 4 I A 25 (52 R, FRARYE
ZA KRBT R .

4. Spline Extension (FEZ&MIZR 1L 77 =0

YR SRAKAE BY A i 22 AR 2 th 2 ELRE 26 i 28 75 S A 200 FE T, 12 U T e HE (7 3 il
Spline Extension [ Nk )i, HIUTHLaRHIZRME,  FHerb 2t RE % i 2 1 T DU At 4y 5K

® Natural
AR TT o 12 I T4 2% it 4 v oo 550 E AR BR AR A A 2230 57 o

® Linear

LT 2o IR T TR A e M s R R S Ao 2200 5
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® Circular

T e IR T TR A i e M I s TR AR 2230 5

® None

ANIEA o I T ANKERE 2% M R e A i 7
5. Associative output (FHEPEHHD

HGZETUR, WAEBYE K2 5 M 2 B A Seibett, B S Jslth 2k, B BT s i h
2 51052 18] (5% & E B 2 .

6. Input Curves (5 Hif 28 25 %51 1)

IR T EHME B FIR MR 55 . ¥ Input Curves I FHidk)E, HIEL TN HIRAE,
HAm| HAE BT fE IR th 26 PR B 5 A 10 4 Az 7720 Retain (f&E) . Blank (F2j) . Delete (il
%) F1 Replace (LAHTHHZE & a2k .

PR, AR, —RARE MR R, XREEEERA AL E BT 5 H 2k
IR IR K BIRE R . & 4.135 Pl R 52 02 BY I8 (¥ AT Ja X6 LA

22T 20
4.135 HEROLEXEITIH 5L
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4.4.4 18115 A

LA @lﬁﬁ':fjﬁﬁfﬂﬂiiﬁﬁﬁﬁﬁ/% Edit»Curve»Trim Corner I, REGU & AME BT M
HIThEE, & REAETT I ANTAT H 2 e AS s T U 15 4

BBy, Bahbr, (R EeRkEN e rh AT R p 2k, HEEER O AL A BT 1 A
fir, B AR, Jhe A B I 5 PSR O TEHE, BE 5, T 2 A3k s A AR O 4
B8 B85 # B IEHE, A RRBOEEAE, AR Undo 21T, 18] 4.136 s 1t 2 1287
Pt R

FEFRARRLAE H An R HhZR IR FR R, AT M AL 4 TR, (8P Ik o ] B e /)y, L AR ke
BROA] [E I e R 2k, AR SR D7 o Y i AR HEAT B BT A R

R PR K AE BT 2 S e 2k 20, R GT i B A5 AR, Pz R R I R 2%
ith £ e X EdE, FHEM ) 4a Tl

L1 L1
AN ,///
(-
/ ”\
L2 L2

4.136 1BEIPIfA

S AN ST P 0 M b S SR, U R GRS AT, e A — EAE N E I
T A [ 4137 FUR MR RME 37 0 U
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4,137 1587 #E[H
4.4.5 S EIghZ

Eiﬁl’fﬁﬁﬁﬂlﬂﬁﬁﬂﬁiﬁ%%iﬁﬁé\ Edit»Curve»Divide I, ZR Gt 3 th il 4.138 o
(1o F L EAE . e e th 2 B AN TE, & BUSON AL I ERAERT R

Equal Segments

Seqments by Bounding Chiecks

Ak knotpainks

|
|
Input &rc Length Segments |
|
|

Ak Corners

0K EBack | Cancel

K 4.138 73 % il 20 TG HE
FE 73 BN A AR R4 1 5 MR F07 30, A — R el& BRI
|. Equal Segments (3515150 BO)
207 e LLAEF K BREE 2 ) J7 1008 26 20 3 O R BT B BR 2o U, PR 2270 1 1 il
2, FRGisiftiintE 4.139 Frosi Equal Segments X TEAE .
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Equal Segments

—Method

{~ Equal Arc Length

Segments [

()4 Baclk Cancel

4.139 Equal Segments XTiFHE

H A5 #0 77 2088 Equal Parameter (%55%() #l Equal Arc Length (i) PiF =0, &
1%E#% 7 Equal Parameter J730, WL ZR IS EME RN S0 2k, R4 ENSE 2B, AR R air
[ E 5o R, FERESR I Ze B DAL S SO O AR, W RESE T Equal Arc Length 73, I
EHI KIS 5555 . Segments SCANHE A >R % B 1 23550 r B 15 B 1B 4.140 PR 21X
Foh 4y 177 2 4]

Method ———
|VF Equal Parameter /'-’_-'——'_Il——‘-“h\ _,."F o 4I-—'—--.. +_\+

™ Equal Arc Length R T e

Segments I 4 I g%

P2
Method ————— _\'\4_/\— L4
" Equal Parameter L M 5 ‘/\'\_
+ Equal &rc Length L1 /+ L3
Seqgments I 4 L2
sElET g

] 4.140 Equal Segments 73 B%
2. Segments by Bounding objects ( H1i A5 % 43 B
2T B R L A Gk B ih 2k . sdiZikbifn, ERESENhZ, REom Bk
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4.141 7~ i By Bounding objects Xf 1 HE . I HIZAS WEHE W] 73 il € SCi s BN T B R T 11 Jyid 5
XGRIFEIM L. 18] 4.142 Fros Bt X o #1077 R

By Bounding Dbjecks

Poink Conskruckor |

Line Subfunckion |

Plane/Face |

1] 4 Bacl | Canecal

4.141 By Bounding objects X 1iH#{E

DEMRS

RHEERIZE
DRFTE \" \\l} Segment 1

Eht e +.
MRS Begme;htﬁ+%egment 2

o

DAE 'a\ \
b
SEE SEE

4.142 Segments by Bounding objects 4B

3. Input Arc Length Segments ( 4B

%7 RoE I 4 e ST BRIk B 28 . B iZik s, SN, REas
R AN 4.143 BRI Arc Length Segments ¥ B X T AE
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Arc Length Segments

Arc Length Segments Seqments I‘
Arc Length [ 0. 1000 Partial [ 0. oozs
0K Bacle | Cancel | 0K Back | Cancel |

& 4.143 Arc Length Segments X ifHE

K] 4.143 723 X EEAE F SR N2 BA KA. (Arc Length SCASHE) , A3 M X 5 HE = [ 5 FH 5k
AN (Segments SCASHE) I 433B A (Partial SCAHE) [, Hdr Partial {H 2 24 MK A &
NI B EER, BaE—BORKE, BRNEIKERDEAIKAIRE. E 4.144 FoRmGt2
1E Arc Length A4y 2 ), HiZR 7001 K1

L
—I-/ Z‘E%ﬁu‘*
TR
Total &rc Length =5 HO. SEGMENT = 2
S8Rl Elfa

¥l 4.144 Input Arc Length Segments 73 B
4. AtKnotpoints (& X 3 BO

AR R B EIRE ML, erEthdne LA th & g2 N B dizikiis, &
o, RG4EE 4.145 Fiasff) Divide at Knotpoints X i AE .

Divide at Knokpoinks

By Mumber |

By Screen Position |

All Knotpaoinks |

0K Baclk | Cancel

4.145 Divide at Knotpoints {5 HE
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EAXHEHE P AL T =N EET: By Number GEIYE X255 ) . By Screen Position Cilid Ji#
N E) A All Knotpoints (FTAE i) o WIRIES | By Number JETH, A ZEAERE A 3t XHHHER
Number SCAHE H A T 75 B8 SO, WXL SR 0 B a1 Rk $E 7 By Screen Position i
T, AT GERE LA BT S AR B WAL SR T All Knotpoints 18500, WU A 1 78 SR #0FE
TEREI R Bl 4.146 BRIl 2 4% By Screen Position B 12k 43 EI1) K451 o

. ’/ Splne 2
Splne 3
Spline 1 / -I—?-')
F'}flﬁf Splne 4
)
SrEIR &G

4.146 At Knotpoints 7 E%
5. At Corners (7B

207 SRR AAL (Bl —Fir AL ) IRk 2 (P mUR R A 21 B 45 AR s 5 T A
T WBOTH IR RO RAFET AR D o IZIEIE, WEEESFIM L, ARG SERFIEN
Dyt oy B £k 181 4.147 Fos st i fh oy 5007 3R B Bl

Corner 1 ’n"_ Spline 2
l N Spline 4
Spine 1 _-f 1 Splne 3—!’ _(
I
Corner 2
S EIET srElfe

4.147 At Corners 73X
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4.4.6 HWIEEA

6T LB A et VA5 4 Edit> CurveFillet I, 45t 2 th 1l 4.148 T 4
SRR A TEAE, 2 RS 7 2] L7 B A

EditFillet Reclus
i —Radius Default
: Autoratic Trim 1 & Modal
Marual Trim | i+ Fillet
Mo Trim | [~ New Center
0K Baclk | Cancel 0K EBacl | Cancal
Kl 4.148 F%E I F X TEHE Kl 4.149 [R5 EXIEHE

FEAZNS TAE G 3 Y A PR I ZRIE BT T 3, RIS A7 AR B A 156 — 2k g th 2k, [ Ay
AR A 8 2k 2, SRV FERE J5 55 X A0 B 4,149 Fr 73~ 1) 1 A 1 BB 435 AE Hh 807 A N2 2 2 )
"l

e R A X TEAE P AL & T =/ MEBY 7 Ak Ti:  Automatic Trim (EHBIMZ28Y) . Manual Trim
(FTAZET) F1 No Trim (ABED) .

1. Automatic Trim
EEZT, RS E SR R A RAE B et 4 .
2. Manual Trim

2O AT FICME SR A R i k. Fiz0i s, BRI RSN, BEER
B 4.149 XHTHEFHIMN S8, RIEHE L B IBBI R A S gz, FE8, Wkes
—AROER IR B B i, BRI E S B BT B A U EE T ARIERR R, A BEY, WL RE SR kR i
ZAIETLE

3. NOTrim
EFEZIT G, MIAME B R A iz th 26
A H— T 4.149 [ % BHEHE I & 1R UK RV

1. Radius CEA{ED
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OCARAE A T8 1R A 1 AR E
2. Radius Default (% H48)
ZIET T 1 B L1 Radius SCAMEF ) EE . ZIETTEE W 2 AN HIEDT:

® Modal
EFZ IR, W Radius SCAHEH B EIRFF AL, ELFITE Radius SCAHEF SN T #1145
fEEGERE T Fillet HLIETT .,

® Fillet
IEFEZ IR, U Radius SCASHE HH R BRAE B A B di 48 [ A 1 A0 1E

3. New Center CHrH1{»)

PGSR BRI b o IEEEZ I, TR B T A — AT SO I A KBS O L
B, AT LA i B R B AT 50 1 34T iR

4.4.7 HhEHI{H

FE R bR o iy ‘ﬂﬁ?%%iﬁé Edit>Curve»Stretch I}, RT3t W&l 4.150 o
R ith Zehr O EAE . EREF R B LR R, IFal Rt R, W RIEI A2 S i, HhRERE
PAFIZAT R, ARG X Gt i AN AL E,  HIREREAEBNZ G

Stretch Curve

Delka %c Im
Delta viC | 0. aoao
Delta ZC | 0. 0000

Reset Yalues

Point to Poink

ndo |

[E Apply | Baclk

Ca.m:ell

P 4.150 fh 2R it iE HE

HBEN M AR JE,  A] AR B AR X A ERGR P B B, BRI L A It s 72 2
AR A5 TR R 88 o A Bl Bt M 14 5 T A2 8 R £ i 2 e AE P, @I BT 2 ROy 30k
iE o
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1. 437{E Delta XC. Delta YC. Delta ZC SCAMEHH AN G XC. YC. ZC Abknihi 77 7] #8 Bl el i
R E Ay Z A LT

2. i Point to Point ST, FBUE —NSH AL REBE AN HIRM, WRGUEZSH A2
F b 5 18 75 18] AR B R A% Bl B X 51

B 4.151 Jr7m Rl A2 it 2 A g P 451

EHE Z

O

R[] fifilE

4.151 HiZdfH
4.4.8 YwEIAC

16 T B RS e s o = B RS 3 44 Edit> Curve> Arc Length I, 545k 20 H1 1] 4.152
7 O AT AR 6 5 9K B B AT 750 58 2 K

383 /454



Arc Length

Selection Step
Filter I Ay T I

TrimyExtend End =

{* Tatal " Incremental

Length I
Spline Extension INaturaI - I

[~ Associative Sukput

Input Curves IREpIaEE - I

[~ Confirm Upan &pply

[E | Appl}'l Baclk | Cancel

K 4.152 ZwiE SIS TEHE

F PGB n i i 28, P& Filter Al Trim/Extend JET, A/ EFIMKSniE 750 REHA
24 1A P BB A HAMAH SS RN AT o R THIA 2 — TN G AR TR 1 A v 2 SR T I, A e
I T AR [ F IR U AN 41 T .

1. Filter (ILJEZH)

ZIRT TR ik B % 28, &7 Any () « Curve (HIZR) . Edge (i) .
Face (AT + Sketch (HE) kT,

2. Trim/Extend (f&BY/%EAH T2
LI T 15 e 2 I — v g AB BT B e (. AL 3 NI T

® Start
PRI, WK 58 28 I L 46 ST U612 BY BUAE

® End
PEPZIRTI, D) M 5 H 28 1) 28 5 TR AR5 B B AE 1

® Both
RPRZAE I, W) RIS A 5 2R A 4k R S 2 i T AR B BY B .
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3. K4t
TEGR T A T HE R SR AL T 2 PRl gmiE 7 x0: Total (24D H Incremental (&) .

® Total
ZERIE IR DA 8 Ak g i 8 28I . FTIZ BRI UG, 7R3 R 771 Length SCAKEH
LTPNIOP i ESINSE IR

® Incremental
Z BT A2 e g B 0 = Bl ek &R g s th e ol . FT ik s, EH TR
Lengtn SCAREH, FIAMEMZIMKMIGmE (HE sidbsE (RE) .

B 4.153 it 2 g iU K BB, Horh 4480708 Total, Hi{H 1 4.8750, Trim/Extend it
BN End JET, HAMBEITUY R SBCE
Firizeha

138~ 7*
Ref only

5.5193
frc length

HRAE R
1397 41°
Ref only
45750
Arc length
. 2.00 Rad

WA N/
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4.153 fwiiNK

4.4.9 BAEIEH
T LUK DL 28 2 BRI RV ETO AARER, s A A i 2k R T R R R R
1. orEh 2k

1E 4.45 /N, FATCEFEMPINE T B &M 07, FIRAITFI A Input Arc Length
Segments J7 I\, 1%%5 € B B 2R K K — B [ 4 1 T .

)
1) BRI, e T A o

oS HLAT 2 Insert»Curve»Basic Curves, f1F

Basic Curve Xﬁﬁliﬁlﬂﬁiﬁﬂ%@ﬁg, BN CIETIRE. EIRE 1RO ARG, BESHTAEREN
BARSCAME 4 30 RIAT . HARAE D BRARCR QA 3.207 fior.

|
¥o| -z 066 ¥C[-z48210 26| o000 » | 0000 & 30 A oo ;[ oo

P
2) Elﬁgﬁﬁ*$$ﬂﬁﬁiﬁ%$ﬁé\ Edit»Curve»Divide, 7E#H )73 %1 it 2 X1 AE
1 Input Arc Length Segments 11 .
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Divide Curve

Equal Segrments |

Segments by Bounding Objecks

Input &rc Length Segments

Ak knotpainks

AL Corners

0K Baclk | Ca.m:ell

3) BEEEXT GUERCT AR, IREURE NEAEXT R, B SO0 HE R N RS 4
TR K BN 10, )i RG2S H — NS EAE SR S5 7~ 08 B G 408 0 1) ) B BRI 381 4% 1) ol 28 K
B, #iNE, R OK %41 BRI,

Arc Length Segments
Mame =

fi
]
0K Bacle _
10,000

Arc Length

Arc Length Segments
! Segments I 51

Partial I 4, 2477
0K Back | Canr.'ell

4) fESERI e RIS BB G, WA ST 1E - B3 E S HOR - FI Tk i ih 200 5.
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R ESHA B TE
A%’@Jlﬁﬂ%ﬁﬂ&f& \

w/
2. HHZh i

£ 4.4.7 /NTih, BATCL MM A T ILRAIT7%, THEAIFA Point to Point J7 3k
LR 328 FED P 0 B

1) 78 L H Kb g ‘E‘Ziﬁi‘%%iﬁ*ﬁé\ Edit»Curve»Stretch, 7E 5 Hi 1 i1 2& S0 6THEAE A
1 HY Point to Point 1& 1.

Stretch Curve

Delta ¥C I

Delta ¥ [ 0. o000
Delta 2C [ 0. oooo
Reset Yalues A/
Paink ko Paink
Lrdo I

E ﬁ.ppl}'l Back | Cancel

2) AR5 R S BT AR, AE2 B AR X s B A 225 f O H b
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Point Constructor

7 - +] /|2 A
CEE

Ease Painkt —
i« . Svscooouc) ek R
Vi 0. 0000000000 +
ZC 0. 0000000000
|(=' WS = Absolute |
Offset INDne vl
| Reset I

0K | Bacl | Cancel |

3) A ARGk Al M AR O TEHE, IR BRI S EOCRRE R E = AT ) B RE
RIRLEE RS . R, RS TARX A, R ATHE TR BOHE 36 BOCEE HEAT Hr i i X8, PRy OK 4% .

Delka ®iC I 1.6742
Delka i I 1. 1418
Delta 7 |m

Reset Yalues

Poink o Paink

Undo

I:IKA Appl}'l Bacl | Cancel

4) BJa, REAEEHP BB HSH, S pnerx 5.

w
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i AR AIER

HRERIEE

4.5 M IEYRE

ANTEN AT — B EDhRE, WimFe . e, Witk 8. 4. A ISR EE.
JHI S Insert» Curve Operation AT 1T, A Al Dtk AN AR 1 th 2 B E DD RE

45.1 w"¥

FTEA @[*ﬁ*ﬁﬁ%%@ﬁiﬁ%%ﬁﬁé\ Insert»Curve Operation»Offset i, &k #h £ e
BAEDIRE, & T AR th 2 A th 26

TEHEAT BRI AR E AR, KRG 4.154 P GRS IR HE, $275 FH F % B
Bk, Hrp Bt 7 DU Gk B 7 20: Solid Face (SZAAKTH) . Solid Edge (SZ4&i1) . Curve
(HIZ) #1 Chain Curve CBEFEHNZ) o FIRHIX£L77 A 2 o] LA e B0 Im e 1 Hh £, AR (17 ith
L NES . RN 2 R & Rl .

Offset Curye
Marne
Solid Face |
Solid Edge |
CUrve |
Chain Curves |
[ | Baclk | Cancel |
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K 4.154 St LB TEHE

e T AR I ZR S, R oA 4.155 PR imfe 2 150, RN, TERTEEEM
2k B —dik, ATk IT O mAZ T ), QRO S PR RS 7 T S, AT B e T AE
Reverse Direction %4l £t B 4 fi#% 75 2 AN AR R S Hm B A] S8 i R ) S #R A . R4 —
A 2R TEAE ) % T R T AR

Offset by IDistancE ~ I
Distance |1. i
Draft Height 1.0
Draft Angle ID- 0

Trim IExtended Tangents j

Extend Factar I 1. 0000

[¥ Group Objects

Approx Tolerance I 0.0010
Mumber of Copies I 1

Reverse Direction I

Redisplay Reference Chjects I

[ associative Oukput
Inpuk Curves IRetain vI

QK Apply Cancel

Kl 4.155 ik it 20 1 AE
1. offsetby (fw#sJ7:0

ZIETUH T BB &L mFe 7. RGP T 3 WAL 73 Distance (FEES) . Draft (#k
F) FlI Law Control (FRAFHEHD

® Distapce J7

27 e E RS IR Bk R M2k . 8z U5, H N7 Distance (FEES) SUAHEH:
%, 7E Distance Al Number of Copies SUASHE HH 43 ) fi N A A% BE 25 A= A m % i 2k e, e
I HEZSHEHIT,

® Draft 730
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27 Roe B M 24248 B IR A FE - (Draft Angle) if% 21 5 #h 28 BT 7 P TRAHEE SR = - (Draft
Height) [1°FTH o A58 S BN I ol 28 BT 00 ~F T AR A2 J5 BT 2 P T B (R BE B, R A B N A 7 1)
5 i il 28 e~ VAR Y M . ik F% 7205, Draft Height 1 Draft Angle SCAHER BTG, 1E
Draft Height 1 Draft Angle SCASHEH 73 B AR BL = FE AR AA B, ARG R B H e 5T,
Kl 4.156 s at X #7206 .

(e
C1
c2 cd
Offset by Im cE
Distance Il. 1]
Diraft Height IEI. 25
Draft Angle Iﬂ BUiNE
- . '
T g J 2500

Kl 4.156 Draft 753\

® Law Control 71

2 RN R IR B ki th 2k, Pz V5, S wE 4.96 Fros a6 7
AATEHE (UL 4.3.3 /15D, MRS BAE B I w2 BE B e a5 U5, 180 B R g i Bl
Al

2. Trim (BE§ 720

ZIE U T & E W th & e sy 7. Hhsggt 7 3 ME8i77:0: None (JG) . Extended
Tangents (PJZRIEAH) A Fillet (AL

® None
%7 XM A2 5 th 8 BEAS (K AR S A I AB BT 43[R # . P 4.157 s B2 1X A7 20
1))
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& 4.157 None J5 3

® Extended Tangents

IEPEZ T N AL Hh 200 2E KA AZ BRI LB BY o 3B %7 B, #5598 M Associative output 1%
Tit, JU Extend Factor SUAHMERGE , FEH A ANSERCEEAH, T A2 ith 2k £ o 2% 28 s it 28 1) i 8 28 AR
R HS FE I Extend Factor £, HLATIANREARZE, WILIRIZ S &4 ZAHIE . 25 (A% i 2 e o
A A X, MIFE A RAME BT 2 R R 7. B 4.158 P sl iX Aoy SN B GX e
KB = w2 PE 55 X A R ED

/1
0.2 — /
AL T
iR~ 0 |
pdE \
Extension factor =0.5
HEZT A

4.158 Extended Tangents /7 z{,

® Fillet
EFZ TG, A th 26 1 2 2 Rl th 26087 BEASAHIERE, W R Gt LA ME o % R 2 1 [ 91,
V4 B 2 RS A0 SRR A0S 5 1) i s PR PR A s A O 2 1 % 2H R i 2R AR AR AT, W R G e AT ik
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BB Z R . B 4.159 Bt 21X #p o7 =0 B

& 4.159 Fillet 773

3. Approx Tolerance CGIfEIA %)

P SCAKE F 1 B A A% PE B 1AL A ZE (HE

4. Number of Copies (EHi|#&)

SOCAHER T W B IRFEIRAIES, B AL RE RUEH .

5. Redisplay Reference Objects (E#i i nS 54 )

ZILETUE RS E T B e T MK E LSS E R R
4.5.2 %

EIE@I%%*%%E Bk S A4 Insert>Curve Operation»Bridge I, £ 4525 it &
4.160 7R BIMFEE 2R UEAE, & F T RS BOMr e i 2 AN R 7 B 1 it 28

BEAMFE M IENE S5, U 28— 2k M 2R b B i, WIEREEE — k2. PR — 2R ih ek
Ja s Sk M ZR R bR E BT, PR SS AR AR . B Pt i 2 R) B 4% ath 26 ) el B
INIRBUEMT R R AESE T 30 TSR 30, R & i bk AL B LR e 25, S FER,
M 2R BoR BB 2 BEE BB AR T E R T 28— T il 20 1 AE o % 32 ZR I H
%

1. Selection Step CGEFELTR)

FEX R BEAT IR RO AR T, A s 3 MRIEDIR:
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o T GEEE—%HZ)
P — KR EbR, A TH et R E s — X %

o T P
PR SR EbR, T WA i R R 3R AR &

o (BHMLILR)

S MBI AR bR TR iR 2R S H e sk i 2, v th &4 Kk 2 1 2 1
MR IR . Z D IRINAE Continuity Method 7770 A Tangent, H. Shape Control 773’} End Point
F1 Peak Point B 4 H 2.
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